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I. РАБОЧАЯ ПРОГРАММА ДИСЦИПЛИНЫ 
1. Цели и  задачи учебной дисциплины «Информатика», ее место в учеб-

ном процессе. 
1.1.  Место дисциплины в учебном процессе 
Предлагаемый курс обеспечивает базовую подготовку студентов в области 

использования средств вычислительной техники: для всех курсов, использующих 
автоматизированные методы анализа и расчетов, курсового и дипломного проек-
тирование.  

1.2. Цели преподавания учебной дисциплины «Информатика»: 
 воспитание у студентов информационной культуры; 
 обучение студентов теоретическим основам и практическим навыкам работы 

с аппаратным и программным обеспечением компьютера 
1.3. Задачи изучения дисциплины: 
 углубить знания студентов по основному аппаратному обеспечению и пери-

ферийным устройствам компьютера; 
 научить студентов решать задачи, возникающие в процессе сопровождения и 

эксплуатации   программных средств; 
 освоить современные методы и средства программирования, этапы разработ-

ки программного  обеспечения; 
 ознакомить студентов с принципами представления данных и функциониро-

вания информационных систем. 
1.4. Перечень учебных курсов, освоение которых необходимо для изуче-

ния дисциплины «Информатика» 
Для успешного освоения курса необходимы знания курса "Информатика" в 

объеме средней общеобразовательной школы.  
1.5. После изучения дисциплины студенты должны знать и уметь исполь-

зовать: 
 операционной системой Windows 2000/XP, Windows NT; 
 операционными оболочками  Total Commander, Far Manager; 
 служебными программами Windows; 
 архиваторами WInRar, WinZip; 
 прикладные программы Microsoft Office: Word, Excel, Access, Power Point; 
 компьютерной графики CorelDraw, PhotoShop; 
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 программой-обозревателем Internet Explorer; 
 системой программирования Delphi  for Object Pascal. 

2.  Содержание учебной дисциплины «Информатика» 

2.1. Согласно государственному стандарту математических и естествен-
ных дисциплин студент должен изучить: 

 понятие информации, общая характеристика процессов сбора, передачи, об-
работки и накопления информации; 

 технические и программные средства реализации информационных процес-
сов; 

 модели решения функциональных и вычислительных задач; 
 алгоритмизация и программирование; 
 языки программирования высокого уровня; 
 базы данных; компьютерная графика; 
 программное обеспечение и технологии программирования; 
 локальные и глобальные сети ЭВМ; 
 основы защиты информации и сведений, составляющих государственную 

тайну; 
 методы защиты информации; компьютерный практикум. 
По окончанию курса студент должен знать и уметь использовать: 

 основное аппаратное обеспечение и внешние устройства ЭВМ; 
 системные программное обеспечение: операционные системы, оболочки,    

сервисные программы; 
 основы и возможности современной компьютерной  технологии; 
 методы и стандарты разработок прикладного программного  обеспечения; 
 решать задачи, возникающие в процессе сопровождения и эксплуатации   

программных средств; 
 современные методы и средства программирования; 
 принципы представления данных и функционирования информационных сис-

тем. 
2. 2. Темы дисциплины и их содержание. 

1. Общие характеристики процессов сбора, передачи, обработки и накоп-
ления информации. 

Понятие информации. Знания и данные. Форма представления информации. 
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Виды информации. Свойства информации. Позиционные системы счисления ин-
формации. Общая структурная схема информационного процесса. Информацион-
ные системы и технологии. Информационное общество. Понятие системы счисле-
ния. Классификация систем счисления. Двоичная система счисления. Правила пе-
ревода из десятичной в двоичную систему. Правила перевода из двоичной в деся-
тичную систему счисления. Системы счисления, родственные двоичной (восьме-
ричная, шестнадцатеричная). 

2.  Технические средства реализации информационного процесса. 
История развития вычислительной техники. Классы ЭВМ и их основные ха-

рактеристики. Основные блоки ПК и их назначение. Процессор и его характери-
стики: разрядность, тактовая частота, быстродействие. Запоминающие устройства. 
Периферийные устройства: монитор, клавиатура, принтер, сканер, модем, графо-
построитель, дигитайзер, манипуляторы, средства мультимедиа. 

3. Программные средства реализации информационных процессов. 
Классификация программных средств. Операционная система: понятие, со-

ставные части, классификация. Физическая организация данных на носителях, 
файловые системы: FAT, NTFS, WinFS. Операционные оболочки. Сервисные про-
граммные средства: форматирование, дефрагментация, проверка диска, очистка 
диска, сведения о системе. Архивация данных. Краткий обзор современных про-
граммных средств. 

4. Локальные сети ЭВМ. 
Понятие компьютерной сети. Устройства сети: сервер, рабочая станция, ком-

муникационные узлы. Характеристики сети. Классификация сетей по территори-
альному признаку: LAN, MAN, WAN сети. Эталонная модель OSI. Топология 
компьютерных сетей. Линии связи. Стек протоколов TCP/IP. Программное обес-
печение компьютерных сетей: одноранговые и с выделенным сервером. Сетевые 
ОС, Windows NT, Novell NetMare.  

5. Глобальные компьютерные сети. 
Понятие Интернет. История создания сети Интернет. Современная структура 

сети Интернет. Адресация в сети Интернет: IP, URL. Основные протоколы сети 
Интернет: http, ftp, telnet, SMTP, POP, IMAP, MIME. Электронная почта. Word 
Wide Web: URL-адрес, гипертекст, программы-браузеры, языки разметки гипер-
текста HTML и XML.  Поиск информации в Интернет. UseNet, Chat, IP-телефония. 
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6. Защита информации в сети. 
Основы защиты информации и сведений, составляющих государственную 

тайну: угрозы информации в сети, основные аспекты безопасности. Методы защи-
ты информации: криптография, электронная подпись, аутентификация, сертифи-
кация Web-узлов. Компьютерные вирусы и антивирусные программные средства. 

7. Компьютерная графика. 
Растровая, векторная, фрактальная графика. Форматы графических файлов: 

bmp, gif, jpeg, png, ppt, tiff, wmf, sda. Интерфейсы графических редакторов: Corel-
Draw и PhotoShop. Компьютерные презентации, Power Point. 

8. Базы данных. 
Понятие базы данных. Модели организации данных. Язык SQL. Системы 

управления базами данных. Основные понятия СУБД Access: поле данных, ключ 
поля данных, схема данных, таблицы, формы, запросы, отчеты. 

9. Моделирование решения функциональных и вычислительных задач. 
Основные понятия теории моделирования. Физические, математические и 

имитационные модели.  Статические и динамические модели.  Модели вычисли-
тельных систем и сетей с использованием теории массового обслуживания, расчет 
параметров моделей. Модели мультипроцессорных систем. Имитационное моде-
лирование систем. Машинные средства и языки для имитационного моделирова-
ния. Моделирование систем на языке GPSS. 

10. Алгоритмизация и программирование. 
Понятие алгоритма. Свойства алгоритма. Блок-схема. Основные конструкции 

алгоритмов. Понятие программы.  Этапы разработки программ: определение ис-
ходных данных, выбор метода решения, алгоритмизация, программирование, от-
ладка и тестирование. 

11. Программное обеспечение программирования. 
Понятие языка программирования. Языки программирования низкого и высо-

кого уровней. Обзор языков программирования. Программы-трансляторы. Систе-
мы программирования.  

12. Технология программирования на языке высокого уровня. 
Структурное, модульное, объектно-ориентированное программирование. Ос-

новные понятия языка: идентификатор, оператор, ключевое слово. Структура про-
граммных объектов (подпрограмм, модуля, программы). Стандартные типы дан-
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ных языка.  Арифметические  операции,  выражения и функции. Операторы: при-
сваивание, полное и неполное ветвление, выбор, цикл с параметром, с предуслови-
ем, с постусловием. Вектора и матрицы. 

2.3. Тематическое планирование лабораторных занятий по курсу "Ин-
форматика". Компьютерный практикум. 

1. Операционная система Windows. 
Папка "Мой компьютер". Работа с файлами, папками, ярлыками: создание, 

открытие, переименование, копирование, перемещение, удаление. Работа с дере-
вом каталогов (файловой структурой) в программе "Проводник". Восстановление 
файлов с помощью программы "Корзина". Виды меню: системное, строка меню, 
контекстное, главное, панель инструментов. Элементы интерфейса: радиокнопки, 
флажки, командные кнопки. Основы работы со стандартными программами 
Windows: Блокнот, калькулятор, графический редактор Paint. Панель управления. 
Поиск файлов и папок. Настройка интерфейса Windows, в том числе настройка 
главного меню.  

2. Операционные оболочки Far Manager, Total Commander. 
Работа с панелями информационного окна, управление пакетом с помощью 

функциональных клавиш и ниспадающего меню. Создание, открытие, просмотр, 
копирование, перемещение, переименование, удаление файлов и каталогов. Работа 
с архивными файлами.  

3. Сервисное программное обеспечение  Windows. 
Программы обслуживания дисков, сведения о системе, программы-

архиваторы (WinZip, WinRar), антивирусные программы, программы обслужива-
ния сети. Запись и чтение информации в локальной сети. 

4. Текстовый процессор Word. 
Классификация текстовых редакторов: простейшие текстовые редакторы, тек-

стовые процессоры, издательские системы. Параметры страницы. Форматирование  
абзаца, опции шрифта, создание списка. Колонтитулы. Вставка объектов (Eqution, 
WordArt, ClipArt и др.). Создание ссылок (концевые сноски и оглавление). Оформ-
ление таблиц и вычисления в них. Проверка орфографии. 

5. Электронная таблица Excel. 
Назначение Excel. Адресация ячеек. Форматирование ячеек. Создание и копи-

рование формул. Математические, статистические  и логические функции. Сорти-
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ровка и фильтрация данных. Работа с базами данных в Excel. Графический анализ 
данных: гистограмма, линейный график, круговая диаграмма.  

6. Система управления базами данных ACCESS. 
Построение структура реляционной базы данных: определение полей, ключе-

вого поля, тип и формат полей. Режим конструктора. Объекты БД: таблица, форма, 
запрос. Сортировка и фильтрация данных. Схема данных:  связи между таблицами 
1↔1, 1↔∞, ∞↔∞. Построение простых запросов. 

7. Компьютерная графика CorelDRAW, Adobe PhotoShop. 
Создание графических изображений, системы цветов и форматов графических 

файлов. Создания рекламы, коллажей и многого другого. Работа со слоями и цве-
токоррекция изображений, работа с каналами и масками. 

8. Презентации PowerPoint 
Рисунки и графические примитивы на слайдах. Выбор дизайна презентации. 

Редактирование и сортировка слайдов. Использование анимации в презентации. 
Интерактивная презентация – переходы между слайдами. Демонстрация презента-
ции. 

9.  Знакомство с  Delphi for Object Pascal 
Интерфейс Delphi: окно формы, окно Инспектора Объектов, окно кода про-

граммы, панель компонентов. Компоненты TPanel, TButton. Задание свойств и со-
бытий. Описание реакции на событие. Программа изменение цвета надписи по 
щелчку мыши на соответствующей командной кнопке.  

10.  Технология программирования задач линейной структуры  
Компоненты TLabel, TEdit, TPanel. Функции перевода строки в число, числа в 

строку. Составление программы вычисления значения выражения, типа: 

x-1 +  1/(x-3) .  
11.  Технология программирования задач разветвляющейся структуры  
Компоненты TMemo, TCheckBox.  Программирование задачи нахождения 

максимального (минимального) из чисел, например: max (x+y+z, x*y*z, 3).  Напи-
сать программу, вычисляющую f(x) на промежутке.  

12.  Технология программирования задач с множественным выбором. 
Компоненты TListBox – список строк, Tradiogroup – список радиокнопок. 

Оператор выбора, константы выбора. Программы: по выбранному элементу спи-
ска выдается соответствующая информация; по введенному значению выделяется 
соответствующая строка списка. 
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13. Технология программирования задач циклической структуры 
Циклы с параметром, с предусловием, с постусловием. Составление программ  

вычисления суммы, произведения, среднего арифметическое членов числового ря-
да. Программы вычисление с заданной точностью ε суммы ряда. Написание про-
граммы табулирования функции. 

14. Технология программирования задач с данными типа одномерный 
массив (вектор) 

Описание данных типа одномерный массив. Написание программ, в которых 
для одномерного массива осуществляется: задание элементов массива (псевдослу-
чайно, по определенному правилу, пользователем); нахождение суммы (произве-
дения) элементов массива; определение количества элементов, соответствующих 
заданному условию; нахождение максимального (минимального) элемента масси-
ва; сортировка элементов вектора. 

15. Технология программирования задач с данными типа матрица 
Описание данных типа двумерный массив. Написание программ, в которых 

для двумерного массива осуществляется: нахождение суммы (произведения) 
строк, столбцов матрицы; определение количества элементов n-строки, соответст-
вующих заданному условию; нахождение максимального (минимального) элемен-
та n-столбца матрицы; получение новой матрицы. 

2.4. Распределение времени по курсу "Информатика" 
2.4.1. Распределение часов на лекционные занятия 

Тема Кол-во часов 
1 семестр 

Общие характеристики процессов сбора, передачи, обработки и накопле-
ния информации 

2 

Технические средства реализации информационных процессов 2 
Программные средства реализации информационных процессов 2 
Локальные сети ЭВМ 2 
Глобальные компьютерные сети 2 
Защита информации в сети 2 
Компьютерная графика 2 
Базы данных 2 
Моделирование решения функциональных и вычислительных задач 2 
ВСЕГО 18 

2 семестр 
Алгоритмизация и программирование 4 
Программное обеспечение программирования 4 
Технология программирования на языке высокого уровня  10 
ВСЕГО 18 



 11

2.4.2. Распределение часов на лабораторные занятия 

Тема Кол-во часов 
1 семестр 

Операционная система Windows 4 
Операционные оболочки Far Manager, Total Commander 4 

Сервисное программное обеспечение  Windows 2 
Текстовый процессор Word 4 
Электронная таблица Excel 6 
Математические вычисления в MathCad 4 
Компьютерная графика CorelDRAW, Adobe PhotoShop 4 
Презентации PowerPoint 2 
Система управления базами данных ACCESS 6 
ВСЕГО 36 

2 семестр  
Знакомство с компонентами страницы Standard Delphi 4 
Технология программирования задач линейной структуры  4 
Программирование задач разветвляющейся структуры  4 
Программирование задач с множественным выбором 4 
Программирование задач циклической структуры 6 
Программирование задач с данными типа вектор 4 
Технология программирования задач с данными типа матрица 4 
ВСЕГО 36 

2.5. Вопросы для самостоятельной работы. 

Тема Кол-во часов, специальность 
 080504 080111 080401 080301 080105 080109 080102 

1 семестр 
Работа с файлами, папками, ярлы-
ками в ОС Windows 95/98/2000. 6 3 4 2 4 4 4 

Работа с файлами и каталогами в 
операционной системе Ms-Dos 4 4 4 2 4 4 4 

Назначение функциональных кла-
виш в Norton-подобных оболочках 4 2 4 2 4 4 4 

Электронная почта в Интернет. По-
исковые системы 12 6 10 2 10 10 10 

Создание Web-страницы. Гипертек-
стовые документы 14 8 12 2 12 12 12 

Организация базы данных в Excel 14 8 12 2 12 12 12 
2 семестр 

Моделирование решения вычисли-
тельных и функциональных задач с 
применением линейной структуры 

6 4 6 4 6 6 6 

Моделирование решения задач с 
применением разветвляющей 
структуры 

8 4 8 4 8 8 8 

Моделирование решения задач с 
применением оператора выбора 8 4 8 4 8 8 8 
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Моделирование решения задач с 
применением циклической струк-
туры 

10 5 10 4 10 10 10 

Моделирование решения задач со 
сложной структурой данных типа 
массив 

16 8 14 6 14 14 14 

ВСЕГО 102 56 92 36 92 92 92 

3. Перечень промежуточных форм контроля знаний студентов. 

По данному  курсу предполагается оценка знаний по каждой теме лабора-

торной работы с использованием тестов, контрольных заданий, контрольных 

вопросов. Для оценки знаний по темам самостоятельной работы выполняются 

индивидуальные домашние задания. 

3.1. Вопросы к зачету (1 семестр) 

1. Информатика как наука. Характеристика информационного общества.  

2. История развития вычислительной техники. 

3. Информация и данные. Свойства информации. Единицы информации. Коди-

рование, декодирование. 

4. Основное аппаратное обеспечение ПК. Материнская плата. Процессор. Ха-

рактеристики процессора: быстродействие (производительность), разряд-

ность, тактовая частота.  

5. Внешнее аппаратное обеспечение ПК. Шина, адаптер, драйвер. 

6. Классификация запоминающих устройств: внутренние и внешние ЗУ. Ем-

кость ЗУ.  

7. Классификация программного обеспечения ПК. 

8. Базовое программное обеспечение ПК. Понятия ОС- операционной системы, 

ОО – операционной оболочки. Базовые элементы ОС. Классификация ОС. 

9. Сервисное программное обеспечение ПК (форматирование, дефрагментация, 

архивация, программы обслуживания диска). 

10. Компьютерные вирусы, их классификация. Антивирусные программы, их 

функции (детектор, доктор, ревизор, сторож, вакцинация).  

11. Файловая система диска: кластер, люфт, Fat 16, Fat 32, NTFS.  Понятия файл, 

каталог, директория, ярлык, их атрибуты. 
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12. Операционные оболочки: примеры, путь к ОО. Назначение функциональных 

клавиш. 

13. Операционная система Windows. Характеристики Windows (6-7 характери-

стик). Виды меню в Windows. Понятия: Мой компьютер, Корзина, Панель 

управления, папки Windows, Мои документы, Program Files. 

14. Компьютерные сети: виды устройств (сервер, рабочая станция, повторитель,  

коммутатор, мост, шлюз), типы передающей среды, топология локальной се-

ти. Классификация сетей по территориальному признаку (LAN, MAN, 

WAN), по распределению сетевой ОС (сети с выделенным сервером, одно-

ранговые сети). Сетевые операционные системы (примеры).  

15. Защита информации. Три аспекта безопасности. Методы защиты: аутенти-

фикация, электронная подпись, криптография, сертификация.  

16. Интернет. Службы Интернет (WWW, электронная почта, FTP, chat, телекон-

ференция). Гипертекстовые документы. Программы-браузеры. Протокол 

IP/TCP. IP-адрес компьютера. URL-адрес ресурса. 

17. Классификация текстовых редакторов: простейшие текстовые редакторы, 

текстовые процессоры, издательские системы.  Команды Word: Параметры 

страницы, Форматирование абзаца, шрифта, списка, колонтитулов. Объекты  

(wordArt, ClipArt, Equation). Таблица. Проверка правописания. 

18. Электронная таблица Excel. Виды адресации ячеек (относительная, абсо-

лютная, смешанная). Форматирование ячеек (типы данных ячеек, границы, 

шрифт, заливка). Виды диаграмм. Функции СУММ, СРЗНАЧ, МАХ, МИН, 

ЕСЛИ, И, ИЛИ, НЕ. 

19. Компьютерная графика (растровая, векторная, фрактальная). 

20. База данных. Модели базы данных. Основные элементы и объекты базы дан-

ных. Типы связей. 

3.2. Вопросы к экзамену (2 семестр). 

1. Студент допускается к экзамену при условии посещения всех лекцион-

ных и лабораторных занятий. 

2. Итоговая оценка по дисциплине рассчитывается по формуле: 0,4x+0,6y, 
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где х – средняя оценка, полученная в результате выполнения текущих форм 

контроля, у – результат итогового зачета (экзамена). 

 

1. Алгоритм. Свойства алгоритма. 

2. Понятия язык и система программирования, 2 вида языков программирова-

ния. Компилятор, транслятор.  

3. Данные, типы данных языка Object Pascal. 

4. Арифметические  операции и функции Object Pascal.  

5. Ветвление: понятие, операторы (2 вида), блок-схемы.  

6. Операции сравнения (=, >, <, <>, <=, >=, =). Логические связки (И, ИЛИ, 

НЕ).  

7. Цикл: понятие, блок-схема цикла с пред- и постусловиями, оператор цикла с 

параметром. 

8.  Оператор выбора, блок-схема. 

9.  Зависимый и независимый переключатели (флажок и радиокнопки). 

10. Массивы. Описание вектора и матрицы в Object Pascal, обращение к элемен-

тами вектора и матрицы. 

11. Компоненты TcheckBox, TradioGroup, Tpanel, TEdit, Tlabel, Tmemo, TButton, 

TRAdiogroup, TlistBox. 

4. Учебно-методические материалы. 

4.1. Основная литература. 

1. Информатика. Базовый курс [Текст]: учеб.: рек. Мин. обр. РФ / Ред. 

С.В. Симонович. - СПб.: Питер, 2000, 2004,2005,2006. - 638 с.  

2. Информатика [Текст]: учеб.: рек. Мин. обр. РФ/ под ред. Н. В.  Макаро-

вой. - М.: Финансы и статистика, 2000, 2005, 2001. - 268 с.   

3. Информатика [Текст]: практикум по технологии работы на компьютере: 

рек. Мин. обр. РФ  / под ред. Н. В.  Макаровой. - М.: Финансы и статистика, 

2005. - 256 с. 

4. Могилев, А. В. Информатика [Текст]: УЧЛ - Учебное пособие / А. В. Мо-
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гилев, Н. И. Пак, Е. К. Хеннер / под ред. Е. К.  Хеннер. - М.: Академия, 2004. - 

842 с. 

5. Бобровский, С. И. Delphi 7 [Текст]: Учебный курс / С. И. Бобровский, 

2004, 2006. - 736 с. 

4.2. Дополнительная литература  

1. Гиляревский, Р. С. Основы информатики [Текст]:  Курс лекций / Р. С. 

Гиляревский. - М.: Экзамен, 2003. - 320 с.  

2. Информатика для юристов и экономистов [Текст]: Учебник / Ред. С.В. 

Симонович. - СПб. : Питер, 2001, 2003. - 688 с.  

3. Ляхович, В. Ф. Основы информатики [Текст]: учеб. пособие: Рек. Мин. 

обр. РФ / В.Ф. Ляхович, С.О. Крамаров. - 3-е изд. - Ростов н/Д : Феникс, 2003. - 

700 с.  

4. Могилев, А. В. Практикум по информатике [Текст]: учеб. пособие / А.В. 

Могилев, Н.И. Пак, Е.К. Хеннер; Под ред. Е.К. Хеннера. - М. : Академия, 2002. 

- 608 с.  

5. Острейковский, В. А. Информатика [Текст]: Учеб.: Рек. Мин. обр. РФ / 

В.А. Острейковский. - М. : Высш. шк., 1999. - 512 с. 

6. Фаронов, В. В. Система программирования Delphi [Текст]: производст-

венно практическое издание / В.В. Фаронов, 2003. 

7. Культин, Н. Delphi 3. Программирование на Object Pascal [Текст]: произ-

водственно-практическое издание / Н. Культин, 1998. - 304 с. 

8. Макарчук, Т.А. Основы программирования в Delphi 5 [Текст]: Учеб.-

метод. пособие / АмГУ, ФМиИ, 2002. - 110 с. 

9. Макарчук, Т.А. Основы программирования в Delphi [Текст]: лаб. прак-

тикум / АмГУ, ФМиИ, 2005. - 81 с. http://libserv.amursu.ru/DiBooks/e-

copy/400.pdf. 
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II. МЕТОДИЧЕСКИЕ РЕКОМЕНДАЦИИ ПРОФЕССОРСКО-

ПРЕПОДАВАТЕЛЬСКОМУ СОСТАВУ 

1. Методические рекомендации по проведению лекционных занятий. 

Задача лекции состоит не столько в изложении системы теоретических 

знаний, сколько в общении с аудиторией, сообщении ей смысла и значения из-

лагаемого материала, в дальнейшем развитии знания. Полученные в ходе лек-

ции знания, часто носят характер поверхностного усвоения, при этом должны 

служить дальнейшим мотивом и основой для дальнейшей организации само-

стоятельной учебно-познавательской деятельности по приобретению новых 

знанию и умений,  приводящей к глубокому освоению понятий, как отдельной 

темы, так и науки в целом. 

На очном лекционном занятии в вводной части определяются минималь-

ные знаний, умения и навыки, подлежащие усвоению в ходе изучения темы 

курса. В основной части рассматривается довольно большой объем материала, 

в основном, обзорного характера.  В заключительной части лекции излагается 

постановка типовых задач темы, решение которых подробно будет рассмотрено 

на лабораторных занятиях. 

Изложение информационного материала лекции предполагает  использо-

вание объяснительно-иллюстративного метода с применением фронтальной 

формы организации обучения.  

2. Методические рекомендации по проведению лабораторных работ. 

На лабораторных занятиях по информатике формируется и совершенству-

ется практический уровень владения информационными процессами, основы-

вающийся на применении теоретических знаний. Для проведения лабораторных 

занятий со студентами по дисциплине «Информатика» используются компью-

терные классы. Занятия в компьютерном классе предполагают индивидуальную 

или парно-групповую формы организации обучения.  

Этапы проведения лабораторной работы следующие: 

• Контрольный опрос студентов для проверки готовности к выполнению 

лабораторной работы (до 10 мин). 
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• Выдача индивидуального задания и пояснения о порядке выполнения 

индивидуального задания (до 5 мин). 

• Выполнение индивидуального задания (около 1 ч.) 

• Оформление результатов работы. Сдача выполненной работы препода-

вателю (до 10 мин). 

• Получение домашнего задания (1-2 мин.) 

• Приведение в порядок рабочего места, в том числе закрытие всех рабо-

чий окон и уничтожение созданных на винчестере индивидуальных файлов (3-4 

мин). 

Индивидуальные задания для лабораторных работ должны быть представ-

лены конкретно-практическими и  творческими задачами. 

На первой ступени изучения темы выполняются конкретно-практические 

задачи, при решении которых формируется минимальный набор умений. Пре-

подаватель опосредованно руководит самостоятельной познавательной дея-

тельностью студентов, консультирует студентов при возникновении непосиль-

ных затруднений в ходе решения задачи, обращает внимание группы "опасные" 

места решения. Отработка минимального набора навыков завершается во вне-

аудиторное время при выполнение домашней работы. Принимая во внимание 

сложность доступа некоторыми студентами к компьютерной техники во внеау-

диторное время, домашние задания по "Информатике" должны носит большей 

части моделирующий характер. 

Вторая ступень изучения темы  дифференцируется в зависимости от сте-

пени усвоения его обязательного уровня. Студенты, овладев основами теории и 

усвоив содержание типовых методов и приемов решения задач, приступают к 

решению творческих задач. Если уровень знаний и умений, демонстрируемых 

студентом при контрольном обследовании, не соответствует установленным 

требованиям, студент вновь возвращается к стандартным упражнениям, но под 

более пристальным наблюдением преподавателя. 

По завершению изучения отдельной темы курса по результатам выполне-

ния лабораторных работ каждый студент получает оценку. 
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Студенты, пропустившие лабораторные занятия, должны их выполнить во 

внеаудиторное время и отчитаться до начала зачетно-экзаменационной сессии. 

3. Методические рекомендации по организации контроля знаний сту-

дентов   

В Университете качество освоения образовательных программ оценивает-

ся путем осуществления текущего контроля успеваемости, проведения проме-

жуточных аттестаций и итогового контроля по окончании семестра.  

На первом занятии до сведения студентов доводятся требования и крите-

рии оценки знаний по дисциплине. 

Целью текущего контроля успеваемости является оценка качества освое-

ния студентами образовательных программ в течение всего периода обучения. 

К главной задаче текущего контроля относится повышение мотивации студен-

тов к регулярной учебной работе, самостоятельной работе, углублению знаний, 

дифференциации итоговой оценки знаний. 

Текущий контроль успеваемости осуществляется систематически и, как 

правило, преподавателем, ведущим лабораторные занятия. Формами текущего 

контроля являются письменные опросы,  автоматизированное тестирование, 

аудиторные контрольные работы, отчеты по лабораторным работам, домашние 

задания. В течение семестра преподавателем должно быть проведено не менее 

7-ми контрольных проверок знаний по каждому студенту из учебной группы. 

Результаты текущего контроля служат основанием для прохождения сту-

дентом промежуточной аттестации. 

Итоговый контроль (зачет или экзамен) по информатике преследуют цель 

оценить работу студентов за курс, полученные теоретические знания, их проч-

ность, развитие творческого мышления, навыки самостоятельной работы, уме-

ние синтезировать полученные знания и применять их при решении практиче-

ских задач. Задания итогового контроля состоят из двух частей: письменного 

теоретического опроса (от 6 до 12 вопросов) и практических заданий (от 1 до 

3), выполняемых на компьютере.  

Во время проведения итогового контроля (зачета или экзамена) студентам 
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не разрешается пользоваться вспомогательными материалами Их использова-

ние, а также попытки общения с другими студентами или иными лицами, в т.ч. 

с применением электронных средств связи, перемещения без разрешения экза-

менатора и т.д., являются основанием для удаления студента из аудитории с 

последующим выставлением в ведомость неудовлетворительной оценки. 

Критериями ОЗ - оценки знаний студента являются: 

• ТМ - уровень освоения теоретического материала, предусмотренного 

программой курса; 

• ПЗ - умение использовать теоретические знания при решении практиче-

ских задач; 

• СХ - социальные характеристики: посещаемость занятий;  корректное 

общение с преподавателем; прилежание и трудолюбие; общая эрудиция; актив-

ность на занятиях; 

• ТК – результаты текущего контроля. 

Каждый критерий и итоговая оценка знаний студентов оценивается в бал-

лах («отлично», «хорошо», «удовлетворительно», «неудовлетворительно»). 

Итоговая оценка знаний студентов рассчитывается: 

ОЗ = 0,25*ТМ+0,25*ПЗ+0,1*СХ+0,4*ТК 
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III. КОНСПЕКТЫ ЛЕКЦИЙ 

Тема 1. Информатика как часть общечеловеческой культуры. Ин-

формация. 

Информатика – это наука, изучающая все аспекты получения, хранения, 

переработки, передачи и использования информации. 

Слово «Информатика» образовалось из 2-х французских слов INFORma-

tion (информация) autoMATIQUE (автоматика). Первоначально в научный оби-

ход оно вошло во  Франции в 60-е годы для обозначения автоматической пере-

работки информации в широкой области научной и производственной деятель-

ности человека. В качестве источников информатики обычно называют доку-

менталистику (изучение рациональных средств и методов повышения эффек-

тивности документооборота) и кибернетику. 

Задачи информатики 

1. Исследование информационных процессов любой природы. 

2. Разработка информационной техники и создание новейшей технологии пере-

работки информации на базе полученных результатов исследования информа-

ционных процессов. 

3. Решение научных и инженерных проблем создания, внедрения и обеспечения 

эффективного использования компьютерной техники и технологии во всех 

сферах общественной жизни. 

Основные направления информатики: теоретическая информатика, кибер-

нетика, программирование, информационные системы, вычислительная техни-

ка, информатика в обществе, информатика в природе. 

Этапы развития информатики: ручной, механический, электромеханиче-

ский, электронный. 

Классификация ЭВМ: 

1. По истории создания:  

I поколение: элементарная база — лампы, оперативная память на элек-

тронно-лучевых трубках и ферритовых сердечниках, быстродействие до 20000 
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оп/сек., охлаждение, однопрограммность. 

II поколение: элементарная база — полупроводниковые транзисторы, бы-

стродействие 104–105 оп/сек. Объем памяти — до 150 слов при длине слова до 

50 двоичных разрядов. Программирование велось на  алгоритмических языках 

Фортран, Алгол, Кобол. 

III поколение:  элементарная база — интегральные схемы (ИС), быстро-

действие 106–107 оп/сек. Резко снижены габариты и энергопотребление ЭВМ. 

Оперативная память строилась на ИС и достигала объема 105–106 байт. Унифи-

цировались периферийные устройства. Появился широкий выбор языков про-

граммирования.  

IV поколение: элементарная база — большие и сверхбольшие ИС (БИС и 

СБИС). Быстродействие 107–108 оп/сек. Формируются два направления — мно-

гопроцессорные и персональные ЭВМ.  

2. По размерам: суперЭВМ, большие ЭВМ, малые ЭВМ, микроЭВМ 

Классификация РС: 

1. Стационарные. 

2. Переносные: портативные, блокноты, электронные словари, органайзеры 

(электронные записные книжки). 

Информационное общество – это общество, в котором большинство ра-

ботающих занято производством, хранением, переработкой или реализацией 

информации, особенно высшей ее формой – знаний.  

В период перехода к информационному обществу необходимо подгото-

вить человека к быстрому восприятию и обработке больших объемов информа-

ции, овладению  им современными средствами, методами и технологией рабо-

ты. Поэтому современный человек должен иметь определенный уровень ин-

формационной культуры. 

Информационное общество характеризуется – 50% людей занято в сфе-

ре информационных услуг. 

Информационная система – взаимосвязанная совокупность средств, ме-

тодов и персонала, используемых для хранения, обработки и выдачи информа-
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ции в интересах достижения поставленной цели. 

Информационная технология – процесс, использующий совокупность 

средств и методов отбора, обработки и передачи данных для получения инфор-

мации нового качества. 

Сигнал – физический процесс, имеющий информационное значение, ус-

тановленное принятым соглашением. В обычной жизни под сигналом понима-

ют физический процесс, который человек воспринимает как звук, свет и т. д. 

Данные – зарегистрированные сигналы. Данные могут рассматриваться как 

признаки или записанные наблюдения, которые по каким-то причинам не ис-

пользуются, только хранятся. Если появляется возможность использовать эти 

данные для уменьшения неопределенности в чем-либо, то данные превращают-

ся в информацию. 

Информация – сведения об объектах и явлениях окружающей среды, их 

параметрах, свойствах и состоянии, которые уменьшают имеющуюся о них 

степень неопределенности, неполноты знаний. 

Одной из важнейших разновидностей информации является информация 

экономическая. Экономическая информация – совокупность сведений, отра-

жающих социально-экономические процессы и служащих для управления эти-

ми процессами и коллективами людей в производственной и непроизводствен-

ной сфере. 

Свойства информации: объективность, достаточность (полнота), досто-

верность, доступность, актуальность, адекватность, своевременность, полнота, 

энтропия информации. 

Классификация информации по разным признакам: 

1. По месту возникновения: входная, выходная, внутренняя, внешняя. 

2. По стабильности: переменная, постоянная. 

3. По стадии обработки: первичная, вторичная, промежуточная, результатная. 

4. По способу отображения: текстовая, графическая. 

Информация всегда связана с материальным носителем (диски, кассеты, 

бумажные носители, человек, негатив и т. д.), а ее передача с затратами энер-
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гии. Закодированное сообщение приобретает вид сигналов - носителей инфор-

мации, которые текут по каналам связи. При выходе из канала связи сигналы 

должны обрести вновь общепонятный вид в декодирующем устройстве. (При-

меры: фонарик, телефон, живой нерв, компьютер).  

Однако, одну и ту же информацию можно хранить в различном матери-

альном виде (на бумаге, магнитной ленте, магнитном диске, оптическом диске) 

и передавать с различными энергетическими затратами (по телефону, по почте, 

с курьером).   

Различают две формы представления информации — непрерывную (анало-

говую) и прерывистую (цифровую, дискретную).  

Непрерывная форма характеризует процесс, который не имеет перерывов и 

теоретически может изменяться в любой момент времени и на любую величину 

(например, речь человека, музыкальное произведение). Цифровой сигнал может 

изменяться лишь в определенные моменты времени и принимать лишь заранее 

обусловленные значения (например, только значения напряжений 0 и 3,5 В). 

Моменты возможного изменения уровня цифрового сигнала задает тактовый 

генератор конкретного цифрового устройства. 

Для преобразования аналогового сигнала в цифровой сигнал требуется 

провести дискретизацию непрерывного сигнала во времени, квантование по 

уровню, а затем кодирование отобранных значений. 

Дискретизация – замена непрерывного (аналогового) сигнала по-

следовательностью отдельных во времени отсчетов этого сигнала. 

Количественное описание информации базируется на вероятностном под-

ходе. За единицу информации принимается один бит. Это такое количество ин-

формации, получаем в результате  реализации одного из двух равновероятных 

событий, например, при бросании монеты. Термин «бит» произошел от выра-

жения binary digit, что означает «двоичная цифра», т.е. принимающая значение 

0 или 1. 

Более крупная единица информации — байт — равна 8 бит. Проверка при-

сутствия или отсутствия на лекции 24 студентов дает лектору три байта инфор-



 24

мации. Еще более крупная единица информации — 1 Кбайт — равна 1024 бай-

там. Далее— 1 Мбайт равен 1024 Кбайтам, 1 Гбайт равен 1024 Мбайтам, а 1 

Тбайт равен 1024 Гбайтам. 

Задача 1. Решить систему уравнений (найти x, y). В ответе необходимо 

указать единицы измерения.  
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Задача 2. Одна страница книги содержит 25 строк по 80 символов. В книге 

300 страниц. Каков объем информации необходим для хранения книги? 

Задача 3. Один музыкальный файл занимает 6 Кб на диске. Сколько файлов 

можно записать на CD-диск объемом 600 Мб.  

Тема 2. Системы счисления. 

Под системой счисления понимается способ изображения чисел с по-

мощью символов совместно с правилами выполнения действий над этими 

числами. 

Классификация систем счисления 

Все системы делятся на позиционные и непозиционные. 

В непозиционных системах каждая цифра имеет свой вес и ее значение не 

зависит от положения в числе – от позиции. Пример – римская система. Число 

76 в этой системе выглядит так: LXXVI, где L=50, X=10, V=5, I=1. Как видно 

цифрами здесь служат латинские символы. 

В позиционных системах значения цифр зависят от их положения (пози-

ции) в числе. Так, например, человек привык пользоваться десятичной позици-

онной системой – числа записываются с помощью 10 цифр. Самая правая циф-

ра обозначает единицы, левее – десятки, ещё левее – сотни и т.д. 

В любой позиционной системе число может быть представлено в виде 
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многочлена. 

Покажем, как представляют в виде многочлена десятичное число. 
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Обобщим это представление на случай использования другого набора 
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Основанием системы счисления называется количество цифр и символов, 

применяющихся для изображения числа, например р=10. 

База системы — это последовательность цифр, используемых для записи 

числа. Ни в одной системе нет цифры, равной основанию системы. 

В настоящее время арифметические действия выполняются в десятичной 

системе, где р=10. База этой системы 0,1,2,3,4,5,6,7,8,9.  

Двоичная система счисления 

Представление информации с помощью двоичного кодирования наи-

более оптимально для ЭВМ, так как данные в ЭВМ передаются по прово-

дам с помощью двух сигналов «есть напряжение» и «нет напряжения».  

Поскольку все данные в ЭВМ кодируются числами, то для передачи их по  

проводам необходимо применять двоичную систему. 

Двоичная система имеет основание р=2 и базу 0 и 1. То есть, для изобра-

жения  числа используются только два знака.  

Правила перевода из десятичной в двоичную СС 

Для перевода десятичного числа в двоичную систему отдельно переводят 

дробную и целую части. 

Чтобы перевести целое число из 10-ой в 2-ую систему нужно выполнять 

последовательное деление числа на 2 до тех пор, пока результат не станет 
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меньше 2. Последний результат и остатки от деления, взятые в обратном по-

рядке дают двоичное число. 

Пример. Перевести число 164 из 10-ой СС в 2-ую. 

164 2       
164 82 2      
0 82 41 2     
 0 40 20 2    
    1 20 10 2   
     0 10 5 2  
      0 4 2 2 
     1 2 1 
      0  
В результате 16510=101001002. 

Для перевода правильной дроби из 10-системы счисления в 2-ю СС нужно 

умножить исходную дробь и дробные части получающихся произведений на ос-

нование 2, представленное в старой 10-системе. Целые части получающихся 

произведений дают последовательность цифр, которая является представлением 

дроби в 2-ой системе счисления. 

Правила перевода из двоичной в десятичную СС 

Для перевода необходимо разложить число по основанию системы счисле-

ния и посчитать результат. 

Пример. 

1011012=1·25+0·54+1·23+1·22+0·51+1·20=32+8+4+1=4510 

+⋅+⋅+⋅+⋅+⋅+⋅+⋅+⋅+⋅= −101234567
2 212020212020212021101,10100100  

10
3175232 625,164128324212121222120 =++=⋅+⋅+⋅++==⋅+⋅+ −−−−  

Существенным недостатком двоичной системы счисления является гро-

моздкая запись чисел. Для упрощения записи двоичных чисел могут быть ис-

пользованы восьмеричная и шестнадцатеричная системы счисления. 

Система называется родственной двоичной, если ее основание является 

степенью числа 2. К таким системам относятся четверичная, восьмеричная и 

шестнадцатеричная. Мы рассмотрим восьмеричную и шестнадцатиричную сис-

темы.  
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Восьмеричная система 

Основание р=8. База — цифры от 0 до 7. 

Для перевода целого десятичного числа в восьмеричную СС необходимо 

выполнить последовательное деление на 8 до тех пор, пока результат не станет 

меньше 8. Последний результат и остатки, взятые в обратном порядке дадут 

восьмеричное число. 

Для перевода правильной дроби из 10-ой СС в 8-ю нужно умножить исход-

ную дробь и дробные части получающихся произведений на основание 8. Целые 

части получающихся произведений дают последовательность цифр, которая яв-

ляется представлением дроби в 8-ой СС. 

Для перевода восьмеричного числа в десятичную систему необходимо раз-

ложить его по степеням основания системы 8 и выполнить сложение.  

Шестнадцатеричная  система 

Основание р=16. База — цифры от 0 до 9 и буквы A, B, C, D, E, F (A – 10, B 

– 11, C – 12, D – 13, E – 14, F – 15.) 

Для перевода целого десятичного числа в шестнадцатеричную систе-

му необходимо выполнить последовательное деление на 16 до тех пор, по-

ка результат не станет меньше 16. Последний результат и остатки, взятые 

в обратном порядке дадут шестнадцатеричное число. 

Для перевода правильной дроби из 10-системы счисления в 16-ю СС нужно 

умножить исходную дробь и дробные части получающихся произведений на ос-

нование 16. Целые части получающихся произведений дают последовательность 

цифр, которая является представлением дроби в 16-ой системе счисления. 

Для перевода шестнадцатеричного числа в десятичную систему не-

обходимо разложить его по степеням основания системы 16 и выполнить 

сложение.  

Вообще, для того чтобы перевести целое число из одной системы счисле-

ния в другую необходимо выполнить следующие действия: 

1) поделить данное число на основание новой системы счисления; 

2) перевести остаток от деления в новую систему счисления; получается 
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младший разряд нового числа; 

3) если частное от деления больше основания новой системы, продолжать 

деление, как указано в п.1; новый остаток, переведенный в новую систему 

счисления, дает второй разряд числа 

Тема 3. Аппаратное обеспечение ПК.  

Современный компьютер состоит из двух взаимосвязанных частей – ап-

паратного (Hardware)  и программного  (Software) обеспечения. К аппаратному 

обеспечению относится все то, что можно потрогать руками (микросхемы, дис-

ки, платы).  

Архитектура компьютера определяется совокупностью ее свойств, суще-

ственных для пользователя. Основное внимание при этом уделяется структуре 

и функциональным возможностям машины, которые можно разделить на ос-

новные и дополнительные. 

Персональный компьютер — это настольная или переносная ЭВМ, удов-

летворяющая требованиям общедоступности и универсальности применения.  

Основные блоки ПК и их назначение 

Персональный компьютер — универсальная техническая система. Суще-

ствует понятие базовой конфигурации, которую считают типовой. Понятие ба-

зовой конфигурации может меняться. В настоящее время в базовой конфигура-

ции рассматривают четыре устройства: системный блок, монитор, клавиатуру, 

мышь. 

Системный блок представляет собой основной узел, внутри которого ус-

тановлены наиболее важные компоненты. Устройства, находящиеся внутри 

системного блока, называют внутренними, а устройства, подключаемые к нему 

снаружи, называют внешними. Внешние дополнительные устройства, предна-

значенные для ввода, вывода и длительного хранения данных, также называют 

периферийными. 

Системный блок обычно включает в себя системную плату, блок питания, 

накопители на дисках, разъемы для дополнительных устройств и платы расши-

рения с контроллерами – адаптеры внешних устройств. 
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 На системной плате (Mother Board) размещаются самые главные детали:  

1. Микропроцессор (МП) - это центральный блок ПК, предназначенный 

для управления работой всех блоков машины. В его состав входят: 

− устройство управления (УУ) — формирует и подает во все блоки машины в 

нужные моменты времени определенные сигналы управления (управляющие 

импульсы); формирует адреса ячеек памяти, используемых выполняемой опе-

рацией, и передает эти адреса в соответствующие блоки ЭВМ; опорную после-

довательность импульсов устройство управления получает от генератора такто-

вых импульсов. В УУ входят регистр команд – запоминающий регистр, в кото-

ром хранится код команды, дешифратор операций и т.д.; 

− арифметико-логическое устройство (АЛУ) - предназначено для выполнения 

всех арифметических и логических операций над числовой и символьной ин-

формацией; 

− математический сопроцессор - используется для ускоренного выполнения 

операций числами, для вычисления некоторых трансцендентных, в том числе 

тригонометрических, функций. Математический сопроцессор имеет свою сис-

тему команд и работает параллельно (совмещение во времени) с основным МП, 

но под управлением последнего; 

− микропроцессорная память (МПП) - служит для кратковременного хранения, 

записи и выдачи информации, непосредственно используемой в вычислениях в 

ближайшие такты работы машины; 

− регистры - быстродействующие ячейки памяти различной длины;  

− интерфейсная система микропроцессора - реализует сопряжение и связь с 

другими устройствами ПК;  

2. Генератор тактовых импульсов - он генерирует последовательность 

электрических импульсов; частота генерируемых импульсов определяет такто-

вую частоту машины. 

Основными характеристиками процессоров являются разрядность и быст-

родействие. Разрядность — это число одновременно обрабатываемых бит. Бы-

стродействие — число выполняемых команд в секунду. Быстродействие связа-
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но с  тактовой частотой, на которой работает процессор. Чем выше тактовая 

частота, тем выше и быстродействие. 

3. Источник питания - это блок, содержащий системы автономного и сете-

вого энергопитания ПК. 

4. Таймер  - это внутримашинные электронные часы, обеспечивающие при 

необходимости автоматический съем текущего момента времени (год, месяц, 

часы, минуты, секунды и доли секунд).  

5. Системная шина - это основная интерфейсная система компьютера, 

обеспечивающая сопряжение и связь всех его устройств между собой. Систем-

ная шина обеспечивает три направления передачи информации: 

1) между микропроцессором и основной памятью; 

2) между микропроцессором и портами ввода-вывода внешних устройств; 

3) между основной памятью и портами ввода-вывода внешних устройств. 

Запоминающие устройства ПК 

Регистровая КЭШ-памятъ — высокоскоростная память сравнительно 

большой емкости, являющаяся буфером между ОП и МП. Используется для ус-

корения выполнения операций за счет запоминания на некоторое время полу-

ченных ранее данных, которые будут использоваться процессором в ближай-

шее время..  

Основная память делится на оперативное (RAM — Random Access Mem-

ory — память вольным доступом) и постоянное (ROM — Read-Only Memory) 

запоминающие устройство. 

Оперативное запоминающее устройство предназначено для хранения ин-

формации (программ и данных), непосредственно участвующей в вычисли-

тельном процессе на текущем этапе функционирования ПК. ОЗУ — энергоза-

висимая память: при отключении напряжения питания информация, хранящая-

ся в ней, теряется.  

Постоянное запоминающее устройство используется для хранения неиз-

меняемой информации: загрузочных программ операционной системы, про-

грамм тестирования устройств компьютера и некоторых драйверов базовой 
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системы ввода-вывода (BIOS — Base Input-Output System) и др. Из ПЗУ можно 

только считывать информацию, запись информации в ПЗУ выполняется вне 

ЭВМ в лабораторных условиях. ПЗУ — энергонезависимое запоминающее уст-

ройство. 

Внешние запоминающие устройства 

Внешние запоминающие устройства (ВЗУ) предназначены для долговре-

менного хранения программ и данных. Устройства выполняют в виде накопи-

телей, носителями информации в которых могут служить диски и ленты. Нако-

пители могут быть со сменными  носителями и со стационарными носителями 

информации. 

По способу доступа ВЗУ делятся на устройства прямого доступа и устрой-

ства последовательного доступа. Накопители на дисках — устройства прямого 

доступа, так как позволяют обратиться непосредственно к любому месту дис-

кового пространства. Накопители на магнитных лентах — устройства последо-

вательного доступа, так как доступ к нужной информации требует предвари-

тельного просмотра всей предыдущей.  

Основные характеристики ВЗУ— информационная емкость и время досту-

па. 

Диски относятся к машинным носителям с прямым доступом, это означа-

ет, что ПК может «обратиться» к дорожке, начинается участок с искомой ин-

формацией или куда нужно записать нужную информацию, где бы ни находи-

лась головка записи/чтения накопителя.   

Магнитные диски (МД) относятся к магнитным машинным носителям 

информации. В качестве запоминающей среды у них используются магнитные 

материалы со специальными свойствами (с прямоугольной петлей гистерезиса), 

позволяющими фиксировать два магнитных состояния — два направления на-

магниченности. Каждому из этих состояний ставятся в соответствие двоичные 

цифры: 0 и 1. Диски бывают жесткими и гибкими, сменными и встроенными в 

ПК. Устройство для чтения и записи информации на магнитном диске называ-

ется дисководом. 
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Все диски характеризуются своим диаметром или, иначе, формфактором. 

Информация на МД записывается и считывается магнитными головками 

вдоль концентрических окружностей — дорожек. Количество дорожек на МД и 

их информационная емкость зависят от типа МД, конструкции накопителя на 

МД, качества магнитных головок и магнитного покрытия. 

Каждая дорожка МД разбита на сектора. В одном секторе дорожки может 

быть помещено 128, 256, 512 или 1024 байт, но обычно 512 байт данных. Обмен 

данными между НМД и ОП осуществляется последовательно целым числом 

секторов. Кластер — это минимальная единица размещения информации на 

диске, состоящая из одного или нескольких смежных секторов дорожки. 

При записи и чтении информации МД вращается вокруг своей оси, а меха-

низм управления магнитной головкой подводит ее к дорожке, выбранной для 

записи или чтения информации. 

Накопители на дисках очень разнообразны. Существуют накопители на гиб-

ких магнитных дисках (НГМД), накопители на жестких магнитных дисках 

(НЖМД), накопители на оптических дисках. 

ВНЕШНИЕ УСТРОЙСТВА 

Внешние устройства ПК обеспечивают взаимодействие машины с окру-

жающей средой: пользователями, объектами управления и другими ЭВМ. ВУ 

весьма разнообразны и могут быть классифицированы по ряду признаков.  

1. Устройствам ввода информации. 

1) Клавиатура — устройство для ручного ввода числовой, текстовой и управ-

ляющей информации в ПК. С помощью клавиатуры управляют компьютерной 

системой. 

2) Графические планшеты (диджитайзеры) - для ручного ввода графической 

информации, изображений путем перемещения по планшету специального ука-

зателя (пера).  

3) Сканеры (читающие автоматы) — для автоматического считывания с бу-

мажных носителей и ввода в ПК машинописных текстов, графиков, рисунков, чер-

тежей.   

4) Цифровые фотокамеры. Как и сканеры, эти устройства воспринимают гра-
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фические данные с помощью приборов с зарядовой связью, объединенных в пря-

моугольную матрицу.  

5) Манипуляторы (устройства указания) Они предназначены для ввода графи-

ческой информации на экран дисплея путем управления движением курсора по 

экрану с последующим кодированием координат курсора и вводом их в ПК: 

− джойстик—рычаг; 

−  мышь, самый распространенный манипулятор. 

− трекбол — шар в оправе, в отличие от мыши он устанавливается стационарно, и 

его шарик приводится в движение ладонью руки. 

− световое перо;  

− инфракрасная мышь отличается от обычной наличием устройства беспроводной 

связи с системным блоком и т.д. 

2. Устройства вывода информации. 

1. Принтеры — печатающие устройства для регистрации информации на 

бумажный носитель. Они являются наиболее развитой группой ВУ ПК и насчиты-

вают до 1000 разных модификаций. 

 1) Матричные принтеры.  

 Принцип печати этих принтеров состоит в том, что печатающая головка 

принтера, содержащая вертикальный ряд тонких металлических стержней (иго-

лок), движется вдоль печатаемой строки, а стержни в нужный момент ударяют по 

бумаге через красящую ленту, что обеспечивает формирование на бумаге симво-

лов и изображений. 

 2) Лазерные принтеры. 

 В лазерном принтере изображение создается лазерным лучом. Им управляет 

сложная электроника, которая позиционирует луч с высокой точностью. Луч рису-

ет изображение на барабане внутри лазерного принтера. Там, где луч касается ба-

рабана, возникает электрический заряд. Барабан вращается над картриджем с то-

нером, собирая тонер на электрически заряженные участки. Когда барабан входит 

в контакт с бумагой, тонерное изображение переводится на бумагу. Чтобы закре-

пить тонер на бумаге, используется тепло. Качество печати приближается к типо-

графскому.  
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 3) Струйные принтеры. 

В этих принтерах изображение формируемся микрокаплями специальных 

чернил, выдуваемых на бумагу с помощью сопел. Этот способ печати обеспечива-

ет более высокое качество печати по сравнению с матричными принтерами, он по-

зволяет получить на специальной бумаге высококачественное цветное изображе-

ние. Однако струйные принтеры дороже матричных и требуют более тщательного 

ухода и обслуживания. Скорость печати струйных принтеров примерно от 10 до 

60 с на страницу.  

2. Графопостроители (плоттеры) — для вывода графической информации 

(графиков, чертежей, рисунков) из ПК на бумажный носитель. 

 3. Монитор - это устройство визуального представления данных. Его основ-

ными потребительскими параметрами являются: размер, шаг маски экрана, мак-

симальная частота регенерации изображения, класс защиты. 

3. Средства связи и телекоммуникации 

1. Модем - коммуникационное устройство, позволяющее передавать цифро-

вые данные по аналоговой телефонной линии. Он осуществляет преобразование 

данных с компьютера в последовательность дискретных (разнотипных) сигналов и 

их отправку по аналоговой телефонной линии. На другом конце они расшифровы-

ваются принимающим модемом путем аналого-цифрового преобразования.  

 2. Факс-модем - это устройство, сочетающее возможности модема и средст-

ва для обмена факсимильными изображениями с другими факс-модемами и обыч-

ными телефаксными аппаратами.  

4. Устройства речевого ввода-вывода. 

Эти устройства относятся к быстроразвивающимся средствам мультимедиа. 

Устройства речевого ввода — это различные микрофонные акустические системы, 

"звуковые мыши", например, со сложным программным обеспечением, по-

зволяющим распознавать произносимые человеком буквы и слова, идентифициро-

вать их и закодировать. 

Устройства речевого вывода — это различные синтезаторы звука, выпол-

няющие преобразование цифровых кодов в буквы и слова, воспроизводимые через 

громкоговорители (динамики) или звуковые колонки, подсоединенные к компью-
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теру. 

 Средства мультимедиа (multimedia — многосредовость) — это комплект ап-

паратных и программных средств, позволяющих человеку общаться с компьюте-

ром, используя самые разные, естественные для себя среды: звук, видео, графику, 

тексты, анимацию и др. К средствам мультимедиа относятся устройства речевого 

ввода и вывода информации; высококачественные видео- (video-) и, звуковые 

(sound-) платы, платы видеозахвата (videograbber), снимающие изображение с ви-

деомагнитофона или видеокамеры и вводящие его в ПК; высококачественные аку-

стические и видеовоспроизводящие системы с усилителями, звуковыми колонка-

ми, большими видеоэкранами, а так же внешние запоминающие устройства боль-

шой емкости на оптических дисках, часто используемые для записи звуковой и 

видеоинформации. 

Тема 4. Программное обеспечение ПК. 

Программное обеспечение – совокупность программ обработки данных. 

Программа – упорядоченная последовательность команд (инструкций) ком-

пьютера для решения задачи. 

Программный продукт - комплекс взаимосвязанных программ для решения 

определенной задачи массового спроса, подготовленный к реализации как любой 

вид промышленной продукции. 

 Интегрированное программное обеспечение — набор нескольких программ-

ных продуктов, функционально дополняющих друг друга, поддерживающих еди-

ные информационные технологии, реализованные на общей вычислительной и 

операционной платформе. 

Программное обеспечение можно классифицировать по разным признакам. 

Рассмотрим классификацию по сфере (области) использования программного 

обеспечения: 



 36

 

 
Системное программное обеспечение 

Системное программное обеспечение - совокупность программ и про-

граммных комплексов для обеспечения работы компьютера и компьютерных 

сетей. 

 
Базовое программное обеспечение 

Базовое программное обеспечение - минимальный набор программных 

средств, обеспечивающих работу компьютера. 

1. Операционная система - совокупность программ, предназначенных для 

управления ресурсами ЭВМ, организации диалога пользователя с ЭВМ, испол-

нения программ пользователя. 

Основная функция всех операционных систем - посредническая. Она за-

ключается в обеспечении нескольких видов взаимодействия (интерфейса): 

Программное обеспечение (ПО) 

Системное ПО Прикладное ПО Инструментарий технологий про-
граммирования 

Системное программное обеспечение 

Базовое программное обеспечение Сервисное программное обеспечение 

Операционная система 

Операционная оболочка 

Сетевая операционная система 

Программы диагностики работо-
способности компьютера 

Антивирусные программы 

Программы обслуживания 
 дисков 

Программы архивирования данных 

Программы обслуживания сети 
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− интерфейс пользователя (взаимодействие между пользователем и программ-

но-аппаратными средствами компьютера); 

− аппаратно-программный интерфейс (взаимодействие между программным и 

аппаратным обеспечением); 

− программный интерфейс (взаимодействие между разными видами про-

граммного обеспечения). 

Программы, работающие под управлением операционной системы, назы-

вают приложениями.  

Операционные системы для персональных компьютеров можно классифи-

цировать по нескольким признакам: 

1) По реализации интерфейса. 

Различают неграфические (текстовые) и графические операционные сис-

темы. Неграфические операционные системы (MS DOS) реализуют интерфейс 

командной строки. Основным устройством управления в данном случае являет-

ся клавиатура. 

Работа в графической ОС основана на взаимодействии активных и пассив-

ных экранных элементов управления. В качестве активного элемента управле-

ния выступает указатель мыши, в качестве пассивных элементов управления 

выступают экранные кнопки, значки, переключатели, флажки, списки,  меню и 

многое другое. 

2) Поддержка многозадачности. 

Однозадачные операционные системы (Ms-Dos) передают все ресурсы вы-

числительной системы одному исполняемому приложению. 

 Многозадачность допускает параллельное выполнение нескольких при-

ложений. Различают вытесняющую и невытесняющую многозадачность. 

При невытесняющей многозадачности (NetWare) активный процесс вы-

полняется до тех пор, пока он сам по собственной инициативе, не отдаст управ-

ление операционной системе для того, чтобы та выбрала из очереди другой го-

товый к выполнению процесс. При вытесняющей многозадачности (Windows 

95/98/2000, Windows NT, OS/2, Unix) решение о переключении процесса с од-
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ного на другой принимается операционной системой, а не самим активным 

процессом. 

3) Поддержка многопользовательского режима. 

В зависимости от числа пользователей, одновременно работающих с ОС, 

ОС делятся на однопользовательские (Ms DOS, ранние версии OS/2) и много-

пользовательские (Unix, Windows NT). Многопользовательские ОС позволяют 

нескольким пользователям разделять вычислительные ресурсы одного компью-

тера.  

4) Поддержка переносимости (непереносимые и переносимые на другие 

типы компьютеров); 

5) Поддержка работы в сетях (несетевые и сетевые). 

2. Операционные оболочки - специальные программы, предназначенные 

для облегчения общения пользователя с командами операционной системы.  

3. Сетевые операционные системы – комплекс программ, обеспечивающий 

обработку, передачу и хранение данных в сетях. 

Сервисное программное обеспечение 

Сервисное программное обеспечение (программы-утилиты) — програм-

мы и программные комплексы, которые расширяют возможности базового про-

граммного обеспечения и организуют более удобную среду работы пользовате-

ля. 

1. Программы диагностики работоспособности компьютера и обслужива-

ния дисков (служебные программы). 

1) Форматирование диска (Format) – разбиение диска на дорожки и секто-

ра. 

2) Дефрагментация диска (Disk Defragments) – процедура по переносу ин-

формации из одних кластеров в другие, в результате которой доступ к любой 

информации будет более быстрым. 

3) Проверка диска (Scandisk) – программа обнаружения ошибок, связанных 

со сбоями в процессе записи на диск. 

4) Корзина - восстановление удаленных файлов. 
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5) Очистка диска – программа освобождает место на диске путем удаления 

временных файлов (в корзине, из Интернета, для быстрого просмотра). 

6) Сведения о ресурсах (Sistem Information) – параметры аппаратного 

обеспечения; программная среда; программа отображает неполадки компьюте-

ра, но не устраняет их. 

2. Программы архивирования данных. 

Архивный файл – это специальным образом организованный файл, со-

держащий в себе один или несколько файлов в сжатом или несжатом виде и 

служебную информацию об именах файлов, дате и времени их создания или 

модификации, размерах и т. п. 

Архивация (упаковка) – помещение (загрузка) исходных файлов в архив-

ный файл в сжатом или несжатом виде. 

Цели сжатия файлов: 

− обеспечение более компактного размещения информации на диске; 

− сокращение времени и стоимости передачи информации по каналам связи в 

сетях; 

− упрощение переноса файлов с одного диска на другой; 

− защита информации от несанкционированного доступа; 

− защита от заражения вирусами. 

Степень сжатия информации характеризуется коэффициентом сжатия: 

%100
0

⋅=
V
V

K c
c , где Vс – объем сжатого файла, V0 – объем исходного файла. 

Хорошо сжимаются графические и текстовые файлы. Слабо сжимаются 

файлы исполняемых программ. 

Разархивация (распаковка) – процесс восстановления файлов из архива 

точно в таком виде, какой они имели до загрузки в архив. При распаковке фай-

лы извлекаются из архива и помещаются на диск или в оперативную память.  

Наиболее распространенные программы – архиваторы: WinRAR и Win-

ZIP. 

3. Антивирусные программы. 
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Компьютерным вирусом называется специально написанная программа, 

способная самопроизвольно присоединяться к другим программам, создавая 

свои копии и внедряя их в файлы, системные области компьютера и в вычисли-

тельные сети с целью нарушения работы программ, порчи файлов и каталогов, 

создания всевозможных помех в работе на компьютере. 
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Признаки появления вирусов: 

− прекращение работы или неправильная работа программы; 

− невозможность загрузки операционной системы; 

− увеличение размера файлов; 

− исчезновение файлов и каталогов или искажение их содержимого; 

− увеличение размера свободной памяти; 

− подача непредусмотренных звуковых сигналов. 

Классификация вирусов 

1. По среде обитания: сетевые, файловые, загрузочные, файлово-

загрузочные. 

2. По способу заражения: резидентные, нерезидентные. 

3. По степени воздействия: неопасные, опасные, очень опасные. 

4. По особенности алгоритмов: паразитические, репликаторы, невидимки, 

мутанты, троянские. 

 Антивирусная программа – это программа, предназначенная для обнару-

жения, удаления и защиты от компьютерных вирусов. 

Классификация антивирусных программ 

1. Детекторы - осуществляют поиск характерной для конкретного вируса 

последовательности байтов в оперативной памяти и в файлах и при обнаруже-

нии выдают соответствующее сообщение. 

2. Доктора - находят зараженные вирусами файлы и «лечат» их, т. е. уда-

ляют из файла тело программы вируса, возвращая файлы в исходное состояние. 

3. Ревизоры – запоминают исходное состояние программ, каталогов и 

системных областей диска до заражения вирусом, а затем периодически или по 

желанию пользователя сравнивают текущее состояние и исходным 

4. Фильтры - предназначены для обнаружения подозрительных действий 

при работе компьютера. 

5. Вакцины – резидентные программы, предотвращающие заражение 

файлов. 
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Прикладное программное обеспечение 

1. Текстовые редакторы. 

Основные функции текстовых редакторов заключаются в автоматизации 

ввода и редактирования текстовых данных. 

В отличие от текстовых редакторов, текстовые процессоры позволяют не 

только вводить и редактировать текст, но и форматировать его, т.е. оформлять. 

Соответственно, к основным средствам текстовых процессоров относятся сред-

ства обеспечения взаимодействия текста, графики, таблиц и других объектов. 

Назначение настольных издательских систем состоит в автоматизации 

процесса верстки полиграфических изданий. 

2. Графические редакторы. 

3. Системы управления базами данных (СУБД).  

4. Электронные таблицы. 

5. Системы автоматического проектирования. 

Программы этого класса предназначены для автоматизации проектно-

конструкторских работ, связанных с разработкой чертежей, схем, диаграмм, 

графическим моделированием и конструированием, созданием библиотеки 

стандартных элементов чертежей и их многократным использованием, созда-

нием демонстрационных иллюстраций и мультфильмов. 

6. Системы автоматизированного управления. 

Системы автоматизированного управления - самый представительный 

класс программных продуктов, включающий в себя программные продукты: 

- автоматизированного бухгалтерского учета; 

- управления финансовой деятельности; 

- управления персоналом (кадровый учет); 

- управления материальными запасами; 

- управления производством; 

- банковские информационные системы и т.п. 

7. Офисные приложения. 

Данный класс программных продуктов охватывает программы, обеспечи-
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вающие организационное управление деятельностью офиса: элементарные тек-

стовые редакторы;  органайзеры; автоматизированный перевод документов; 

средства проверки орфографии и распознавания текста; электронная почта.  

8. Экспертные системы. 

 Предназначены для анализа данных, содержащихся в банках знаний, и 

выдачи рекомендаций по запросу пользователя. такие системы применяют в тех 

случаях, когда исходные данные хорошо формализуются, но для принятия ре-

шения требуются обширные специальные знания. Характерными областями 

использования экспертных систем являются юриспруденция, медицина, фарма-

кология, химия.  

9. Редакторы HTML (Web- редакторы). 

Это особый класс редакторов, объединяющий в себе свойства текстовых и 

графических редакторов. Они предназначены для создания и редактирования 

так называемых Web- документов (Web- страниц Интернета). Программы этого 

класса эффективно используют для подготовки электронных документов и 

мультимедийных изданий. 

10. Геоинформационные системы (ГИС) 

ГИС предназначены для автоматизации картографических и геодезических 

работ на основе информации, полученной топографическими или аэрокосмиче-

скими методами. 

11. Автоматизация научно-исследовательских работ. 

Программы, автоматизирующие научно-исследовательские работы, ис-

пользуют вычислительную мощь компьютера для решения расчетных задач.  

12. Программные средства мультимедиа. 

Этот класс программных продуктов является относительно новым. Основ-

ное назначение программных продуктов мультимедиа - создание и использова-

ние аудио- и видеоинформации для расширения информационного пространст-

ва пользователя.  

13. Системы видеомонтажа. 

Системы видеомонтажа предназначены для цифровой обработки видеома-
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териалов, их монтажа, создания видеоэффектов, устранения дефектов, наложе-

ния звука, титров и субтитров. 

14. Компьютерная обработка звука. Музыкальные редакторы. 

Компьютерная обработка звука ориентирована на систему цифровой запи-

си. Музыкальные редакторы позволяют обрабатывать звук, записанный на зву-

ковой носитель; реставрировать старые записи с помощью встраиваемых при-

ложений; осуществлять нотную запись; создавать многоканальную запись; под-

готавливать звуковые файлы к публикации в Интернет. 

15. Обучающие программы. 

Обучающие программы  предназначены для самостоятельного изучения 

данной темы, широко используются в заочном или дистанционном образова-

нии.  

Инструментарий технологии программирования 

 Это совокупность программ и программных комплексов, обеспечивающих 

технологию разработки, отладки и внедрения создаваемых программных про-

дуктов. 

Инструментарий технологии программирования обеспечивает процесс 

разработки программ и включает специализированные программные продукты, 

которые являются инструментальными средствами разработчика. Программные 

продукты данного класса поддерживают все технологические этапы процесса 

проектирования, программирования (кодирования), отладки и тестирования 

создаваемых программ. Пользователями технологии программирования явля-

ются системные и прикладные программисты. 

Инструментарий технологии программирования включают в себя следую-

щие классы: 

− средства для создания приложений (языки и системы программирования); 

− средства для создания информационных систем (CASE - технологии). 

Языки программирования - формальный язык для описания алгоритма ре-

шения задачи на компьютере.  

Системы программирования - хорошо интегрированная система, вклю-



 45

чающая в себя как минимум: 

− специализированный текстовый редактор;  

− компилятор для перевода текста программы в машинный код; 

− библиотека функций; 

− редактор связей для связывания модулей (файлов с исходными текстами) и 

стандартных функций, находящихся в библиотеках; 

− исполнимый код - это законченная программа с расширением .COM или 

.EXE, которую можно запустить  на любом компьютере, где установлена 

операционная система, для которой эта программа  создавалась; 

− справочную систему; 

− отладчик, который позволяет анализировать работу программы во время ее 

выполнения по шагам. 

CASE-технологии - программный комплекс, автоматизирующий весь тех-

нологический процесс анализа, проектирования, разработки и сопровождения 

сложных программных систем. 

Тема 5. Файловая система. Norton-подобные операционные оболочки. 

Файловая система 

Файловая система (ФС) является важной частью любой операционной 

системы, которая отвечает за организацию хранения и доступа к информации 

на каких-либо носителях. 

ФС - это совокупность именованных наборов данных и программ на 

внешних  носителях,   структуру  и   организацию   которых  поддерживает опе-

рационная система. 

В широком смысле понятие ФС включает: 

− совокупность всех файлов на диске,  

− наборы служебных структур данных, используемых для управления файла-

ми, такие как, например, каталоги файлов, дескрипторы файлов, таблицы 

распределения свободного и занятого пространства на диске,  
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− комплекс системных программных средств, реализующих управление фай-

лами, в частности операции по созданию, уничтожению, чтению, записи, 

именованию файлов, установке атрибутов и уровней доступа, поиску и т.д.  

Различие между файловыми системами заключается, в основном, в спосо-

бах распределения пространства между файлами на диске и организации на 

диске служебных областей. 

Файл - это поименованная совокупность  элементов  информации храня-

щаяся на магнитных носителях - дисках, лентах.  

Имена файлов записываются следующим образом:  ИМЯ . ТИП,  где 

ИМЯ набор символов (короткое не более 8 символов, длинное – 256 ) латинско-

го алфавита,  цифр и специальных символов ~ & @ ( ) %  { } _ #  $,  а ТИП или 

РАСШИРЕНИЕ файла состоит  из не более чем 3 символов.  В отличие от име-

ни тип может отсутствовать в спецификации файла. 

Тип файла  используется для классификации,  определения принадлежно-

сти к какой-то группе с общими свойствами.  

При использовании имен файлов в качестве параметров команд ОС необ-

ходимо указывать адрес или путь к файлу. Путем к  файлу называется цепочка 

символов,  начиная с имени дисковода,  корневого каталога и последующих 

подкаталогов  вплоть до каталога, содержащего необходимый файл. 

Имя дисковода - это одна из букв латинского алфавита. Персональный 

компьютер  имеет несколько накопителей на магнитных носителях, исходя из 

этого,  принято обозначать A: и B: - гибкие диски, C: D: и т.д. - жесткие диски. 

Каталог - это справочник файлов и библиотек со  ссылками  на их распо-

ложение, содержащее информацию о файлах (имя, тип, размеры в байтах, дата 

и время создания, атрибуты) и других каталогах, называемых подкаталогами,  

используется операционной системой для определения местоположения файла. 

 На каждом  диске  имеется один главный или корневой каталог. Каталоги, 

входящие в корневой  каталог  называются  подкаталогами 1-го уровня.  Ката-

логи, входящие в состав подкаталога 1-го уровня называются подкаталогами 2-

го уровня и т.д. Каждый подкаталог является оглавлением,  содержащим пере-
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чень имен файлов и подкаталогов, возможны варианты, когда в оглавлении  

имеются  только  имена файлов.  

Организация файловой системы 

Принцип организации файловой системы — табличный. Поверхность же-

сткого диска рассматривается как трехмерная матрица, измерениями которой 

являются номера поверхности, цилиндра и сектора. Под цилиндром понимается 

совокупность всех дорожек, принадлежащих разным поверхностям и находя-

щихся на равном удалении от оси вращения. Данные о том, в каком месте диска 

записан тот или иной файл, хранятся в системной области диска в специальных 

таблицах размещения файлов (FAT-таблицах). К FAT-таблицае предъявляются 

особые требования надежности, и она существует в двух экземплярах, идентич-

ность которых регулярно контролируется средствами операционной системы. 

 Наименьшей физической единицей хранения данных является сектор. 

Размер сектора равен 512 байт. Поскольку размер FAT- таблицы ограничен, то 

для дисков, размер которых превышает 32 Мбайт, обеспечить адресацию к ка-

ждому отдельному сектору не представляется возможным. В связи с этим груп-

пы секторов условно объединяются в кластеры. Кластер является наименьшей 

единицей адресации к данным. Размер кластера, в отличие от размера сектора, 

не фиксирован и зависит от емкости диска. 

Операционные системы MS-DOS, OS/2, Windows 95, Windows NT реали-

зуют 16-разрядные поля в таблицах размещения файлов. Такая ФС называется 

FAT 16. Она позволяет разместить в FAT-таблицах не более 65 536 записей (216) 

о местоположении единиц хранения данных и, соответственно, для дисков объ-

емом от 1 до 2 Гбайт длина кластера составляет 32 Кбайт (64 сектора).  

Высокопроизводительная ФС HPFS (High Performance File System) позво-

ляет использовать жесткие диски объемом до 2 Терабайт. Кроме того, она под-

держивает разделы диска размером до 512 Гб и позволяет использовать имена 

файлов длиной до 255 символов. В HPFS по сравнению с FAT уменьшено вре-

мя доступа к файлам в больших каталогах.  
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ФС VFAT (Virtual FAT), реализованная в Windows NT 3.5, Windows 95 

(DOS 7.0) - это файловая система FAT, включающая поддержку длинных имен 

файлов. VFAT использует ту же самую схему распределения дискового про-

странства, что и файловая система FAT. 

ФС FAT32 - усовершенствованная версия файловой системы VFAT, под-

держивающая жесткие диски объемом до 2 терабайт. Главные отличия от пре-

дыдущих версий FAT состоят в следующем. Блок начальной загрузки на разде-

лах с FAT32 был увеличен до 2 секторов и включает в себя резервную копию 

загрузочного сектора, что позволяет системе быть более устойчивой к возмож-

ным сбоям на диске. Объем, занимаемый таблицей размещения файлов, увели-

чился, поскольку теперь каждая запись в ней занимает 32 байта, и общее число 

кластеров на разделе FAT32 больше, чем на разделах FAT. Соответственно, вы-

росло и количество зарезервированных секторов. 

ФС NTFS (New Technology File System) - наиболее предпочтительная фай-

ловая система при работе с ОС Windows NT (Windows 2000 и XP также являют-

ся NT системами), поскольку она была специально разработана для данной сис-

темы. В NTFS значительно расширены возможности по управлению доступом к 

отдельным файлам и каталогам, введено большое число атрибутов, реализована 

отказоустойчивость, средства динамического сжатия файлов. NTFS позволяет 

использовать имена файлов длиной до 255 символов, при этом она использует 

тот же алгоритм для генерации короткого имени, что и VFAT. NTFS обладает 

возможностью самостоятельного восстановления в случае сбоя ОС или обору-

дования, так что дисковый том остается доступным, а структура каталогов не 

нарушается. NTFS позволяет хранить файлы размером до 16 эксабайт (264 байт) 

и располагает встроенным средством уплотнения файлов в реальном времени.  

Операционная система Microsoft DOS. 

1. Начальные сведения о DOS. 

DOS является основной частью программного обеспечения. DOS означает 

Disk Operating System (дисковая операционная система), которая необходима 

для запуска и работы компьютера. 
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DOS   является  однопользовательской  и  однозадачной  ОС.  Диалог поль-

зователя с DOS осуществляется в форме команд, которые записываются в ко-

мандной строке,  начинающейся с приглашения DOS.  Командная строка обыч-

но имеет следующий вид: C:\>_ 

2. Составные части DOS 

 1. Базовая система ввода/вывода (BIOS), находящаяся в постоянной памя-

ти (постоянном запоминающем устройстве, ПЗУ) компьютера.  

2. Загрузчик ОС (ядро DOS) - это очень короткая программа,  находящаяся 

в  первом секторе каждой дискеты с ОС DOS.   

3. Дисковые файлы Io.sys и Msdos.sys.   

4. Командный  процессор находится в файле Command.com на диске, с ко-

торого загружается ОС.   

5. Драйверы устройств - это специальные программы, которые дополняют 

систему ввод/вывода DOS и обеспечивают  обслуживание  новых  или нестан-

дартное использование имеющихся устройств.   

Операционные оболочки. 

Программа-оболочка – это программа, один из модулей которой, называе-

мый резидентным, постоянно находится в оперативной памяти компьютера. 

Оболочки позволяет эффективно работать с файловой системой  дисков, а 

также запускать программы на исполнение. 

Элементы экрана Windows Commander. 

Главное меню расположено в верхней строке окна и заключает в себе все 

возможности программы, рассортированные по более или менее однотипным 

командам.  

Панели – две равноправные таблицы, занимающие основную часть окна. 

Внутри панелей может отображаться различная информация. Одна из панелей 

является активной (на ней находится курсор и заголовок панели подсвечен), 

другая панель – пассивная. Смена активное панели достигается нажатием  Tab 

или щелчком мыши в любой части панели. При этом курсор перемещается с 

одной панели на другую. Панели предназначены для представления различной 
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информации на экране. С панелями связаны пункт меню Вид, который имеет 

три основных раздела. Первый раздел меню Вид содержит команды, управ-

ляющие тем, что выводится в панелях, второй раздел – как выводится, третий 

раздел — режимы сортировки. 

Командная строка располагается под панелями и служит для выполнения 

команд MS-DOS.   

Меню функциональных клавиш расположено в самой нижней строке экра-

на. Оно имеет вид подсказок к функциональным клавишам. 

Вид информации в окне 

Для выбора внешнего вида информации, выводимой в рабочей области ок-

на необходимо выполнить команду главного меню Вид и установить флажки 

возле команд, которые должны выполняться. Изменения произойдут только в 

текущей панели. 
Сочетание 
клавиш 

Команда Назначение 

Ctrl+F1 Краткий  Краткая информация о файле (только имя) 
Ctrl+F2 Подробный Полная информация о файле (имя, расширение, размер, дата, 

атрибуты) 
Ctrl+F8 Дерево В панели выводится дерево каталогов текущего диска. При 

перемещении по дереву в противоположной панели отобра-
жается содержимое открываемого каталога 

Ctrl+Q Быстрый 
просмотр 

Если установить курсор на какой-либо файл текущей панели, 
то в противоположной панели появится его содержимое. Ес-
ли установить курсор на каталог, то появиться информация о 
нем (общий размер, количество файлов) 

 Одна панель 
под другой 

Панели размещаются в окне горизонтально, одна под другой 

Работа с папками и файлами 

1. Смена оглавление диска в панели. 

Сменить оглавление диска в текущей панели можно несколькими способами: 

1. Щелкнуть по кнопке с названием диска. 

2. Обратиться к окну выбора диска и выбрав нужный диск из списка, 

щелкнуть по нему левой кнопкой мыши. 

3. Воспользоваться комбинацией клавиш Alt+F1 для левой панели или 

Alt+F2 – для правой. Результатом нажатия клавиш будет открытие окна выбора 

дисков. Перемещаясь по списку доступных дисков при помощи клавиш ↑ и ↓, 
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установить курсор на имя нужного дика и нажать Enter. 

2. Переход из каталога в каталог. 

Войти в каталог можно: Выйти из каталога: 

1. Двойным щелчком мыши. 

2. Установить курсор на каталог и на-

жать клавишу Enter. 

 

1. Переместить курсор в крайнее 

верхнее положение (стрелка вверх и 

двоеточие) и дважды щелкнуть мыш-

кой. 

2. Переместить курсор в крайнее 

верхнее положение и нажать клавишу 

Enter. 

3. Выделение файлов и каталогов. 

Прежде чем выполнять какие либо действия с файлами и каталогами их 

необходимо выделить. Для этого существует множество способов. 

Чтобы выделить один файл или один каталог по нему можно просто щелк-

нуть мышкой или установить курсор. 

Для выделения группы файлов используется клавиша Insert. Выделенный 

файл становится красного цвета. Повторное нажатие клавиши Insert, снимает 

выделение. Тот же эффект достигается при щелчке по файлу правой кнопкой 

мыши.  

Группу смежных файлов (подряд идущих) можно выделить при помощи 

клавиш перемещения курсора ↑, ↓, удерживая клавишу Shift. Группу несмеж-

ных файлов (располагающихся в списке не подряд) можно выделить при помо-

щи левой кнопки мыши удерживая при этом клавишу Ctrl. 

1. Просмотр файла.  

Для просмотра файл необходимо выделить. Затем нажать клавишу или 

кнопку F3. Откроется специальное окно программы просмотра. Текст в этом 

окне можно только просматривать. 

2. Редактирование файла. 

Для редактирования файла его необходимо выделить и нажать клавишу F4. 

Откроется окно стандартной программы Блокнот. Файл, который был выделен, 
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автоматически загружается в это окно. Здесь, в отличие от программы про-

смотра, курсор активен, а это значит, что доступны элементарные приемы ре-

дактирования: можно набирать с клавиатуры текст, вносить в него изменения и 

удалять. 

3. Копирование файла или каталога.  

Для копирования файлов и каталогов служит клавиша F5. Технология ко-

пирования заключается в следующем. 

1) Раскрыть в одной панели тот каталог, в который копируем. 

2) В другой панели поставить курсор на тот файл или каталог, который ко-

пируем. 

3) Нажать F5. 

4) Нажать Enter. 

4. Перемещение файла или каталога. 

Процесс перемещения аналогичен процессу копирования, разница лишь в 

том, что объекты перемещаются из каталога в каталог, а не копируются. Для 

начала процесса перемещения нужно нажать кнопку F6. 

5. Переименование файлов и каталогов. 

Самый простой способ переименовать объект это выделить его щелчком 

левой кнопки мыши, а затем повторить щелчок. Текстовое поле, содержащее 

имя объекта активизируется, в нем появится курсор. Старое имя можно удалить 

и ввести новое. 

9. Создание нового каталога. 

Для создания каталога необходимо перейти в каталог, внутри которого бу-

дет создаваться новый каталог и нажать F7. Появится диалоговое окно для вво-

да имени нового каталога. После нажатия Enter каталог будет создан. 

10. Удаление файлов и каталогов. 

Удаление происходит с помощью клавиши F8, после нажатия которой 

нужно необходимое количество раз подтвердить удаление. 

11. Быстрый поиск каталогов. 

При выполнении команды Команды→Дерево каталогов (ALT+F10 )выво-
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дится окно, в котором помещено дерево каталогов диска, выведенного на теку-

щей панели. При помощи этого окна можно быстро перейти в нужный каталог. 

Для этого нужно установить на него курсор и либо нажать Enter, либо дважды 

щелкнуть мышкой, либо нажать кнопку Ок. Клавиша F2 позволяет обновить 

дерево каталогов. 

12. Поиск файлов. 

Осуществить поиск файлов можно при помощи команды Команды→Поиск 

файлов…(ALT+F7).  

13. Архивация файлов. 

Для того, чтобы поместить объекты в архив, их необходимо выделить. За-

тем выполнить команду Файл→Упаковать или нажать сочетание клавиш 

Alt+F5.  Появится окно Упаковка файла. В этом окне можно задать архиватор и 

тип архивации. В текстовое поле Упаковать файлы в архив необходимо ввести 

полное имя будущего архивного файла.  

Для того, чтобы извлечь объекты из архива, необходимо выделить архив-

ный файл и выполнить команду Файл→Распаковать или нажать сочетание кла-

виш Alt+F9. На экране появится окно Распаковка файлов. В текстовом поле 

Распаковать выбранные файлы из архива в: необходимо указать имя диска и ка-

талога в который будет извлечена информация из архива. 

14. Создание файла. 

Для создания файла необходимо нажать сочетание клавиш Shift+F4. В поя-

вившемся окне Редактирование файла вводится имя создаваемого файла и на-

жимается клавиша Enter. 

Тема 6. Операционная система Windows. 

Основные характеристики и история создания. 

Первая графическая многооконная операционная оболочка Windows фир-

мы Microsoft появилась в 1986 г. После своего возникновения  она пережила 

ряд модификаций, но не все из них были удачными. Однако в 1991 г. вышла 

версия операционной среды Windows 3.1 и несколько позже сетевой вариант 

Windows 3.11 For WorkGroups, завоевавшие широкое признание миллионов 
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пользователей.  Дальнейший ряд Windows-продуктов продолжили высокопро-

изводительные многозадачные, полнофункциональные операционные системы 

с графическим интерфейсом Windows 95, Windows 98, Windows 2000 для ком-

пьютеров платформы IBM PC. 

Основными характеристическими чертами операционной системы 

Windows 95 являются: 

1. Единый графический пользовательский интерфейс, который составляют ра-

бочий стол, окна, панель задач и другие графические объекты (кнопки, пик-

тограммы, списки и т.п.). 

2. Интегрированная операционная система, ядро которой загружается в момент 

включения компьютера, активизирует графический интерфейс пользователя 

и обеспечивает полную совместимость с операционной системой MS-DOS. 

3. Объектно-ориентированная система. 

4. Программная совместимость обеспечение полной независимости программ 

от аппаратной части компьютера. 

5. Вытесняющая многозадачность - свойство операционной системы самостоя-

тельно в зависимости от внутренней ситуации передавать или забирать 

управление у того или иного приложения, не позволяющее одному прило-

жению занять все аппаратные ресурсы. 

6. 32-разрядная операционная система, поддерживающая 16-разрядные прило-

жения без всякой их модификации. 

7. Многопоточность - свойство операционной системы выполнять операции 

одновременно над потоками нескольких 32-битовых приложений. Поток - 

это некоторая часть процесса, который может быть выделено процессорное 

время для одновременного выполнения наряду с другими потоками.  

8. Сетевые возможности. Хотя ОС Windows предназначена для управления ав-

тономным компьютером, но также содержит все необходимые средства для 

создания небольшой локальной одноранговой сети: совместное использова-

ние ресурсов файлового сервера, принтеров, факс-модемов. Windows 95 
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имеет средства для интеграции компьютера во всемирную сеть: использова-

ние электронной почты и других средств коммуникации. 

9. Средства обмена данными между приложениями: буфер обмена (Clipboard), 

технологии DDE (Dynamic Data Exchange), OLE (Object Linking and 

Embedding).   

10. Интерфейс мультимедиа, включает в себя лазерный проигрыватель (CD-

плеер), обеспечивает поддержку видеодисков и видеомагнитофонов и т.п. 

11. Поддержка длинных имен файлов и папок (до 255 символов). 

12. Использование технологии Plug and Play ("включи и работай") позволяет 

осуществляет функции распознания новых устройств для их установки и 

настройки, при этом обеспечивает динамическое изменение конфигурации 

системы и автоматического уведомления об этом программных приложе-

ний.  

13. Реализация принципа WYSIWYG -What You See Is What You Get ("что ви-

дишь, то и получаешь"). Принцип реализуется при выводе на печать ин-

формации, полностью соответствующей изображению на экране. 

14. Технология AutoPlay позволяет автоматически озвучивать работу с Windows 

при установленных средствах мультимедиа. 

15. Режим MouseKeys позволяет все действия с мышью выполнять через кла-

виатуру). 

По сравнению с Windows 95, Windows 98 включает средства, позволяющие 

компьютеру работать быстрее без добавления нового оборудования. В состав 

Windows 98 входит ряд программ, совместное применение которых повышает 

производительность компьютера: 

− Служебные программы позволяют быстрее выполнять программы, прове-

рять жесткий диск на наличие ошибок и освобождать место на диске, обес-

печивать бесперебойную работу системы. 

− Проверка диска запускается автоматически после неверного выключения 

ОС. 
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− Новый Web-узел ресурсов Microsoft Windows Update автоматизирует про-

цесс обновления драйверов и системных файлов и обеспечивает новейшие 

возможности технической поддержки. 

− Обозреватель Интернета Internet Explorer делает ряд функций доступными с 

рабочего стола Windows: каналы Web - узлов на рабочем столе, возможно-

сти поиска в Интернет, панели обозревателя. Приложение Internet Explorer 

объединяет рабочий стол  с Web, благодаря чему рабочий стол и его папки 

будут выглядеть и действовать так же, как при работе с Web. Такой рабочий 

стол называется Active Desktop. 

Главными новыми технологическими решениями, реализованных в 

Windows 2000, являются расширение сетевых возможностей и усовершенство-

вание функций защиту информации в сетях. Windows 2000 оснащена целым ря-

дом свойств управления клиентами и серверами, позволяющих снизить общую 

стоимость эксплуатации операционной системы. 

Основные элементы графического интерфейса Windows. 

Задача интерфейса - сделать компьютер доступнее, понятнее для пользова-

теля.  

По замыслу разработчиков, общий вид монитора ассоциируется с видом 

обычного рабочего стола, на котором располагаются документы (окна, подоб-

ные листам бумаги).    

Рабочий стол (DeskTop) - все  пространство экрана в среде Windows с рас-

положенными на нем графическими объектами. 

Вдоль одной из границ (чаще в нижней части) рабочего стола находится 

панель задач. Панель задач содержит: 

− кнопку ПУСК - главное системное меню; 

− доступ ко всем открытым приложениям. При открытии приложения на па-

нели задач появляется соответствующая открытому окну кнопка. Нажатие 

этой кнопки позволяет быстро перейти в выбранное окно.  

− пиктограммы специальных "фоновых" приложений: часы, индикатор теку-

щей раскладки клавиатуры и др. 
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Главное системное меню предназначено для быстрого запуска программ, 

поиска файлов, обеспечения доступа к справке, вызов панели управления для 

настройки компьютера и др. Меню содержит в себе несколько пунктов, при 

подведении указателя мыши на одном из пунктов автоматически открывается 

подменю для выбора нужной операции. 

1. Пункт Программа позволяет запускать программы.  

2. Пункт Документы содержит ярлыки 15 последних открывавшихся докумен-

тов.  

3. Пункт Избранное характерен для ActiveDesktop и позволяют осуществлять 

доступ к средствам всемирной сети. 

4. Пункт Настройка позволяет настраивать: панель задач, в том числе пункты 

главного меню; панель управления, доступ к которой также можно получить 

через папку Мой Компьютер; свойства папки Принтеры и др. 

5. Пункт Найти позволяет осуществлять поиск папок и файлов на дисках ком-

пьютера, в локальной сети, в Интернет. Поиск можно осуществлять, используя 

маску файлов, дату создания файла, по типу файла, его размеру, поиск по тек-

сту. 

6.  Пункт Справка выводит справку по работе с Windows. 

7. Пункт Выполнить позволяет запускать программы на исполнение, при этом 

необходимо указать путь и имя запускаемого файла. 

8. Пункт Завершение работы необходим для корректного завершения работы с 

Windows, перезагрузки компьютера, перезагрузки с выходом в режим MS-DOS.  

На рабочем столе размещено несколько графических объектов - ярлыков. 

Ярлык - маленький файл-указатель, с помощью которого можно быстро 

получить доступ к объекту (файлу, каталогу, диску, программе). 

Ярлык представлен в виде значка (пиктограммы) и названия. Двойной 

щелчок по ярлыку открывает объект, с которым он связан. 

Основными объектами файловой структуры Windows являются файл, ка-

талог, ярлык.  С этими объектами можно проделывать следующие операции: 

создавать, переименовывать, удалять, копировать, перемещать и другие. В 
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Windows, по аналогии с обычными терминами, принято называть каталог - пап-

кой, файл - документом. 

Изначально на Рабочем столе расположены значки «Мой компьютер», 

«Сетевое окружение», «Корзина» и «Портфель».   

 Мой компьютер отражает содержание всего компьютера целиком. Папка 

позволяет просмотреть содержимое находящихся на компьютере дисков, дос-

туп к панели управления, сетевому окружению. 

Сетевое Окружение - обеспечивает доступ к ресурсам сети, если к ней 

подключен компьютер. 

В Портфель, как и в обычный дорожный портфель, в котором носят нуж-

ные документы, помещают файлы и папки, с которыми пользователь работает 

на нескольких компьютерах: дома и на работе, на настольном и переносном 

компьютере в дороге. Портфель содержит базу данных, позволяющую сопоста-

вить несколько вариантов одного документа и выбрать оптимальный.  

Корзина  - специальная папка, предназначена для временного хранения 

удаленных файлов, папок, ярлыков. Она позволяет восстановить объекты, уда-

ленные по ошибке. Размер корзины устанавливает пользователь. По мере рабо-

ты следует регулярно очищать корзину, особенно когда возникают проблемы 

со свободным дисковым пространством.  

Структура окна в Windows. 

Окно - прямоугольная область экрана, в которой может отображаться при-

ложение, документ или сообщение. 

Окно может быть представлено в виде: свернутое на панель задач (мини-

мизировано), нормальное (окно с обрамление), полноэкранное окно (распахну-

тое на весь экран). 

Любое окно Windows имеет ряд стандартных элементов.  

Системное меню содержит команды для изменения размеров окна, его пе-

ремещения, минимизации, закрытия. 

Заголовок окна является удобным управляющим элементом для переме-

щения окна. В заголовке окно отображается название приложения и документа 
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(имя открытого файла). 

Строка меню содержит пункты для открытия ниспадающего меню. 

Контекстное меню (всплывающее меню) появляется при нажатии правой 

кнопки мыши и содержит активные команды для данного объекта.  

Рабочее поле окна представляет собой область для размещения окна доку-

мента, и которая будет пустой, пока ни один документ не открыт. 

Рамка окна - двойная линия, обрамляющая нормальное окно. Она служит 

управляющим элементом для изменения размеров окна.  

Линейки (полосы) прокрутки окаймляют левую и нижнюю стороны окна и 

служат для перемещения (прокрутки) документа по вертикали и горизонтали. 

Панели инструментов представляют собой линейки командных кнопок, 

предназначенных для быстрого вызова той или иной команды мышью. 

Строка состояния  находится у нижнего края окна и содержит информа-

цию о режимах работы приложения. 

Виды окон 

1. Окно приложения представляют собой интерфейсы работающих прило-

жений. Главным свойством окон приложений  является то, что они могут пере-

крывать друг друга и являются независимыми, т.е. не подчинены никакому 

другому окну. 

2. Окно документа  всегда подчинены окнам своих приложений и не выхо-

дят за их пределы. 

3. Диалоговое окно служит для ввода дополнительных параметров, необ-

ходимых для выполнения какой-либо команды. 

Активное окно - окно приложения, реагирующее в данный момент на дей-

ствия пользователя. Заголовок активного окна отличается по цвету и яркости от 

неактивного. 

Обмен данными между приложениями 

Передача фрагмента данных от одного документа в другой представляет 

собой простейший способ обмена данными между приложениями. Выполняется 

эта операция через буфер обмена.  
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Буфер обмена (Clipboard) – это специальным образом организованное ди-

намическое пространство оперативной памяти для временного размещения 

данных и сведения, к какому программному приложению они относятся. 

Для занесения информации в буфер обмена и ее извлечения оттуда имеют-

ся команды копировать, вырезать, вставить. 

Технология  DDE - динамический обмен данными.  

Технология DDE  опирается на связь, установленную между фрагментами 

одного документа, а также между документами различных приложений. Нали-

чие такого механизма связи позволяет автоматически актуализировать данные в 

документе-приемнике при изменениях в источнике данных. 

Например, в файле - источнике (графическом редакторе) открывают файл 

рисунка, фрагмент которого выделяется и копируется в буфер обмена. Предпо-

лагается вставка этого фрагмента в файл-приемник (текстовый документ) в ка-

честве иллюстраций.  При последующей команде вставка → объект → из файла 

фрагмент визуально отображается в текстовом документе, при этом создается 

ссылка на файл-источник. Все изменения рисунка автоматически отображаются 

и в документе-приемнике. 

Технология OLE -связывание и встраивание объектов. 

Технология OLE опирается на связь, установленную между документом и 

приложением, а также на механизм, разработанный для связи приложений. На-

личие такого механизма позволяет перенести в выходной документ (файл-

приемник - OLE-клиент) фрагмент или файл другого приложения (файл-

источник - OLE - клиент), при этом он приобретает свойства встроенного или 

связанного объекта. При этом при обращении к встроенным данным (например, 

щелчок мыши) происходит автоматический того приложения, к которому они 

относятся. 

Тема 7. Текстовые редакторы.  

Основные функции текстовых редакторов заключаются в автоматизации 

ввода и редактирования текстовых данных. 
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В отличие от текстовых редакторов, текстовые процессоры позволяют не 

только вводить и редактировать текст, но и форматировать его, т.е. оформлять. 

Соответственно, к основным средствам текстовых процессоров относятся сред-

ства обеспечения взаимодействия текста, графики, таблиц и других объектов. 

Назначение настольных издательских систем состоит в автоматизации 

процесса верстки полиграфических изданий. 

Рассмотрим один из текстовых процессоров – Ms Word, который явля-

ется приложением Windows. 

Структура окна Word типична для приложений Windows. После уста-

новки программы в ней по умолчанию присутствуют две панели инструментов 

– Стандартная и Форматирование. Если в ходе работы возникает необходи-

мость в других панелях инструментов, их можно открыть и расположить вдоль 

любой границы окна или отдельно. 

Основные приемы работы в Word: 

1. Форматирование страниц. 

При форматировании страниц задают отступы и ориентацию бумаги. Для 

этого необходимо выбрать Файл → Параметры страницы. В появившемся окне 

Параметры страницы задаются поля (отступы) страницы и ориентация (книж-

ная или альбомная). 

Для введения нумерации страниц в создаваемом документе необходимо 

выбрать Вставка → Номера страниц. В появившемся окне Номера страниц за-

дается формат номеров страниц. Номера страниц проставляются в колонтиту-

лах. 

Колонтитулы представляют собой одну или несколько строк, помещае-

мых в начале или конце каждой страницы документа. Для расстановки колон-

титулов необходимо выбрать Вид → Колонтитулы.  

Можно установить колонтитулы для первой страницы, а так же для чет-

ных и нечетных страниц. Для этого необходимо выбрать Файл → Параметры 

страницы. В появившемся окне выбрать вкладку Источник бумаги и задать 

расположение колонтитулов. 
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2. Форматирование шрифта. 

Для форматирования шрифта необходимо выбрать Формат → Шрифт. 

В появившемся окне Шрифт задаются: размер (14 пт – деловой документ, 

12 пт – документ Internet, 8 пт - газета); название; интервал между буквами (уп-

лотненный, обычный, разреженный); цвет; параметры (жирный, курсив, под-

черкнутый и др.); анимация для вводимого текста. 

3. Форматирование абзаца. 

Для форматирования шрифта необходимо выбрать Формат → Абзац. 

В появившемся окне Абзац задаются отступы слева, справа; отступ для 

первой строки; межстрочный интервал; выравнивание текста (по ширине, по 

центру, по краям). 

Тема 8. Электронные таблицы. 

Электронная таблица (ЭТ) – компьютерный эквивалент обычной табли-

цы, в клетках (ячейках) которой записаны данные различных типов: тексты, да-

ты, формулы, числа. 

Для управления ЭТ используется табличный процессор. 

Рабочая область ЭТ состоит из строк и столбцов, имеющих свои имена. 

Имена строк – это их номера. Нумерация строк начинается с 1 и заканчивается 

максимальным числом, установленным для данной программы. Имена столб-

цов – это буквы латинского алфавита сначала от А до Z, затем от АА до AZ, BA 

до BZ и т. д. 

Пересечение строки и столбца образует ячейку таблицы, имеющую свой 

уникальный адрес. Для указания адресов ячеек в формулах используются ссыл-

ки (например, А2 или С4). 

В ЭТ существует понятие блока (диапазона) ячеек. Блок ячеек – группа 

последовательных ячеек, может состоять из одной ячейки, строки (или ее час-

ти), столбца (или его части), а также последовательности строк или столбцов 

(или их частей). Адрес блока ячеек задается указанием ссылок первой и по-

следней его ячеек, между которыми ставится разделительный символ – двоето-
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чие <:> или две точки подряд <..>. 

Пример. G3, A1:H1, B1:B10, D4:F5. 

Каждая команда ЭТ требует указания блока (диапазона) ячеек, в отноше-

нии которых она должна быть выполнена. 

Блок используемых ячеек может быть указан двумя путями: либо непо-

средственным набором с клавиатуры начального и конечного адресов ячеек, 

формирующих диапазон, либо выделением соответствующей части таблицы 

при помощи клавиш управления курсором. Удобнее задавать диапазон выделе-

нием ячеек. 

Текущей (активной) называется ячейка ЭТ, в которой в данный момент 

находится курсор. Адрес и содержимое текущей ячейки выводятся в строке 

ввода ЭТ. 

Каждый документ представляет собой набор таблиц – рабочую книгу, ко-

торая состоит из одного или многих рабочих листов. 

В каждую ячейку ЭТ пользователь может ввести данные одного из сле-

дующих типов: 

 
Формулы – это выражения, состоящие из числовых величин, адресов яче-

ек и функций, соединенных знаками арифметических операций. Написание 

формулы начинается со знака равенства (=). 

Пример. =(А1+В1)/С2. 

При копировании или перемещении формулы необходимо организовать 

управление формированием адресов исходных данных. Для этого при написа-

Типы данных 

Символьные 
(текстовые) 
данные имеют 
описательный 
характер. Они 
могут включать 
в себя алфавит-
ные, числовые и 
специальные 
символы. 

Числовые данные 
не могут содер-
жать алфавитных и 
специальных сим-
волов, поскольку с 
ними производят 
математические 
операции 

Формулы – могут 
включать ряд 
арифметических, 
логических и про-
чих действий, про-
изводимых с дан-
ными из других 
ячеек. 

Даты Функции представляют 
собой программы с уни-
кальным именем (част-
ный случай формулы). 
Различают статистиче-
ские, логические, финан-
совые и др. функции. 
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нии формул используются понятия относительной и абсолютной ссылок. 

Абсолютная ссылка – это не изменяющийся при копировании и переме-

щении формулы адрес ячейки, содержащий исходное данное.  

Для указания абсолютной адресации вводится символ $. Различают два 

типа абсолютной ссылки: полная и частичная. 

Полная абсолютная ссылка указывается, если при копировании или пере-

мещении адрес клетки, содержащий исходное данное, не меняется. Для этого 

символ $ ставится перед наименованием столбца и номером строки. 

Пример. $B$5; $D$12 

Частичная абсолютная ссылка указывается, если при копировании или 

перемещении не меняется номер строки или наименование столбца. При этом 

символ $ ставится перед номером строки, а во втором случае – перед наимено-

ванием столбца. 

Пример. B$5; D$12; $B5; $D12 

При абсолютной адресации копируемая формула не изменяется. 

Относительная ссылка – это изменяющийся при копировании и переме-

щении формулы адрес ячейки, содержащий исходное данное. Изменение адреса 

происходит по правилу относительной ориентации клетки с исходной форму-

лой и клеток с данными. 

Пример: В ячейку С1 занесена формула =A$1+$B2. Перенести эту фор-

мулу в ячейки D2, E4. 

 
Функция представляет собой программу с уникальным именем, для кото-

рой пользователь должен задать конкретные значения аргументов, стоящих в 

скобках после ее имени. 

Функция имеет синтаксис написания: начинается с указания имени функ-

ции, затем вводится открывающаяся скобка, указываются аргументы, отде-

ляющиеся «;», а затем – закрывающаяся скобка. 
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Рассмотрим синтаксис и примеры задания наиболее используемых функ-

ций. 

6. Логические функции. 

Логические функции предназначены для проверки выполнения условия 

или для проверки нескольких условий. 

− ЕСЛИ используется для условной проверки значений и формул. Возвращает 

одно значение, если заданное условие при вычислении дает значение 

ИСТИНА, и другое значение, если ЛОЖЬ. 

Синтаксис: 

ЕСЛИ(лог_выражение;значение_если_истина;значение_если_ложь) 

Пример. ЕСЛИ(А10>В1;В5/В1;10) 

7. Статистические функции. 

Синтаксические функции позволяют выполнять статистический анализ 

диапазонов данных. 

− СРЗНАЧ возвращает среднее арифметическое значение своих аргументов. 

Синтаксис: СРЗНАЧ(число1;число2;…), 

где число1, число2, … - это от 1 до 30 аргументов, для которых вычисляет-

ся среднее значение. 

Пример. Если ячейки А1:А5 содержат числа 10, 7, 9, 27 и 2, то 

СРЗНАЧ(А1:А5) равняется 11. 

− СЧЕТ подсчитывает количество чисел в списке аргументов, используется 

для получения количества числовых ячеек в интервалах или массивах ячеек. 

Синтаксис: СЧЕТ(значение1;значение2;…). 

Пример. Если ячейки А1:А7 содержат числа, то СЧЕТ(А1:А7) возвращает 

число 7. 

− МАКС возвращает наибольшее значение из набора значений. 

Синтаксис: МАКС(число1;число2;…). 

Пример. Если ячейки А1:А5 содержат числа 10, 7, 9, 27 и 2, то 

МАКС(А1:А5) равняется 27. 

− МИН возвращает наименьшее значение из набора значений. 
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Синтаксис: МИН(число1;число2;…). 

Пример. Если ячейки А1:А5 содержат числа 10, 7, 9, 27 и 2, то 

МИН(А1:А5) равняется 2. 

8. Арифметические и тригонометрические функции. 

Арифметические и тригонометрические функции позволяют производить 

простые и сложные математические вычисления. 

− СУММ суммирует все числа в интервале ячеек. 

Синтаксис: СУММ(число1;число2;…). 

Пример. Если ячейки А2:Е5 содержат числа 5, 15, 30, 40 и 50, то 

СУММ(А2:Е5) равняется 50. 

ЭТ располагает рядом команд для построения различных типов диа-

грамм: круговая диаграмма, линейный график и т. д. 

Тема 9. Электронные презентации. 

Создание новой презентации 

При запуске MS PowerPoint появляется диалоговое окно, которое имеет 

четыре переключателя, позволяющих:  

− Создать новую презентацию используя мастер автосодержания, шаблон пре-

зентации, пустую презентацию.  

− Открыть имеющуюся презентацию.  

Мастер автосодержания помогает выбрать один из нескольких шаблонов 

содержания и способы его оформления. Шаблон представляет собой презента-

цию с заранее установленными цветами слайда и текстовыми стилями. На каж-

дом шаге мастер автосодержания запрашивает определенную информацию о 

создаваемой презентации. По завершении работы мастера создается презента-

ция в режиме структуры с титульным слайдом и несколькими слайдами с заго-

ловками, в которые затем можно добавить собственный текст и рисунки.  

При выборе переключателя шаблон оформления открывается диалоговое 

окно Создать презентацию с шаблонами. В диалоговом окне имеются вкладки 

Презентации и Шаблоны оформления для создания презентаций по шаблонам.  
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После выбора переключателя Пустая презентация также открывается 

диалоговое окно с 24 макетами разметки слайдов. В новой презентации исполь-

зуются цветовая схема, стиль заголовка и стили текста презентации, принимае-

мые по умолчанию. 

Переключатель Открыть презентацию позволяет открыть существующую 

презентацию MS PowerPoint. 

Если MS PowerPoint уже запущен, то можно создать новую презентацию: 

− используя мастер автосодержания командой Файл → Создать, выбрать 

вкладку Общие, затем Мастер автосодержания; 

− по шаблону командой Файл → Создать, выбрать вкладку Презентации или 

Шаблоны оформления; 

− без использования шаблона командой Файл → Создать, выбрать вкладку 

Общие, затем Новая презентация или использовать кнопку Создать на Стан-

дартной панели инструментов. 

СОЗДАНИЕ СЛАЙДОВ ПО РАЗМЕТКЕ 

При создании нового слайда можно выбрать один из макетов. Каждый из 

них предлагает свою композицию содержимого, соответствующую определен-

ному назначению слайда. Макет предусматривает, что в каждой зоне слайда 

будет располагаться определенный вид информации. Существует макет, вклю-

чающий рамки для заголовка, текста и диаграммы; в другом макете предусмот-

рены места для заголовка и картинки. Рамка с пунктирным контуром изобража-

ется на создаваемом слайде и обозначает место для размещения таких объектов 

как заголовок слайда, текст, диаграмма и т.п. Например, диаграмма будет рас-

полагаться только справа, а текст только слева. Расположение, размер и формат 

рамок допускается изменять. Чтобы изменить макет уже созданного слайда, 

нужно воспользоваться командой Формат → Разметка слайда… или нажать 

кнопку Разметка слайда на панели инструментов Стандартная, затем выбрать 

новую разметку. Отсутствие нужных рамок в новой разметке не приведет к по-

тере данных. 
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Режимы PowerPoint 

Режимами называются способы отображения и работы над презентацией. 

Кнопки в нижней части окна презентации позволяют переходить от одного ви-

да режима к другому. Также все эти режимы доступны из меню Вид. 

В Обычном режиме отображаются три области: область структуры, об-

ласть слайда и область заметок. Эти области позволяют одновременно работать 

над всеми аспектами презентации. Размеры областей можно изменять, перетас-

кивая их границы. 

Область структуры служит для организации и развертывания содержимо-

го презентации. В ней можно вводить текст презентации и упорядочивать пунк-

ты списка, абзацы и слайды. В области слайда отображается текст каждого 

слайда с учетом форматирования. На отдельные слайды можно добавлять ри-

сунки, фильмы, звуки, анимацию и гиперссылки. Область заметок служит для 

добавления заметок докладчика или сведений для аудитории. 

В Режиме структуры презентация изображается в сокращенном виде: 

только заголовки слайдов и содержащийся в них текст. В верхнем правом углу 

находится окно для просмотра текущего слайда. Оно позволяет отслеживать 

ход заполнения слайда текстом, чтобы вовремя перейти на новый слайд. 

Перед заголовком каждого слайда стоит номер и значок. Основной текст, 

включающий до пяти уровней отступов, расположен после каждого заголовка. 

Работа со структурой является наилучшим вариантом организации и развития 

презентации, так как в процессе работы на экране отображаются все заголовки 

и основной текст. Можно поменять местами пункты на слайде, переместить 

слайд целиком с одной позиции в другую и изменить заголовки и основной 

текст. Например, чтобы упорядочить слайды или пункты маркированного спи-

ска, нужно выбрать значок слайда или маркер, соответствующий тексту, кото-

рый требуется переместить, и перетащить его в другую позицию. 

В Режиме слайдов создают и редактируют отдельные элементы слайдов: 

текст в метках-заполнителях, объекты (графику, звук и т.п.), дополнительные 

тексты, фигуры, собственные рисунки и т.д. С одного слайда на другой пере-
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ключаются при помощи вертикальной полосы прокрутки, а также клавишами 

Page Up и Page Down. 

В Режиме сортировщика слайдов  на экране в миниатюре отображаются 

сразу все слайды презентации в том порядке, в каком их будут показывать во 

время выступления. Это упрощает добавление, удаление (клавиша Delete), ко-

пирование (клавиша Ctrl) и перемещение слайдов, задание времени показа 

слайдов и выбор способов их смены. Кроме того, можно просматривать анима-

цию на нескольких слайдах, выделив требуемые и выполнив команду Показ 

слайдов → Просмотр анимации. Чтобы поменять местами один или несколько 

слайдов, нужно выбрать их и перетащить в новое место. 

В Режиме показа слайдов представляют презентацию во время выступле-

ния. Чтобы выбрать какой-либо способ показа, нужно в Режиме слайдов вы-

полнить команду Показ слайдов → Настройка презентации и установить в со-

ответствующее положение переключатель.  

Существует три разных способа показа слайдов: 

− управляемый докладчиком (полный экран). Это обычный способ проведения 

показа, управляемого докладчиком, когда слайды отображаются в полноэк-

ранном режиме. Ведущий получает полный контроль над презентацией. Он 

может проводить ее вручную (по щелчку мыши) или автоматически (через 

определенное время), останавливать ее для записи замечаний и даже запи-

сывать во время презентации речевое сопровождение; 

− управляемый пользователем (окно). В этом случае показ слайдов будет про-

водиться в стандартном окне со специальными меню и командами, обеспе-

чивающими возможность самостоятельного просмотра презентации пользо-

вателем; 

− автоматический (полный экран). В этом режиме презентация будет прово-

диться в автоматическом режиме, который возобновляется после 5 минут 

простоя. Это можно использовать на выставочном стенде или собрании. 

Зрители могут менять слайды, переходить по гиперссылкам, но не могут из-

менять презентацию. При выборе этого варианта автоматически устанавли-
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вается флажок Непрерывный цикл до нажатия клавиши «Esc». Прервать по-

каз слайдов можно, нажав клавишу Esc. 

Вставка слайдов в PowerPoint 

Вставить слайды можно следующими способами: 

1. При помощи команды Вставка → Новый слайд… или с помощью кноп-

ки Новый слайд на Стандартной панели инструментов. Будет создан новый, 

«чистый» слайд с разметкой, выбранной в открывшемся по этой команде диа-

логовом окне. 

2. Чтобы добавить новый слайд, который имеет ту же разметку, что и те-

кущий слайд, нужно щелкнуть на кнопке Новый слайд на Стандартной панели 

инструментов, удерживая клавишу Shift. 

3. В режиме структуры. Для создания «чистого» слайда нужно поместить 

курсор в конец предыдущего слайда и нажать клавишу Enter. Если прототип 

слайда уже где-то существует (в другой презентации или в текстовом докумен-

те), то можно вставить его в нужное место презентации, используя буфер обме-

на. 

4. При помощи команды Вставка → Дублировать слайд. Для этого необ-

ходимо выделить уже имеющийся слайд презентации и выбрать эту команду. 

Копия слайда будет расположена сразу после его прототипа. 

5. При помощи команды Вставка → Слайды из файлов… Эта команда по-

зволяет копировать слайды из одной презентации в другую. Если воспользо-

ваться ею, откроется диалоговое окно Поиск слайдов. Щелчок по кнопке Обзор 

позволяет выбрать презентацию, в которой содержится нужный слайд. Чтобы 

найти слайд, нужно щелкнуть по кнопке Показать, затем отметить нужные 

слайды и щелкнуть по кнопке Вставить. Искать слайды в этом окне можно в 

двух режимах: с показом уменьшенных копий слайдов и с показом заголовков 

слайдов. Для переключения этих режимов используются кнопки в правой части 

окна. 
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6. При помощи команды Вставка → Слайды из структуры… Под структу-

рой в данном случае подразумевается любой текстовый файл, абзацы которого 

MS PowerPoint преобразует в слайды презентации. 

Способы вставки рисунков в презентацию 

В комплект MS PowerPoint входит стандартный набор рисунков в виде 

коллекции. Эта коллекция включает множество картинок, выполненных на 

профессиональном уровне и позволяющих придать презентации более красоч-

ный вид. Выбор рисунков самый широкий — карты, изображения людей, зда-

ний, пейзажей и т.д. 

Для выбора рисунка нужно выполнить команду Вставка → Рисунок или 

нажать кнопку Добавить картинку на Стандартной панели инструментов  и пе-

рейти на вкладку Графика или Картинки. В коллекции предусмотрено удобное 

средство поиска, помогающее найти нужные изображения для презентации. 

Кроме того, здесь имеется своя система справки, где можно узнать, как встав-

лять в коллекцию свои рисунки, как обновлять и как настроить ее для своих це-

лей. 

Чтобы воспользоваться средством поиска или системой справки, необхо-

димо нажать кнопку Поиск или Справка соответственно. 

Для вставки рисунка необходимо сначала выбрать нужный раздел, затем 

подходящий рисунок и нажать кнопку Вставить или выполнить двойной щел-

чок по рисунку. 

Анимация и способы перехода слайдов 

Анимацией называется звуковое и визуальное оформление, которое мож-

но добавить к тексту или другому объекту, например, к диаграмме или рисунку. 

Переходом называется специальный эффект, используемый для отображения 

очередного слайда в ходе показа презентации. Например, можно обеспечить 

появление слайда из затемнения или наплывом. Также можно выбрать вид и 

скорость перехода. При создании слайдов презентации основное внимание не-

обходимо уделять их содержанию. Анимация, способы смены слайдов и другие 

средства используются для подчеркивания определенных аспектов сообщаемых 
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сведений, а также делает презентацию более привлекательной. Для каждого 

объекта слайда также можно установить способ его появления на экране, на-

пример, «влетание» с левой или с правой стороны, потускнение или изменение 

в цвете. 

Добавление управляющих кнопок в презентацию 

В MS PowerPoint включены некоторые готовые к использованию управ-

ляющие кнопки, которые можно добавить в презентацию, назначив соответст-

вующую гиперссылку. На управляющих кнопках изображены значки, которые 

служат для создания интуитивно понятных обозначений для перехода к сле-

дующему, предыдущему, первому и последнему слайдам. В MS PowerPoint 

также имеются управляющие кнопки для воспроизведения фильмов и звуков. 

Для добавления управляющих кнопок в слайд нужно выполнить команду  

Показ слайдов → Управляющие кнопки и выбрать требуемую кнопку. Напри-

мер, назад, далее, в начало или в конец. 

Чтобы изменить размер кнопки, необходимо перетащить указатель до 

требуемого размера. Для сохранения пропорций фигуры при перетаскивании 

удерживать нажатой клавишу Shift. 

Когда появится окно Настройка действия, на вкладке По щелчку мыши 

или По наведении указателя мыши установить переключатель Перейти по ги-

перссылке, из списка выбрать нужный элемент, затем ОК. 

Запуск показа слайдов 

Для запуска презентации нужно выполнить любое из приведенных ниже 

действий: 

− Перейти в режим Показ слайдов. 

− Выполнить команду Показ слайдов → Показ. 

− Выполнить команду Вид → Показ слайдов. 

Форматы сохраненных файлов 

Презентацию (новую или сохранявшуюся ранее) можно сохранить в ходе 

работы над ней командой Файл → Сохранить или использовать кнопку Сохра-

нить на панели инструментов Стандартная. Также можно сохранить копию пре-
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зентации под другим именем или в другом месте командой Файл → Сохранить 

как… Можно выбрать различные форматы сохраняемых файлов: 

− расширение файла обычной презентации ppt; 

− презентация, которая всегда будет открываться в режиме Показ слайдов, 

имеет расширение pps. Открыв такой файл (в MS PowerPoint или на основ-

ном экране), автоматически запустится показ слайдов. Если показ запускает-

ся из основного экрана, по его завершении MS PowerPoint закроется. Если 

показ слайдов запускается из MS PowerPoint, по его завершении презентация 

останется открытой и доступной для редактирования; 

− презентация, сохраненная в виде шаблона, имеет расширение pot. 

Тема 10. Компьютерная графика. 

Компьютерная графика – раздел информатики, предметом которого явля-

ется работа на компьютере с графическими изображениями (рисунками, черте-

жами, фотографиями и т. д ). 

Графический редактор – прикладная программа, предназначена для соз-

дания и обработки графических изображений на компьютере. 

Типы компьютерной графики 

1. Растровая графика – графика, состоящая из прямоугольной сетки точек, 

называемой растром. 

Каждая точка растра (пиксель) представлена единственным параметром – 

цветом. Пиксель - это цветное пятно, которое может принимать различные от-

тенки. Любое изображение вне зависимости от его сложности - это всего лишь 

совокупность пикселей. Редактирование растровых изображений – изменение 

цветов их отдельных пикселей. 

Характеристики растровых изображений 

− Получаются с помощью сканеров из фотографических изображений, с по-

мощью цифровых камер. 

− Обеспечивают максимальную реалистичность изображения. 

− Занимают много памяти. 
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− Качество зависит от размера. 

Основные параметры растровых изображений: 

− Количество цветов 

− Разрешение – количество пикселей на единицу длины (как правило на дюйм) 

2. Векторная графика состоит из  контуров. Контуры представляют собой 

кривые, имеющие точное математическое описание. 

Характеристики векторного изображения 

− Векторные изображения требуют ручного ввода (построения и рисования). Мо-

гут быть получены из растровых с помощью программ трассировки. 

− Не обеспечивают близкую к оригиналу реалистичность. 

− Компактны, так как хранят только математическое описание объектов. 

− Качество изображения не зависит от размера. 

− Легко редактировать. 

3. Фрактальная графика – предназначена для автоматической генерации 

изображений путем математических расчетов. Создание фрактальной художест-

венной композиции состоит не в рисовании или оформлении, а в программирова-

нии. Изображение строится по уравнению. 

Простейшим фрактальным объектом является фрактальный треугольник. 

Данный вид графики часто используют в развлекательных программах. 

Теория цвета 

Основные - это три цвета, смешением которых в разных пропорциях можно 

получить любой цвет.  

Дополнительные цвета при смешении дают в глазу ощущение белого цвета, 

например сине-зеленый и красный, оранжевый и синий, зелено-желтый и фиоле-

товый цвета. 

Для описания цвета используются математические модели, работа которых 

основана на смешения основных цветов для получения всех других цветов: 

− RGB (Red-красный, Green-зеленый, Blue -синий). В этой модели отображает 

экран монитора, кодирует изображение сканер. 
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− CMYK (Cyan-голубой, Magenta-пурпурный, Yellow-желтый, BlacK). Использу-

ется для создания изображений, предназначенных для печати. 

Тема 11. Базы данных.  

База данных (БД) – это поименованная совокупность структурированных 

данных, относящихся к определенной предметной области (БД по металлургии, 

БД в деканате о студентах, БД в библиотеке по книгам). 

Система управления базами данных (СУБД)– это комплекс программных и 

языковых средств, необходимых для создания баз данных, поддержания их в акту-

альном состоянии и организации поиска в них необходимой информации. 

Основными функциями системы управления базами данных являются: 

- создание структуры базы данных; 

- предоставление средств для ее заполнения или импорта данных из другой ба-

зы; 

- обеспечение возможности доступа к данным; 

- предоставление средств поиска, фильтрации, запросов данных. 

Классификация БД: 

 
Структурные элементы базы данных: 

1. Поле – элементарная единица логической организации данных, которая 

соответствует неделимой единице информации – реквизиту. Для описания поля 

Базы данных 

По технологии обработки данных По способу доступа к данным 

Централизованная база данных хра-
нится в памяти одной вычислительной 
системы 

Распределенная база данных состоит из 
нескольких, возможно пересекающихся 
или даже дублирующих друг друга час-
тей, хранимых в различных ЭВМ вы-
числительной сети 

С локальным доступом 

С удаленным (сетевым) доступом 

Файл-сервер 

Клиент-сервер 
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используются следующие характеристики: 

a) Имя, например, Фамилия, Имя, отчество, Дата рождения; 

b) Тип, например, символьный, числовой, календарный; 

c) Размер – определяет предельную длину, например, 15 байт; 

d) Формат – определяет способ форматирования данных; 

e) Маска ввода – определяет форму, в которой вводятся данные в поле; 

f) Подпись – определяет заголовок столбца таблицы; 

g) Точность для числовых данных, например для десятичного знака для отобра-

жения дробной части числа. 

2. Запись – совокупность логически связанных полей. Экземпляр записи - 

отдельная реализация записи, содержащая конкретные значения ее полей. 

Запись содержит данные о конкретном экземпляре сущности. База, не 

имеющая записей, является пустой, но все равно полноценной. Простейший «не-

компьютерный вариант» БД – ежедневник, в котором каждому календарному дню 

выделено по странице. Даже если он пустой, он не перестает быть ежедневником, 

поскольку имеет структуру. 

Файл (таблица) – совокупность экземпляров записей одной структуры. 

Типы данных 

1. Текстовый – используется для хранения обычного неформатированного текста 

ограниченного размера (до 255 символов). 

2. Поле Memo – для хранения больших текстов (до 64000 символов). 

3. Числовой. 

4. Дата и время. 

5. Денежный – для хранения денежных сумм. 

6. Счетчик – для уникальных (не повторяющихся) натуральных чисел с автомати-

ческим наращиванием. Используется для порядковой нумерации записей. 

7. Логический – для хранения логических данных, которые могут принимать толь-

ко два значения, например Да или Нет. 

Объекты базы данных 

1. Таблицы. 

2. Запросы. Служат для извлечения данных из таблицы и предоставления их 
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пользователю в удобном виде. С помощью запроса выполняют отбор данных, их 

сортировку и фильтрацию, создают новые таблицы. 

3. Формы. Являются основным средством создания диалогового интерфейса 

приложения пользователя. Форма может создаваться для ввода и просмотра взаи-

мосвязанных данных базы на экране в удобном виде. 

4. Отчеты. Предназначены для формирования выходных документов вывода 

данных на принтер. В отчетах приняты меры для группирования выводимых дан-

ных и для вывода элементов оформления, характерных для печатных документов. 

В структуре записи файла указываются поля, значения которых являются 

ключами: первичными (ПК), которые идентифицируют экземпляр записи, и вто-

ричными (ВК), которые выполняют роль поисковых или группировочных призна-

ков (по значению вторичного ключа можно найти несколько записей). 

Виды моделей данных. 

Модель данных – совокупность структур данных и операций их обработки. 

1. Иерархическая модель данных. 

Представляет собой совокупность элементов, связанных между собой по оп-

ределенным правилам. Объекты, связанные иерархическими отношениями, обра-

зуют ориентированный граф (перевернутое дерево). 

 
К основным понятиям иерархической структуры относятся: уровень, элемент 

(узел), связь. 

Узел – это совокупность атрибутов данных, описывающих некоторый объект 

(на схеме – вершины графа). Каждый узел на более низком уровне может быть 

связан  только с одним узлом, находящемся на более высоком уровне. 

Примером иерархической структуры БД являются сведения о студентах обу-

чающихся в группе. Можно сказать, что каждый студент учится в определенной 

(только одной) группе, которая относится к определенному (только одному) ин-

А 

В1 В2 В3 В4 В5 

Уровень 1 

Уровень 2 

С1 С2 С3 С4 С5 С6 С7 С8 Уровень 3 
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ституту. 

2. Сетевая модель данных. 

Объекты в сетевой модели связаны разнородно, т. е. при тех же основных 

понятиях (уровень, узел, связь) каждый элемент может быть связан с любым дру-

гим элементом. 

 
Примером сетевой структуры БД может служить структура базы данных, со-

держащая сведения о студентах, участвующих в научно-исследовательских рабо-

тах (НИРС). Возможно участие одного студента в нескольких НИРС, а также уча-

стие нескольких студентов в разработке одной НИРС. 

3. Реляционная модель данных. 

Эта модель ориентированна на организацию данных в виде двумерных таб-

лиц. Каждая реляционная таблица представляет собой двумерный массив и обла-

дает следующими свойствами: 

− каждый элемент таблицы – один элемент данных; 

− все столбцы в таблице однородные, т. е. все элементы в столбце имеют одина-

ковый тип (числовой, символьный и т.д.) и длину; 

− каждый столбец имеет уникальное имя; 

− одинаковые строки в столбце отсутствуют; 

− порядок следования строк и столбцов может быть произвольным. 

Реляционной таблицей можно представить информацию о студентах, обу-

чающихся в вузе. 

Поле, каждое значение которого однозначно определяет соответствующую 

запись, называется простым ключом (ключевым полем). Если записи однозначно 

определяются значениями нескольких полей, то такая таблица базы данных имеет 

составной ключ. В примере ключевым полем таблицы является «№ личного дела». 

Чтобы связать две реляционные таблицы, необходимо ключ первой таблицы 

А В 

С D E 

H G L 
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ввести в состав ключа второй таблицы (возможно совпадение ключей); в против-

ном случае нужно ввести в структуру первой таблицы внешний ключ – ключ вто-

рой таблицы. 

 
 К реляционной модели данных относится Ms-Access.  

Тема 12. Компьютерные сети. Интернет. 

 Компьютерная (вычислительная) сеть - совокупность компьютеров и терми-

налов, соединенных с помощью каналов связи в единую систему, удовлетворяю-

щую требованиям распределенной обработки данных. 

Устройства компьютерной сети 

Все устройства, подключаемые к сети, можно разделить на три функциональ-

ные группы: рабочие станции; серверы сети; коммуникационные узлы.  

 
 

 

Сервер - компьютер, подключенный к сети и обеспечивающий ее пользователей 
определенными услугами 

Файловый  
сервер 

Сервер резервного копирова-
ния данных 

Сервер баз данных Факс - сервер 

Рабочая станция – персональный компьютер, подключенный к сети, через 
который пользователь получает доступ к ее ресурсам 

Дисковая – имеет винчестер 
для записи информации 

Бездисковая – информация запи-
сывается на главный компьютер 
сети 

Удаленная рабочая станция – 
удалена от центра сетевого 
управления 

Типы связей 

Один к одному (1:1) – пред-
полагает, что в каждый мо-
мент времени одному эк-
земпляру объекта А соот-
ветствует не более одного 
экземпляра объекта В и 
наоборот. 

А В 

Один ко многим (1:М)  - одно-
му экземпляру объекта А со-
ответствует 0, 1 или более 
экземпляров объекта В, но 
каждый экземпляр объекта В 
связан не более чем с 1 экзем-
пляром объекта А. 

 
А В 

Многие ко многим (М:М) -  пред-
полагает, что в каждый момент 
времени экземпляру объекта А 
соответствует 0, 1 или более 
экземпляров объекта В и наобо-
рот. 

А В 

Студент-преподаватель Покупатель - торговый агент Гражданин - паспорт 
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К коммуникационным узлам относятся следующие устройства: повторите-

ли, коммутаторы (мосты), маршрутизаторы, шлюзы.  

Информация передается по сети порциями (пакетами). В сети при передаче 

отдельного пакета с помощью каналов связи происходит затухание сигнала. 

Поэтому сеть ограничивают участками (сегментами).  

По окончанию каждого участка имеется повторитель – устройство, усили-

вающее или регенерирующее пришедший на него сигнал. Повторитель, приняв 

пакет от одного сегмента, передает его дальше. Повторитель осуществляет свя-

зывание сегментов.  

Коммутатор или мост – это устройство, которое, как и повторитель, вы-

полняет объединение нескольких сегментов. В отличие от повторителя, мост 

выполняет развязку присоединенных к нему сегментов.  

Маршрутизатор – устройство, соединяющее сети одного или разных типов 

по одному протоколу данных, анализирует адрес назначения и направляет дан-

ные по оптимально выбранному маршруту.  

 Шлюз – это устройство, позволяющее организовать обмен данными меж-

ду разными сетевыми объектами, использующими разные протоколы обмена 

данными.  

Основные показатели сети 

Производительность сети определяется количеством информации, пере-

данной через сеть или её сегмент в единицу времени.  

Надежность работы вычислительной сети определяется надежностью ра-

боты всех ее компонентов. Для обеспечения надежности, как правило, инфор-

мация в сети храниться в нескольких экземплярах (дублирование информации). 

При передаче информации возможны потери и искажения. Для оценки надеж-

ности исполнения этой функции используются показатели вероятности потери 

пакета при его передаче, либо вероятность доставки пакета.  

Безопасность – это способность сети обеспечить защиту информации от 

несанкционированного доступа. Задачи обеспечения безопасности решаются 

применением специального программного обеспечения, использование более 
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безопасной передающей среды в сети.  

Управлением сетью занимается администратор сети, обычный пользова-

тель не имеет административных прав. Администратор сети должен иметь воз-

можность воздействовать на работу любого элемента сети. Управляемость се-

тью – возможность определения проблем в работе вычислительной сети  или 

отдельных ее сегментов, выработка управленческих действий для решения вы-

явленных проблем.  

Расширяемость определяется возможностью добавления новых элементов 

сети (рабочих станций, служб).  

Масштабируемость сети определяет возможность расширения сети без 

существенного снижения ее производительности. Например, одноранговые се-

ти обладают хорошей расширяемостью, но плохой масштабируемостью.  

Интегрируемость означает возможность подключения к вычислительной 

сети разнообразного и разнотипного оборудования.  

Классификация вычислительных сетей: 

 
Типы передающей среды в компьютерных сетях 

В компьютерных сетях используется два основных вида передающей сре-

Компьютерные вычислительные сети

Глобальная вычислительная 
сеть объединяет абонентов, 
расположенных в различных 
странах, на различных кон-
тинентах. Взаимодействие 
между абонентами такой се-
ти может осуществляться на 
базе телефонных линий свя-
зи, радиосвязи и систем 
спутниковой связи. Глобаль-
ные вычислительные сети 
позволят решить проблему 
объединения информацион-
ных ресурсов всего челове-
чества и организации досту-
па к этим ресурсам. 

Региональная вычисли-
тельная сеть связывает 
абонентов, расположен-
ных на значительном 
расстоянии друг от дру-
га. Она может включать 
абонентов внутри боль-
шого города, экономи-
ческого региона, от-
дельной страны. Обычно 
расстояние между або-
нентами региональной 
вычислительной сети 
составляет десятки - 
сотни километров. 

Локальная вычислитель-
ная сеть объединяет або-
нентов, расположенных в 
пределах небольшой тер-
ритории. Обычно такая 
сеть привязана к конкрет-
ному месту. К классу ло-
кальных вычислительных 
сетей относятся сети от-
дельных предприятий, 
фирм, банков, офисов и т. 
д. Протяженность такой 
сети можно ограничить 
пределами 2-2,5 км. 
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ды: кабельный канал связи  и радиосвязь.  

Кабельный вид связи 

Кабельный вид связи используют преимущественно в локальных, чаще ре-

гиональных сетях. Кабели бывают нескольких видов: витая пара проводов, ко-

аксиальный кабель, оптоволоконный кабель.  

Витая пара состоит из двух изолированных проводов, свитых между собой. 

Например, телефонный кабель. Такой вид соединения недорогой. Недостаток 

витой пары - плохая помехозащищенность и низкая скорость передачи инфор-

мации. Существует неэкранированная витая пара и экранированная витая пара. 

Дополнительный защитный слой в экранированной паре делает кабель помехо-

устойчивым, значительно уменьшает электромагнитное излучение. 

Коаксиальный кабель по сравнению с витой парой обладает большей 

прочностью, помехозащищенностью. В центре коаксиального кабеля находится 

медный проводник, окруженный толстым слоем изоляционного материала. 

Второй слой сделан в виде оплетки поверх изоляции.  

Оптоволоконный кабель не подвержен действию электромагнитных полей. 

В оптоволоконном кабеле для передачи данных используются световые им-

пульсы. Сердечник такого кабеля изготовлен из стекла или пластика. Сердеч-

ник окружен слоем отражателя, который направляет световые импульсы вдоль 

кабеля путем отражения от стенок. Оптоволоконный кабель более дорогой по 

сравнению с предыдущими типами.  

Радиосвязь 

Каналы радиосвязи используют различные диапазоны передачи данных. В 

радиосвязи передача информации осуществляется от одного ретранслятора к 

другому. Разновидностью радиосвязи является спутниковая связь, в которой 

передача данных осуществляется через спутник. 

Конфигурация локальных вычислительных сетей 

Существуют следующие конфигурации ЛВС: шинная, кольцевая, звездо-

образная, древовидная. От конфигурации ЛВС зависит, как размещаются або-

ненты сети и как они соединяются между собой.  
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Шинной называется такая конфигурация сети, при которой к незамкнуто-

му каналу (шине) с некоторым интервалом подключаются рабочие станции. 

Информация от абонента-источника распространяется по каналу в обе стороны.  

В кольцевой сети информация передается по замкнутому каналу (кольцу), 

в большинстве случаев только в одном направлении. Каждый абонент непо-

средственно связан с двумя соседними абонентами, но «прослушивает» переда-

чу любого абонента сети.  

Звездообразные сети возникли на основе телефонных сетей с АТС. В цен-

тре звездообразной сети находится центральный коммутатор, либо устройство, 

которое последовательно опрашивает абонентов и предоставляет им право на 

обмен информацией.  

Древовидная конфигурация сети образуется путем подсоединения нескольких 

простых шин к одной магистральной при помощи мостов или шлюзов.  

Системное программное обеспечение вычислительных сетей 

Для эффективной работы сетей используются специальные операционные 

системы. Это сетевые операционные системы, которые устанавливаются на специ-

ально выделенные компьютеры. Признанными лидерами сетевых ОС являются 

Windows NT, Unix.  

Обработка информации в сети распределена между двумя объектами: клиент 

(рабочая станция) и сервер. Клиент может запросить с сервера чтение – запись 

файла, поиск информации и т.д. Сервер выполняет запрос, поступивший от клиен-

та. Подобные системы принято называть системами «клиент – сервер».  

В зависимости от распределения функций между компьютерами в сети мож-

но выделить одноранговые сетевые ОС и ОС с выделенным сервером.  

Одноранговые ОС используются в одноранговых сетях, для которых  харак-

терно: нет единого центра управления и единого устройства для хранения данных, 

сетевая операционная система  распределена по всем рабочим станциям. Достоин-

ства: низкая стоимость и высокая надежность. Недостатки: сложность управления 

сетью, сложность обеспечения защиты информации, трудности обновления про-

граммного обеспечения, ограниченность количества рабочих станций.  

В сети с выделенным сервером один компьютер выполняет роль сервера. На 
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нем устанавливается сетевая операционная система, к нему подключаются все 

внешние устройства. Взаимодействие между рабочими станциями в сети осущест-

вляется через сервер. Количество серверов может быть более одного. Достоинства: 

надежная система защиты информации, высокое быстродействие, отсутствие ог-

раничений на число рабочих станций. Недостатки: высокая стоимость сервера, 

меньшая гибкость по сравнению с одноранговой сетью.  

 Любая коммуникационная сеть должна включать следующие основные ком-

поненты: передатчик, сообщение, средства передачи, приемник. 

Глобальная сеть INTERNET 

 Internet представляет собой глобальную компьютерную сеть. Само ее назва-

ние означает "между сетей". Это сеть, соединяющая отдельные сети. 

Internet обеспечивает обмен информацией между всеми компьютерами, под-

ключенными к ней. Тип компьютера и используемая им операционная система 

значения не имеют. 

Существуют компьютеры, самостоятельно подключенные к internet. Они на-

зываются хост-компьютерами (host – хозяин). 

Каждый подключенный к сети компьютер имеет свой адрес, по которому 

его можно найти. 

Система адресации в Internet 

 Internet самостоятельно осуществляет передачу данных. К адресам станций 

предъявляются специальные требования. Адрес должен иметь формат, позволяю-

щий вести его обработку автоматически, и должен нести некоторую информацию 

о своем владельце. 

 С этой целью для каждого компьютера устанавливаются два адреса: цифро-

вой IP -адрес(IP - Internetwork Protocol - межсетевой протокол) и доменный адрес.  

 Оба эти адреса могут применяться равноценно. Цифровой адрес удобен 

для обработки на компьютере, а доменный адрес - для восприятия пользовате-

лем. 

 Цифровой адрес имеет длину 32 бита. Для удобства он разделяется на че-

тыре блока по 8 бит, которые можно записать в десятичном виде. Адрес содер-

жит полную информацию, необходимую для идентификации компьютера. 
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 Два блока определяют адрес сети, а два другие - адрес компьютера внут-

ри этой сети. Существует определенное правило для установления границы 

между этими адресами. Поэтому IP - адрес включает в себя три компонента: 

адрес сети, адрес подсети, адрес компьютера в подсети.  

 Доменный адрес определяет область, определяющую ряд хост - компьюте-

ров. В отличие от цифрового адреса он читается в обратном порядке. Вначале идет 

имя компьютера, затем имя сети, в которой он находится.  

 В системе адресов Internet приняты домены, представленные географиче-

скими регионами. Они имеют имя, состоящее из двух букв.  

Пример Географические домены некоторых стран: Франция - fr; Канада - ca; 

США - us; Россия - ru. 

 Существуют и домены, разделенные по тематическим признакам. Такие 

домены имеют трехбуквенное сокращенное название. 

Пример Учебные заведения - edu. Правительственные учреждения - gov. Ком-

мерческие организации - com. 

Службы Internet  

1. Электронная почта (E-Mail).  

2. Списки рассылки (MailList).  

3. Телеконференции (Usenet).  

4. Всемирная паутина WWW.  

5. Служба передачи файлов (FTP).  

6. Chat (разговор) в реальном времени (IRC).  

7. ICQ.  

Проблемы безопасности информации 

Защита информации – контрольные механизмы, препятствующие незакон-

ному использованию ресурсов.  

Проведение финансовых операций с использованием Интернета или дру-

гих сетей, заказ товаров и услуг, использование кредитных карточек, доступа к 

закрытым информационным ресурсам, передача телефонных разговоров тре-

буют обеспечения соответствующего уровня безопасности. Начиная с 90-х го-
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дов, Интернет становится мощным средством обеспечения розничного торгово-

го оборота, в нем циркулируют договорные и финансовые обязательства, необ-

ходимость защиты которых как от просмотра, так и от фальсификации, очевид-

на.  

 Конфиденциальная информация, которая передается по сети Интернет, 

проходит через определенное количество маршрутизаторов и серверов, прежде 

чем достигнуть пункта назначения. Существует возможность перехвата инфор-

мации, более того, информация может быть изменена и перехвачена адресату в 

измененном виде.  

Проблемы, возникающие с безопасностью передачи информации при ра-

боте в компьютерных сетях, можно разделить на следующие типы:  

опасность заражения компьютерным вирусом;  

перехват информации - целостность информации сохраняется, но ее кон-

фиденциальность нарушена;  

модификация информации - исходное сообщение изменяется либо полно-

стью подменяется другим и отсылается адресату;  

подмена авторства информации. Например, кто-то может послать письмо 

от вашего имени или Web-сервер может притворяться электронным магазином, 

принять заказы, номера кредитных карт, но не высылать никаких товаров.  

Под термином "безопасность" подразумевается совокупность трех различ-

ных характеристик:  

1. Аутентификация - процесс распознания пользователя системы и пред-

ставления ему определенных прав и полномочий;  

2. Целостность - идентичность отправленного и принятого;  

3. Секретность - предотвращение несанкционированного доступа к инфор-

мации.  

Методы защиты информации 

1. Антивирусная защита 

Защиту от вирусов можно разделить на два класса: общие и профилактиче-

ские средства. К общим средствам относятся - создание копий файлов и сис-
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темных областей дисков и разграничение доступа - предотвращает использова-

ние компьютера без разрешения. Профилактические средства – наиболее об-

ширный класс, к которому относятся антивирусные программы. Антивирусные 

программы разделяются на мониторы и сканеры. Монитор - находится рези-

дентно (постоянно) в оперативной памяти компьютера и сообщает об обнару-

женном вирусе. Сканер - программа, запускаемая пользователем (когда следует 

проверить дисковые накопители) или автоматически (периодическая проверка 

дисков). Важно, чтобы антивирусные программы, используемые для проверки, 

были самых последних версий. Широко используемые антивирусные програм-

мы - Drweb, AVP, Norton Antivir и др.  

2. Криптография 

Криптография - шифрование, позволяющая трансформировать данные в 

зашифрованную форму, из которой извлечь исходную информацию можно 

только при помощи ключа. Обеспечивает секретность информации.  

В основе шифрования лежат два основных понятия: алгоритм и ключ. Ал-

горитм -  это способ закодировать исходный текст, в результате чего получает-

ся зашифрованное послание. Зашифрованное послание можно интерпретиро-

вать только с помощью ключа.  

Существуют две основные схемы шифрования: симметричное шифрование 

и несимметричное  шифрование.  

При симметричном шифровании отправитель и получатель владеют одним 

и тем же ключом, с помощью которого они могут зашифровать и расшифровать 

данные. Основной недостаток симметричного процесса заключается в том, что 

прежде чем начать обмен информацией, надо выполнить передачу ключа, а для 

этого опять-таки нужна защищенная связь, то есть проблема повторяется, хотя 

и на другом уровне. Если рассмотреть оплату клиентом товара или услуги с 

помощью кредитной карты, то получается, что торговая фирма должна создать 

по одному ключу для каждого своего клиента и каким-то образом передать им 

эти ключи. Это крайне неудобно.  

Поэтому в настоящее время в Интернете используют несимметричное 
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шифрование. В данной схеме для шифрования послания используется один 

ключ (открытый), для расшифровки - другой (закрытый, личный). На самом де-

ле это как бы две "половинки" одного целого ключа, связанные друг с другом.  

Ключи устроены так, что сообщение, зашифрованное одной половинкой, 

можно расшифровать только другой половинкой (не той, которой оно было за-

кодировано). Создав пару ключей, торговая компания широко распространяет 

публичный ключ (открытую половинку) и надежно сохраняет закрытый ключ 

(свою половинку).  

Как публичный, так и закрытый ключ представляют собой некую кодовую 

последовательность. Публичный ключ компании может быть опубликован на ее 

сервере, откуда каждый желающий может его получить. если клиент хочет сде-

лать фирме заказ, он возьмет ее публичный ключ и с его помощью закодирует 

свое сообщение о заказе и данные о своей кредитной карте. После кодирования 

это сообщение может прочесть только владелец закрытого ключа. Никто из 

участников цепочки, по которой передается информация, не в состоянии это 

сделать. Даже сам отправитель не может прочитать собственное послание, хотя 

ему хорошо известно содержание. Лишь получатель сможет прочесть сообще-

ние, поскольку только у него есть закрытый ключ, дополняющий использован-

ный публичный ключ.  

Если фирме надо будет отправить клиенту квитанцию о том, что заказ 

принят к исполнению, она закодирует ее своим закрытым ключом. Клиент 

сможет прочитать квитанцию, воспользовавшись имеющимся у него публич-

ным ключом данной фирмы. Он может быть уверен, что квитанцию ему отпра-

вила именно эта фирма, и никто другой, поскольку никто иной доступа к за-

крытому ключу фирмы не имеет.  

 Число бит в ключе определяет надежность защиты. Например, 8-битный 

ключ допускает 28=256 комбинаций ключей. Если использовать 128 - битный 

ключ, то необходимо будет перебрать 2128 ключей, что в настоящее время не 

под силу даже самым мощным компьютерам.  

Даже если послание зашифровано, все равно остается возможность моди-
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фикации исходного сообщения или подмены этого сообщения другим. Защита 

публичным ключом не является абсолютно надежной. Дело в том, что посколь-

ку каждый желающий может получить и использовать чей-то публичный ключ, 

то он может сколь угодно подробно изучить алгоритм работы механизма шиф-

рования и пытаться установить метод расшифровки сообщения, то есть рекон-

струировать закрытый ключ.  

Во многих странах вопрос применения алгоритмов шифровки данных на-

ходится в поле законодательного регулирования. В частности, в России к ис-

пользованию в государственных и коммерческих организациях разрешены 

только те программные средства шифрования данных, которые прошли госу-

дарственную сертификацию в административных органах, в частности, в Феде-

ральном агентстве правительственной связи и информации при Президенте 

Российской Федерации.  

3. Электронная подпись 

Мы рассмотрели, как клиент может переслать организации свои конфи-

денциальные данные. Точно также он может общаться и с банком, отдавая ему 

распоряжения о перечислении своих средств на счета других лиц и организа-

ций. Однако здесь возникает проблема: как банк узнает, что распоряжение по-

ступило именно от данного лица, а не от злоумышленника, выдающего себя за 

него? Одним из путей решения этой проблемы является передача получателю 

уникальной записи - электронной подписи.  

Принцип ее создания тот же, что и рассмотренный выше. С помощью спе-

циальной программы (полученной от банка) создаются те же два ключа: закры-

тый и публичный. Публичный ключ передается банку. Если теперь надо отпра-

вить поручение банку на операцию с расчетным счетом, оно кодируется пуб-

личным ключом банка, а своя подпись под ним кодируется собственным закры-

тым ключом. Банк поступает наоборот. Он читает поручение с помощью своего 

закрытого ключа, а подпись - с помощью публичного ключа поручителя. Если 

подпись читаема, банк может быть уверен, что поручение ему отправили имен-

но мы, и никто другой.  
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4. Сертификация Web-узлов  

При заказе товаров в Интернете важно убедиться, что сервер, принимаю-

щий заказы и платежи от имени некоей фирмы, действительно представляет эту 

фирму. Подтвердить это может сертификат продавца. В сертификате указано, 

когда он выдан и на какой срок. Прежде чем выполнять платежи через Интер-

нет или оправлять данные о своей кредитной карте кому-либо, следует прове-

рить наличие действующего сертификата у получателя путем обращения в сер-

тификационный отдел. Это называется сертификацией Web-узла. Например, в 

обозревателе Microsoft Internet Explorer 5.0, доступ к центрам сертификации 

осуществляется командой Сервис  Свойства Обозревателя  Содержание  

Сертификатов  Доверенные Корневые Центры Сертификации.  

5. Аутентификация 

Аутентификация является одним из самых важных компонентов организа-

ции защити информации в сети.  Прежде чем пользователю будет предоставле-

но право получить тот или иной ресурс, необходимо убедится, что он действи-

тельно тот, за кого себя выдает.  

При получении запроса на использование ресурса от имени какого-либо 

пользователя сервер, представляющий данный ресурс, передает управление 

серверу аутентификации. После получения положительного ответа сервера ау-

тентификации пользователю предоставляется запрашиваемый ресурс.  

Одной из схем аутентификации является использование стандартных па-

ролей. Эта схема является наиболее уязвимой с точки зрения безопасности - па-

роль может быть перехвачен и использован другим лицом. Чаще всего исполь-

зуются схемы с применением одноразовых паролей. Даже будучи перехвачен-

ным, этот пароль будет бесполезен при следующей регистрации, а получить 

следующий пароль из предыдущего является крайне трудной задачей.  

Тема 13. Алгоритмизация и программирование. Моделирование ре-

шения функциональных и вычислительных задач. 

Алгоритм – точное предписание, определяющее процесс перехода от ис-

ходных данных к результату. 
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Свойства алгоритма: 

1. Дискретность – алгоритм должен быть разбит на отдельные действия. 

2. Понятность – точное понятие команды. 

3. Определенность – исполнитель алгоритма не должен сомневаться в следую-

щем шаге. 

4. Результативность – по завершению выполнения алгоритма должен быть по-

лучен результат. 

5. Массовость – алгоритм должен быть написан для решения ряда подобных 

задач. 

Способы представления алгоритма: 

− Словесный; 

− Математическая формула; 

− Табличный; 

− Графический (блок - схема) 

Основные элементы блок – схемы: 

 
Основные базовые структуры алгоритма  

1. Линейная структура. 

2. Разветвляющая структура (ветвление). 

3. Циклическая структура (цикл).  

Программирование  - это процесс создания программы, который может 

быть представлен как последовательность следующих шагов: 

− Определение требований к программе; 

− Разработка или выбор алгоритма решения поставленной задачи; 

− Написание команд; 

− Отладка; 

− Тестирование. 
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Язык программирования - формальный язык для описания алгоритма ре-

шения задачи на компьютере.  

Уровни языков программирования 

Языки программирования бывают двух уровней: низкого и высокого уров-

ня.  

Языки программирования низкого уровня близки к машинному коду и 

ориентированы на конкретные команды процессора.  

Языком самого низкого уровня является язык ассемблера, который просто 

представляет каждую команду машинного кода, но не в виде чисел, а с помо-

щью символьных условных обозначений, называемых мнемоникой. Каждой 

модели процессора соответствует свой язык ассемблера.  

С помощью языков низкого уровня создаются очень эффективные и ком-

пактные программы, так как разработчик получает доступ ко всем возможно-

стям процессора. С другой стороны, для этого требуется очень хорошо пони-

мать устройство компьютера (отладка больших приложений  затруднена, а ре-

зультирующая программа не может быть перенесена на компьютер с другим 

типом процессора). Подобные языки обычно применяются для написания не-

больших системных приложений, драйверов устройств, когда важнейшими 

требованиями становятся компактность, быстродействие и возможность прямо-

го доступа к аппаратным ресурсам.  

Языки программирования высокого уровня значительно ближе и понятнее 

человеку, для описания алгоритма используется привычная для него форма. 

Особенности конкретных компьютерных архитектур (аппаратных средств) в 

них не учитываются, поэтому создаваемые тексты программ легко переносимы 

на другие платформы, имеющие программу перевода данного языка в машин-

ный код.  

Интерпретаторы и компиляторы  

С помощью языка программирования создается не готовая программа, а 

только ее текст, описывающий ранее разработанный алгоритм. Чтобы получить 

работающую программу, надо этот текст перевести в машинный код. Для этого 
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используются программы-трансляторы, которые бывают двух видов: компиля-

торы и интерпретаторы.  

Программа-компилятор переводит исходный текст программы в машин-

ный код и записывает его на диске в виде отдельного бинарного файла (инфор-

мация в машинном коде). При запуске программы исполняется бинарный файл. 

Почти все системы программирования работают с компилятором.  

Программа–интерпретатор работает совместно с исходным текстом. Каж-

дая команда интерпретируется в машинный код и немедленно исполняется. 

Файл на машинном языке не создается. Программа, написанная в системе про-

граммирования, включающая интерпретатор, работает медленно. Поэтому ин-

терпретаторы не нашли широкого применения.  

В настоящее время с интерпретатором работают в основном языки про-

граммирования для Интернета. Например, с интерпретатором работает Java, 

Perl.  

 Поколения языков программирования  

1-е поколение составляют языки, созданные в начале 50-х ггов, когда пер-

вые компьютеры только появились на свет. Это был первый язык ассемблера, 

созданный по принципу «одна инструкция – одна строка».  

2-е поколение составляют языки программирования конца 50-х – начала 

60-х гг. Тогда появился символический ассемблер, в котором существовало по-

нятие переменой. Он стал полноправным языком программирования.  

3-е поколение языков программирования относится к 60-м гг. В это время 

родились универсальные языки высокого уровня, с помощью которых появи-

лась возможность решать задачи из любых областей. Такие качества языков 

программирования высокого уровня как относительная простота, независи-

мость от конкретного компьютера и возможность использования алгоритмиче-

ских конструкций позволили резко повысить производительность труда про-

граммистов. Подавляющее большинство языков программирования этого поко-

ления успешно применяется и сегодня.  

4-е поколение языков программирования предназначено для реализации 
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крупных проектов, повышена их надежность и скорость создания. 4-е поколе-

ние началось в 70-х гг. и продолжается до настоящего времени. Как правило, 

языки 4-го поколения имеют мощные функции (операторы, команды), для реа-

лизации которых  на языках поколения младшего уровня потребовалось бы ты-

сячи строк.  

5-е поколение языков программирования появилось в середине 90-х гг. К 

ним относятся системы автоматического создания прикладных программ с по-

мощью визуальных средств разработки, без знания программирования. Инст-

рукции вводятся в компьютер в максимально наглядном виде с помощью мето-

дов, наиболее удобных для человека, не знакомого с программированием.  

Обзор языков программирования высокого уровня 

Fortran (Фортран) – это компилируемый язык, созданный в 50-е гг. Этот 

язык появился первым после языка ассемблера, поэтому удобство создания 

программы не так хорошо реализовано, как возможность получения эффектив-

ного машинного кода. В 2000 г. выпущен Фортран F2k.  

Cobol (Кобол) – компилируемый язык, разработанный в начале 60-х гг. для 

применения в экономической области и решения бизнес-задач. Отличается 

большой «многословностью»  его операторы иногда выглядят как обычные 

английские фразы. Очень распространен среди программистов США.  

 Algol (Алгол) – компилируемый язык, созданный в 1960 г. Он был при-

зван заменить Фортран, но из-за более сложной структуры не получил широко-

го распространения.  

Pascal (Паскаль) – создан  в конце 70-х гг. Во многом напоминает Алгол, 

но в нем ужесточены требования к структуре программы, за счет чего структу-

ра стала более наглядной и простой. Паскаль удобен для получения азов про-

граммирования, но также успешно применяется при создании крупных проек-

тов.  

Basic (Бейсик) – создавался в 60-х гг. в качестве учебного языка и очень 

прост в изучении. Для него имеются интерпретаторы и компиляторы.  

C (Си) – создан в лаборатории Bell и первоначально планировался для за-
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мены ассемблера. Имеет возможность создавать эффективные и компактные 

программы, в то же время не зависеть от конкретного типа процессора. Си во 

многом похож на Паскаль и имеет дополнительные средства для прямой рабо-

ты с памятью. В 1980 г. создано объектно–ориентированное расширение языка 

Си – С++(Си++).  

Java (Джава, Ява) – язык, созданный компанией Sun в начале 90-х гг. на 

основе Си++. Главная особенность этого языка – компиляция не в машинный 

код, а в платформенно-независимый байт-код (каждая команда занимает 1 

байт). Этот байт-код выполняется с помощью интерпретатора – визуальной 

Java–машины, версии которой существуют сегодня для любой платформы.   

Благодаря наличию множества Java–машин, программы легко переносятся на 

уровне двоичного байт-кода. Сегодня язык Ява очень популярен. Пока основ-

ной его недостаток – невысокое быстродействие, так как язык Ява интерпрети-

руемый.  

Языки программирования баз данных – язык структурированных запросов 

SQL. Основан на мощной математической теории и позволяет выполнять эф-

фективную работу, манипулируя не отдельными, а группами записей. Для 

управления большими базами данных используются СУБД. Практически в ка-

ждой СУБД, помимо поддержки языка SQL, имеется свой уникальный язык, 

ориентированный на особенности этой СУБД: Microsoft, IBM, Oracle, Software.  

Языки программирования для Интернет отличаются характерными осо-

бенностями: являются интерпретируемыми, интерпретаторы для них распро-

страняются бесплатно, а сами программы в исходных текстах. Такие языки на-

зываются скрипт-языками. Примерами языков программирования для Интернет 

являются НТМL, Perl, Tcl/Tk, VRML.  

Логические языки программирования используются в области создания 

искусственного интеллекта. Наиболее распространены Пролог, Ада.  

Системы программирования 

Для написания программы на языке программирования необходимо иметь 

на компьютере установленную соответствующую систему программирования.  
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Системы программирования  хорошо интегрированная система, вклю-

чающая как минимум:  

− специализированный текстовый редактор (для написания текста програм-

мы);  

− компилятор для перевода текста программы в машинный код (в редких слу-

чаях  интерпретатор);  

− библиотека функций (подключенные модули);  

− редактор связей для связывания модулей (файлов с исходными текстами) и 

стандартных функций, находящихся в библиотеках;  

− исполнимый код - законченную программу с расширением .COM или .EXE, 

которую можно запустить  на любом компьютере, где установлена операци-

онная система, для которой эта программа  создавалась;  

− справочную систему;  

− отладчик, позволяющий анализировать работу программы во время ее вы-

полнения по шагам.  

В последние несколько лет в программировании (особенно в программи-

ровании для операционной системы Windows) наметился так называемый визу-

альный подход. Он облегчает создание графических приложений, в таких сис-

темах имеется множество стандартных элементов управления и контроль за их 

работой. Подобные системы программирования называются средами быстрого 

проектирования RAD-среды.   

Наиболее популярны следующие визуальные среды быстрого проектиро-

вания программ для Windows: Basic: Microsoft Visual Basic, Pascal: Borland Del-

phi, C++: Borland C++ Bulider, Java: Symantec Cafй.  

Человечество в своей деятельности (научной, образовательной, техноло-

гической, художественной) постоянно создает и использует модели окру-

жающего мира. Строгие правила построения моделей сформулировать невоз-

можно, однако человечество накопило богатый опыт моделирования различ-

ных объектов и процессов. 

Модели позволяют представить в наглядной форме объекты и процессы, 
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недоступные для непосредственного восприятия (очень большие или очень 

маленькие объекты, очень быстрые или очень медленные процессы и др.). На-

глядные модели часто используются в процессе обучения. Модели играют 

чрезвычайно важную роль в проектировании и создании различных техниче-

ских устройств, машин и механизмов, зданий, электрических цепей и т. д. Раз-

витие науки невозможно без создания теоретических моделей (теорий, зако-

нов, гипотез и пр.),отражающих строение, свойства и поведение реальных 

объектов. Создание новых теоретических моделей иногда коренным образом 

меняет представление человечества об окружающем мире (гелиоцентрическая 

система мира Коперника, модель атома Резерфорда-Бора, модель расширяю-

щейся Вселенной, модель генома человека и пр.). Адекватность теоретических 

моделей законам реального мира проверяется с помощью опытов и экспери-

ментов. 

Моделирование – это метод познания, состоящий в создании и исследо-

вании моделей. 

Модель – это некий новый объект, который отражает существенные осо-

бенности изучаемого объекта, явления или процесса. 

Один и тот же объект может иметь множество моделей, а разные объекты 

могут описываться одной моделью. 

Все модели можно разбить на два больших класса: модели предметные 

(материальные) и модели информационные. Предметные модели воспроизво-

дят геометрические, физические и другие свойства объектов в материальной 

форме (глобус, анатомические муляжи, модели кристаллических решеток, ма-

кеты зданий и сооружений и др.). Информационные модели представляют 

объекты и процессы в образной или знаковой форме. 

Классификация моделей 

При построении математических моделей процессов функционирования 

систем существуют следующие основные подходы: 

 непрерывно-детерминированный (например, дифференциальные урав-

нения, уравнения состояния); 
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 дискретно-детерминированный (конечные автоматы); 

 дискретно-стохастический (вероятностные автоматы); 

 непрерывно-стохастический (системы массового обслуживания); 

 обобщенный или универсальный (агрегативные системы).  

Классификация моделей и видов моделирования объектов и систем в со-

ответствии с теорией подобия должна выделить в них наиболее общие призна-

ки и свойства реальных систем. Ниже приведена одна из возможных классифи-

каций.  

Признаки классификации Виды математических моделей 

1. Принадлежность к иерархическому 
уровню  

 Модели микроуровня  
 Модели макроуровня  
 Модели метауровня  

2. Характер взаимоотношений со сре-
дой  

 Открытые непрерывный обмен)  
 Закрытые (слабая связь)  

3. Характер отображаемых свойств 
объекта  

 Структурные  
 Функциональные  

4. Способ представления свойств объ-
екта  

 Аналитические  
 Алгоритмические  
 Имитационные  

5. Способ получения модели   Теоретические  
 Эмпирические  

6. Причинная обусловленность   Детерминированные  
 Вероятностные  

7. По отношению к времени   Динамические  
 Статические  

8. По типу уравнений   Линейные  
 Нелинейные  

9. По множеству значений переменных 
 Непрерывные  
 Дискретные  
 Дискретно-непрерывные  

10. По назначению  
 Технические  
 Экономические  
 Социальные и т.д.  

Моделирование в целом включает в себя ряд этапов:  
1. Содержательная постановка задачи. Необходимо выработать общий подход 

к исследуемой проблеме, определить подзадачи, сформулировать основную 

цель и наметить пути ее достижения. На этом этапе требуется глубокое по-
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нимание существа протекающих процессов в рассматриваемой системе, что-

бы корректно поставить задачу.  

2. Изучение и сбор информации об объекте-оригинале. На этом этапе анализи-

руются или подбираются подходящие гипотезы, аналогии, теории, учитыва-

ются опытные данные, наблюдения и т.д. Определяются входные и выход-

ные переменные, связи, принимаются упрощающие предположения.  

3. Формализация. Принимаются условные обозначения и с их помощью опи-

сываются связи между элементами объекта в виде математических выраже-

ний.  

4. Выбор метода решения. Для поставленной математической задачи обосно-

вывается метод ее решения с учетом знаний и предпочтений пользователя и 

разработчика.  

5. Реализация модели. Принимается критерий оценки эффективности модели, 

разрабатывается алгоритм, пишется и отлаживается программа, чтобы осу-

ществить системный анализ и синтез.  

6. Анализ полученных результатов. Сопоставляется предполагаемое и полу-

ченное решение, проводится оценка адекватности и погрешности моделиро-

вания. Уточнение модели происходит до тех пор, пока не будут получены 

приемлемые результаты.  

Таким образом, после прохождения этих этапов наиболее полно могут 

быть выполнены требования, предъявляемые к моделям:  

 Универсальность – характеризует полноту отображения моделью изучаемых 

свойств реального объекта;  

 Адекватность – способность отражать нужные свойства объекта с погреш-

ностью не выше допустимой;  

 Точность – оценивается степенью совпадения значений характеристик ре-

ального объекта со значениями этих характеристик, полученных с помощью 

моделей;  

 Экономичность – определяется затратами ресурсов ЭВМ (памяти и времени 

на ее реализацию и эксплуатацию).  
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Тема 14. Основы программирования в Delphi. 

Delphi – это среда разработки программ, ориентированных на работу в 
Windows. В качестве языка программирования в Delphi используется объектно-
ориентированный язык Object Pascal. 

Объектно-ориентированное программирование – это методика разработки 
программ, в основе которой лежит понятие объекта. 

Объект – это совокупность свойств (параметров) определенных сущностей 
и методов их обработки (программных средств). 

Свойство – это характеристика объекта, его параметр. Все объекты наде-
лены определенными свойствами, которые в совокупности выделяют объект из 
множества других объектов. 

Одним из свойств объекта является метод его обработки. 
Метод – это программа действий над объектом или его свойствами. 
Метод рассматривается как программный код, связанный с определенным 

объектом; осуществляет преобразование свойств, изменяет поведение объекта. 
Объект может обладать набором заранее определенных встроенных мето-

дов обработки, либо созданных пользователем или заимствованных в стандарт-
ных библиотеках, которые выполняются при наступлении заранее определен-
ных событий. 

Событие – это изменение состояния объекта. 
Объекты могут объединяться в классы. 
Класс – это совокупность объектов, характеризующихся общностью при-

меняемых методов обработки и свойств. 
Среда Delphi состоит из нескольких отдельно расположенных окон. Это 

близко к той модели приложений, что используется в Windows. Окна могут пе-
ремещаться по экрану, частично или полностью перекрывая друг друга.  После 
запуска Delphi перед вами появятся основные окна:  

1. главное окно (заголовок Delphi5 - Project1);  
2. окно формы (заголовок Form1);  
3. окно Инспектора Объектов (Object Inspector);  
4. окно кода программы или окно редактора кода (заголовок Unit1.pas);  
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Первоначально окно кода перекрыто окном формы, для переключения ме-
жду которыми осуществляется клавишей F12. 

Почти все объекты Windows реализованы в Delphi в виде палитры визу-
альных компонентов VC. Компоненты сгруппированы в отдельные страницы, 
каждая из которых снабжена закладкой. Если вы щелкнете мышью на одну из 
закладок, то сможете перейти на соответствующую ей страницу.  

При подведении курсора мыши к компоненте (или нажатие правой кнопки 
мыши на компоненте) появляется подсказка - название компоненты. 

Форма - окно будущей программы. Окно формы представляет собой проект 
окна Windows: имеет заголовок, кнопку вызова системного меню, кнопку макси-
мизации, минимизации и закрытия окна, рамку окна. На форме размещаются ком-
поненты, тем самым, формируя окно будущей программы. Форма относится к раз-
ряду класс. Форма относится к классу TForm. 

Окно Инспектора Объектов содержит две страницы: Properties (Свойства) и 
Events (События). 

Страница Свойства служит для указания свойств объекта. На этой странице 
указаны все свойства активного (выделенного) объекта. Рассмотрим первые не-
сколько свойств компонент. 

− Cвойство Name - имя переменной, определяет как этот элемент будет назы-
ваться в создаваемой программе. Имена создаются средой Delphi по такому 
принципу: сначала идет название компонента (Form), а за ним порядковый но-
мер размещенного на форме компонента (1). То есть если добавить еще одну 
форму, то она получит имя Form2, следующее – Form3 и т.д. Имя, заданное по 
умолчанию можно изменить, но при этом желательно использовать только 
английские буквы и цифры. Запомните! Свойство Name задается первоначаль-
но, это имя переменной с которой вы будете работать при написании програм-
мы.  

− Свойство Font - шрифт, позволяет выбрать параметры шрифта.  

− Свойство Caption - надпись, создает надпись, в соответствии со свойством 
Font.  

− Свойство COLOR - цвет, определяет цвет объекта.  

− Свойство Width - определяет ширину объекта.  

− Свойство Height - определяет высоту объекта.  
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− Свойство Left - указывает расстояние от объекта до левой границы формы. 

− Свойство Тор - указывает расстояние от объекта до верхней границы формы.  
Для написания программы нужно разместить необходимые компоненты, 

задать их свойства, определить события и реакцию на событие. 
Для размещения компоненты на форме нужно щелкнуть мышью на компо-

ненте, после щелкнуть на форме. 
Компонента TLabel - метка, служит для отображения текста на экране. 
У компонента TLabel есть свойство AutoSize, по умолчанию установленное в 

True. Эта установка позволяет метке увеличиваться и уменьшаться при изменении 
надписи, размера шрифта. Если цвет метки совпадает с цветом фона, то при со-
кращении надписи до нулевой длины, она может исчезнуть с экрана. В этом слу-
чае разыскать ее можно, перейдя в окно Инспектора Объектов, развернув список 
компонент и выбрав ее из этого списка. 

Компонент TButton - командная кнопка. TButton позволяет выполнить какие-
либо действия при нажатии кнопки во время выполнения программы.  

Запомните! Определяя свойства любой компоненты, ее необходимо выде-
лить. 

События устанавливаются в окне Инспектора Объектов на странице Events 
(События). 

OnClick - событие щелчок мыши. 
OnDbClick - событие двойной щелчок мыши. 
OnClose - закрытие окна формы. 

Компонент TEdit 
TEdit - однострочное окно ввода-вывода 
С помощью компонента TEdit можно вводить или отображать достаточно 

длинные строки.  
Центральным свойством компонента является свойство Text, которое пред-

ставляет собой отображаемую строку.  
Свойства компонента:  

AutoSelect: Boolean Указывает, будет ли выделяться весь текст в момент получения ком-
понентом фокуса ввода. 

AutoSize: Boolean Если содержит True и BorderStyle=bsSingle, высота компонента ав-
томатически меняется при изменении высоты шрифта. 

TborderStyle = 
bsNone, bsSingle;  

Определяет стиль обрамления компонента: bsNone – нет обрамления, 
bsSingle – компонент обрамляется одной линией. 
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MaxLength: Integer; Определяет максимальную длину текстовой строки. Если имеет зна-
чение 0, длина строки не ограничена. 

Modified: Boolean; Содержит True, если текст был изменен. 
ReadOnly: Boolean; Если содержит True, текст не может изменяться. 
SelLength: Integer; Содержит длину выделенной части текста. 
SelStart: Integer; Содержит номер первого символа выделенной части текста. 
SelText: String; Содержит выделенную часть текста. 
Text: String; Содержит весь текст. 

Методы компонента:  
Clear; Удаляет весь текст. 
ClearSelection; Удаляет выделенный текст. 
CopyToClipboard; Копирует выделенный текст в буфер обмена ClipBoard. 
CutToClipboard; Копирует выделенный текст в буфер обмена ClipBoard, после чего 

удаляет выделенный текст. 
SetFocus; Устанавливает фокус ввода. 
PastefromClipboard; Вставляет текст из буфера обмена Clipboard. 
SelectAll; Выделяет весь текст. 
Undo; Восстанавливает текст в том виде, в каком он был перед последним 

получением компонентом фокуса ввода. 
После выбора события автоматически открывается окно кода программы. 

Окно кода программы предназначено для создания и редактирования тек-

ста программы. Этот текст составляется по определенным правилам. Совокуп-

ность правил записи текста называется языком программирования.  

После задания события в коде программы автоматически создается проце-

дура обработки события, внутри которой описывается реакция на событие. За-

головок процедуры формируется следующим образом: 

Procedure TF1. Button1Click (Sender:TObject); {событие нажатие мыши на 

компоненте Button1, расположенной на форме F1 } 

Begin 

 

End;  

Между Begin End указывается реакция на события - перечень совершае-

мых действий. 

Перед тем как запустить программу на исполнение необходимо ее сохра-

нить. Сохранение программу осуществляется в два этапа. 

1. File / Save as …- сохраняет программу с расширением .pas. Имя файла 

задается английскими буквами. Например, sdr.pas. 
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2. File / Save project as … - сохраняет проект, работающим с программой, с 

расширением .dpr. Имя проекта желательно формировать следующим образом: 

римя файла.dpr. Напрмер, psdr.dpr. 

Для компиляции и обнаружения ошибок в программе выбирается команда 

Project/Compile. В случае если отладчик обнаружит ошибку, он выделить эту 

строку красным цветом. Вы можете открыть команду Project/Information - итоги 

компиляции, надпись Succestfully будет свидетельствовать о том, что ошибки 

не обнаружены. 

Для запуска программы на исполнение выбирается команда Run/Run или 

нажать клавишу F9. 

Возможно, ваша программа даст сбои при работе. Тогда необходимо вы-

полнить команду Run/ Program Reset - прекращение работы программы. 

Тема 15. Введение в Object Pascal. Линейная структура. Оператор 

ветвления. 

Линейное программирование 

Элементы языка Object Pascal. Основные понятия языка. 

Алфавит языка Object Pascal включает буквы, цифры, специальные символы, 

пробелы, зарезервированные (ключевые слова). Цифры – арабские цифры от 0 до 

9. Ключевые (зарезервированные) слова – это последовательность символов, 

имеющая в данном языке особый установленный смысл. Ключевые слова нельзя 

использовать в качестве идентификаторов. Ключевые слова выделяются жирным 

шрифтом.  

Идентификаторы  - это имена констант, переменных, типов, модулей, объ-

ектов и т.п. Идентификаторы могут иметь различную длину, но значащими яв-

ляются только первые 63 символа. Идентификаторы всегда начинаются буквой, 

за которой могут следовать буквы и цифры, не содержат пробелов и специаль-

ных символов.  

Оператор – минимальная структура в программе, производящая закончен-

ное действие. Оператор содержит ключевое слово, которое определяет его 

смысл.  
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Данные. Структура типов данных. Простые типы данных  

Данные в Object Pascal бывают:  

− константы (сохраняют свое значение в течение работы всей программы);  

− переменные (могут изменять значение в результате работы программы);  

− значение функций или выражений.  

Любые данные характеризуются своими типами. Тип определяет:  

− множество допустимых значений, которые может иметь то или иное данное;  

− множество допустимых операций, которые применимы к данному;  

− объем памяти, выделяемый для хранения данного.  
Object Pascal характеризуется разветвленной структурой типов данных.  

 
Данные простого типа хранят в себе только одно значение. К простым ти-

пам относятся целые, вещественные, логические, символьные, перечисляемые, 
тип-диапазон.  

Целые типы данных используются для представления целых чисел. Есть не-
сколько различных целых типов, которые могут хранить целые значения. Различ-
ные целые типы имеют существенно различные диапазоны хранимых значений, 
затраты памяти растут с ростом допустимого диапазона значений.  

Тип  Диапазон значений  Требования к памяти  
Byte  [0; 255]  1 байт  
Word  [0; 65535]  2 байт  
Shorting  [-128; 127]  1 байт  
Smallint  [-32768; 32767]  2 байт  
Integer  [-2147483648; 2147483647]  4 байт  
Cardinal  [0; 2147483647]  4 байт  
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Longint [-2147483648; 2147483647] 4байт 

Вещественные типы данных предназначены для хранения чисел, имеющих 

дробную часть.  

Тип  Диапазон значений  Требования к памяти  
Real  [2.9*10-39; 1.7*1038]  6 байт  
Single  [1.5*10-45; 3.4*1038]  4 байт  
Extended  [3.4*10-4932; 1.1*104392]  10 байт  
Логический тип данных – один из простейших и часто используемых. Приме-

ром логического типа является Boolean. Переменные типа Boolean представляют 
собой логические значения True или False.  

Значениями символьного типа являются множество всех символов компью-
тера (буквы, цифры, арифметические знаки, орфографические знаки, специальные 
символы). Код необходим для внутреннего представления символа.  

Для кодировки в Windows используется код ANSI (назван по имени American 
National Standard Institute – Американского института стандартизации).  

Примером символьного типа данных является тип Char, использующийся для 
хранения одного символа и в памяти отводится 1 байт. 

Математические выражения, функции и операции 
Математические выражения – это операции с числами, переменными, значе-

ниями функций.  
Порядок выполнения операций – слева направо, при этом сначала выполня-

ются действия в скобках, после умножение, деление, арифметические функции, а 
дальше сложение, вычитание. Числа записываются при помощи цифр, причем це-
лая часть от дробной отделяется точкой.  

Например:  4.5*(b-2.2)/(c+5.1).  
Числа могут быть представлены в показательной форме в виде:  
1.76Е-3 – запись соответствует 1.76*10-3=0.00176  
3.765Е4  – запись соответствует  3.765*104= 37650  

Опе-
рация 

Действие Тип результата Пример 

+ Сложение 4+5 = 9 
- Вычитание 9 - 4 = 5 
* Умножение 

Соответствует типу 
операндов 2 * 2 = 4 

/ Деление Вещественный 10/2=5 
div Целочисленное деление 9 div 4 = 2 
mod Остаток от деления 

Целый 
9 mod 4 = 1 

abs Модуль числа abs(-5.3)=5.3 
sqr Возведение в квадрат 

Соответствует типу 
операнда sqr(4)=16 
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sqrt Квадратный корень sqrt(78)=2.97 
cos Косинус cos(4)=0.997 
sin Синус sin(4)=0.069 
exp Экспонента exp(4) 
ln Натуральный логарифм 

Вещественный 

ln(4)=1.38 
round Округление до ближайшего целого round(4.5)=5 
trunc Возвращает целое число путем отбрасы-

вания дробной части 
Целый trunc(4.5)=4 

Оператор присваивания 

Это наиболее часто используемый оператор языка. Синтаксис оператора 

присваивания:  

Идентификатор:= выражение; 

Символы «:=» всегда пишутся слитно, без разделяющих пробелов, хотя 

перед двоеточием и после знака равенства можно для лучшей читаемости про-

граммы вставлять пробелы. Как и любой другой оператор языка, оператор при-

сваивания завершается точкой с запятой. Переменные и результат выражения 

должны быть одного типа.  

Составной оператор  

Это последовательность произвольных операторов программы, заключен-

ная в операторные скобки – begin … end.  

Составной оператор может состоять из любого количества операторов:  

begin  

оператор1;  

оператор2;  

...  

операторN;  

end;  

Задание.  Даны два числа. Найти их сумму. 

 Решение любой задачи начинается с определения входных и выходных 

переменных. 

входные переменные    a, b:тип (целый, вещественный, символ, строка и 

т.д.) 

выходные переменные  f:тип (целый, вещественный, символ, строка и т.д.) 
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Для визуального программирования зарисовываются два окна. В первом 

окне определяется внешний облик окна, во втором окне указываются исполь-

зуемые элементы управления (компоненты). 

 
Второй этап моделирования программы, кроме визуального проектирова-

ния окна программы предполагает и описание событий. 

В нашей программе будет два события: 

1. Щелчок мыши на компоненте "Вычислить" - procedure TF1. 

Button1Click(); 

2. Щелчок мыши на компоненте "Очистить" - .... 

Третий этап моделирования программы называется алгоритмизация. На 

данном этапе составляется алгоритм для каждого события. 

Например, первое событие щелчок мыши на кнопке "Вычислить" - 

Button1Click,  находит  сумму двух чисел a и b. 

На данном этапе проектирования программы реализуются алгоритмы на 

языке программирования. Для этого первоначально нужно создать события. 

Напоминаем. Для задания события выделяется данный компонент.  Далее 

переходят в Инспектор Объектов на страницу Events и два раза щелкают мы-

шью на нужном событии (в первом случае на событии OnClick). После выбора 

события автоматически открывается окно кода программы. В окне коде про-

граммы автоматически создается процедура обработки события, внутри кото-

рой описывается реакция на событие.  

В первой части процедуры описываются данные. Для описания перемен-

ных существует раздел var. 
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Var имя переменной: тип данных; 

При написании процедур необходимо помнить, что все вводимые данные 

воспринимаются как строки. Поэтому необходимо переводить вводимые дан-

ные из строки в числа, а выводимый результат переводить из числа в строку. 

StrToInt – перевод строки в целое число 

StrToFloat – перевод строки в веществен-

ное число 

 

IntToStr – перевод целого числа встроку  

FloatToStr – перевод вещественного числа  

в строку  

 

Процедуры примут вид 

Procedure TS1.Button1Click(); 

Var a,b,S: real; 

begin 

a:=StrToFloat(edit1.text); 

b:=StrToFloat(edit1.text); 

S:=a+b; 

edit3.text:=FloatToStr(S); 

end; 

Procedure TS1.Button2Click(); 

begin 

edit1.clear; 

edit2.clear; 

edit3.clear; 

edit3.visible:=false; 

edit1.SetFocus; 

end; 

Оператор ветвления 

Ветвление - это алгоритмическая структура, в которой проверяется некоторое 

условие и в зависимости от результатов проверки выполняется то или иное дейст-

вие. 

Для программирования проверки условия и выбора действия в зависимости 

от этого условия используются условные операторы. 

Условие в языке программирования может принимать два значения: истина 

(True) и ложь (False). Условие записывается с помощью операций отношений и ло-

гических операций. 

Операции отношения. Логические операции  
Оператор Описание Значение выражения 

> Больше True, если первый операнд больше второго, иначе False 
< Меньше True, если первый операнд меньше второго, иначе False 
= Равно True, если первый операнд равен второму, иначе False 
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<> Не равно True, если первый операнд не равен второму, иначе False 
>= Больше или равно True, если первый операнд больше или равен второму, 

иначе False 
<= Меньше или рав-

но 
True, если первый операнд меньше или равен второму, 
иначе False 

Использование операторов сравнения позволяет записывать простые усло-

вия. Из простых условий, которые являются выражениями логического типа, 

можно строить сложные условия с применением к ним, как к операндам, логи-

ческих операторов: not, and, or, xor. 

Существует две формы условного оператора: 

1. Полное ветвление (развилка) 

Синтаксис: 

  If условие 

    Then оператор1 

      Else оператор2; 

После оператора1 ";" не ставится. 

Действия: Проверяется условие, если оно истинно, т. е. принимает значе-

ние True, то выполняется оператор1, иначе, если условие ложно, т. е. принима-

ет значение False, то выполняется оператор2.  

Иногда после служебных слов Then или Else может стоять более одного 

оператора. Тогда необходимо использовать составной оператор. 

Составной оператор может состоять из произвольного количества опера-

торов, разделенных между собой “;“. 

Синтаксис: 

                     Begin 
                       Оператор1; 
                       Оператор2; 
                           …….. 
                        Оператор n; 
                     End; 

2. Неполное ветвление 

Синтаксис: 
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  If условие 

    Then оператор; 

 Действия: Если условие принимает значение True, то выполняется опе-

ратор, иначе никаких действий не происходит. 

Пример. Составить программу вычисления значения функции 

( )

⎪
⎪
⎩

⎪⎪
⎨

⎧

>−
≤≤++

<++

=
1 ,4

10 ,43
0 ,43

3

23

x
xxx

xxx
y .  

Определим переменные задачи: 

Входные  данные: х: вещественного типа. 

Выходные данные: у: вещественного типа.  

Для решения задачи расположим компоненты на окне формы.   

 

procedure TForm1.Button1Click();  

var x,y:real;  

begin  

x:=strtofloat(edit1.text);  

if (x>=0) and (x<=1) then y:= x*x*x+3*x +4; 

if (x<0) then y:=sqr(x*x*x +3*x+4);  

if (x>0) then y:=-4;  

edit2.text:=floattostr(y);  

end; 

Тема 16. Оператор выбора. 

Оператор выбора позволяет выбрать одно из нескольких возможных продол-

жений программы. Параметром, по которому осуществляется выбор, служит ключ 

выбора s – выражение любого порядкового типа (кроме типов Real и String). 

Синтаксис: 

                      Case s of 
                         c1:оператор1; 
                         c2:оператор2; 
                           ……… 
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                         cn:оператор n 
                         else оператор; 
                      End; 
где c1, c2, …, cn – все простые типы Integer, Char, за исключением Real. Это 

конкретное значение управляющей переменной и выражения s, при котором 

необходимо выполнить соответствующий оператор, игнорируя все остальные. 

Если в наборе несколько значений, то они разделяются между собой «,». 

Можно указывать диапазоны значений между которыми ставятся «.». 

Между набором значений с и соответствующим ему оператором должно 

стоять «:». Значения c1 … cn не должны повторяться. 

Для работы с оператором выбора в Delphi служат несколько компонент. 

1. Компонента TRadioGroup. 

Компонент представляет собой комбинацию GroupBox с набором Ra-

dioButton, т. е. контейнер для размещения зависимых переключателей класса 

TRadioButton, каждый переключатель помещается в специальный список Items 

и доступен по индексу. 

Нумерация переключателей начинается с нуля. 

Свойства TRadioGroup: 

− Name – имя; 

− Colums – количество столбцов переключателя; 

− ItemIndex – индекс выбранного переключателя; 

− Items – список строк с заголовками элементов. 

Пример1. Написать программу изменяющую цвет формы. 

 

procedure TForm1.RG1Click(); 
begin 
case RG1.ItemIndex of 
  0:Form1.Color:=clred; 
  1:Form1.Color:=clblue; 
  2:Form1.Color:=clgreen; 
end; 

end; 
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2. Компонента TListBox. 

Компонент содержит список элементов, которые могут быть выбраны при 

помощи клавиатуры или мыши. Список может содержать строки и произволь-

ное изображение. Список задается свойством Items и доступен по индексу. 

Нумерация строк начинается с нуля. 

Свойства TListBox: 

− Name – имя; 

− ItemIndex – индекс выбранного переключателя; 

− Items – список строк с заголовками элементов. 

Пример2. По выбранному месяцу вывести название времени года. 

 

procedure TForm1.ListBox1Click(); 

begin 

case ListBox1.ItemIndex of 

  0,1,11:Edit1.Text:='зима'; 

  2,3,4:Edit1.Text:='весна'; 

  5,6,7:Edit1.Text:='лето'; 

 8,9,10:Edit1.Text:='осень'; 

end; 

end; 

3. Компонента TComboBox. 

Компонент представляет собой комбинацию списка ListBox и компоненты 

Edit (большинство свойств и методов взято у этих компонент). 

Нумерация списка начинается с нуля. 

Свойства TComboBox: 

− Name – имя; 

− ItemIndex – индекс выбранного переключателя; 

− Items – список строк с заголовками элементов. 

Пример 3. По выбранному месяцу в компоненте ListBox отобразить назва-

ние времени года в компоненте ComboBox. 
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procedure TForm1.ListBox1Click(); 

begin 

case ListBox1.ItemIndex of 

  0,1,11:ComboBox1.ItemIndex:=0; 

  2,3,4:ComboBox1.ItemIndex:=1; 

  5,6,7:ComboBox1.ItemIndex:=2; 

  8,9,10:ComboBox1.ItemIndex:=3; 

end; 

end; 

 

Тема 17. Циклические структуры. 

При решении многих задач некоторая последовательность действий при-

ходится выполнять несколько раз. Такие повторяющиеся действия называются 

циклами. 

 1. Оператор цикла с параметром. 

Данный оператор используется, если надо выполнить некоторую последо-

вательность действий несколько раз, причем число повторений заранее извест-

но. 

Синтаксис: 

For параметр цикла:=мл. знач. to ст. знач. do 

For параметр цикла:=ст.. знач. downto мл. знач. do 

Здесь For, to, do – зарезервированные слова (для, до, делать). 

Если параметр возрастает, то между границами его значений ставится to, 

если убывает, то downto. 

Действия: параметру цикла присваивается начальное значение и выполня-

ется тело цикла, затем параметру цикла присваивается следующее значение и 

вновь выполняется тело цикла и так до тех пор, пока не будет перебраны все 

значения параметра цикла. 

Замечание1. Счетчик цикла увеличивается автоматически на единицу.  
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Замечание 2. Если в цикле используется более одного оператора, то необ-

ходимо использовать операторные скобки (составной оператор). 

2.Оператор цикла с постусловием. 

Данный оператор используется в программе, если надо провести некото-

рые повторяющиеся вычисления, однако число повторов заранее не известно и 

определяется самим ходом вычисления. 

Синтаксис:  

Repeat тело цикла  

Until условие; 

 

 

Здесь Repeat,Until – зарезервированные слова (повторять до тех пор, пока не 

будет выполнено условие). 

Действия: сначала выполняются операторы, потом проверяется условие. Ес-

ли оно ложно, то снова выполняются операторы, и так до тех пор, при проверке 

условие не примет значение True. 

Замечание 1. Тело цикла будет выполняться хотя бы один раз. 

Замечание 2. Если в теле цикла используется несколько операторов, то со-

ставной оператор не нужен. 

Замечание 3. Параметр цикла может быть вещественного типа и задается в 

теле цикла. 

3. Оператор цикла с предусловием. 

Данный оператор, как и оператор Repeat,  используется в программе, если на-

до провести некоторые повторяющиеся вычисления, однако число повторов зара-

нее не известно и определяется самим ходом вычисления. 

Синтаксис:  

While условие Do оператор; 

 

Здесь While, Do – зарезервированные слова (пока выполняется условие де-

лать). 

Действия: сначала проверяется условие, если оно истинно, то выполняется 

тело цикла. Затем снова проверяется условие и т. д. Если условие ложно, то 

цикл завершается и выполняется оператор, стоящий непосредственно после 
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цикла. 

Замечание 1. Если в теле цикла используется несколько операторов, то не-

обходим составной оператор. 

Замечание 2. Параметр цикла может быть вещественного типа, задается и 

увеличивается пользователем в теле цикла. 

Пример 1. Найти значение n! факториала. 

Определим переменные задачи: 

Входные  данные: n: целого типа. 

Промежуточные переменные: i: целого типа - параметр элемента, изменяется 

на промежутке [1;n] с шагом 1. 

Результат: Р: вещественного типа.  

Запомните! Первоначальное значение суммы S=0, а произведения P=1. 

Именно эти значения не вносят свой вклад в вычисление результата. 

Решение данной задачи рассмотрим для цикла с  

параметром. Поэтому расположим следующие компоненты на окне формы. 

Программа решения задачи с помощью цикла с параметром следующие: 

 

procedure TForm1.Button1Click(); 

var i,n,P:integer; 

begin 

n:=strtoint(edit1.text); 

P:=1; 

for i:=1 to n do 

P:=P*i; 

edit2.text:=inttostr(P); 

end; 

Часто при решении задач результат выводится в несколько строк, поэтому 
в таких задачах используется новый компонент TMemo. 

TMemo - многострочное окно ввода-вывода 
Компоненты класса TMemo предназначены для ввода, редактирования и 

отображения достаточно большого текста. Компонент представляет собой  не-
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большой текстовый редактор, имеет ограничения на объем текста в 32Кб, что 
составляет 10-20 стр.  

Текст хранится в свойстве Lines класса TStrings.  В целом компонент пред-
ставляет собой пронумерованный набор строк (нумерация начинается с нуля). 
С помощью методов класса TStrings можно динамически формировать содер-
жимое компонента. 

Методы класса:  
Add(s:string):integer;  Добавляет строку в набор данных последней и воз-

вращает ее индекс.  
Clear;  Очищает набор данных.  
Delete(Index:integer);  Удаляет строку с индексом Index.  
Insert(index:integer; s;string);  Вставляет строку в набор с индексом Index.  
String[номер строки] Получить текст в строке 
Count:Integer Получить количество строк в Memo 

Компоненту присущи специфичные свойства:  
Lines: Tstrings; Содержит строки текста. 
Text: String; Содержит весь текст. 

 

Пример 2. Вычислить значение функции 
⎪
⎩

⎪
⎨

⎧

>

<
≤≤

=

2  ,cos
1  ,1

21  ,ln2

tbte
t

ttat
y

at

 на интервале [0; 3] с 

шагом 15.0=∆t . 

 Задачи такого типа называются задачами на табулирование, т. е. при ре-

шении таких задач результаты выводятся на каждом шаге. 

Определим переменные задачи: 

Входные  данные: a, b: целого типа. 

Выходные данные: y: вещественного типа.  

Программа решения задачи с помощью цикла с предусловием: 

procedure TForm1.Button1Click( ); 
var a,b:integer; t,y:real; 

begin 
a:=StrToInt(Edit1.Text); 
b:=StrToInt(Edit2.Text); 
t:=0; 
while t<=3 do 
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begin 
  if t>2 
   then y:=exp(a*t)*cos(b*t); 
  if t<1 
   then y:=1 
    else y:=a*SQR(t)*ln(t); 
 Memo1.Lines.Add(FloatToStr(t)); 
 Memo1.Lines.Add(FloatToStr(y)); 
 t:=t+0.15; 
end; 
end; 

Пример 3. Составить программу, находящую сумму ряда ( )∑
=

n

i

i
1

sin . 

Условие задачи определяет ряд, вида Sin(1) + Sin(2) + Sin(3) + ... + Sin(n). 

Обозначим отдельный элемент переменной a. Можно сказать, что каждый 

элемент a = Sin(i), где i=1,2,3, ... , n. 

i - параметр элемента, который каждый раз изменяется на один (i=i+1). 

Определим переменные задачи: 

Входные  данные: n: целого типа  - параметр  последнего элемента. 

Промежуточные переменные: i: целого типа - параметр элемента, изменя-

ется на промежутке [1;n] с шагом 1; a: вещественного типа - элемент, равный a 

= sin(i). 

Выходные данные: S: вещественного типа - сумма ряда.  

Решение данной задачи рассмотрим для всех циклов. 

 Программа решения задачи с помощью цикла с предусловием: 

Procedure TForm1.Button2.Click(); 
var n,i:Integer; 
       a,S:real;  
 begin 
n:=StrToInt (edit1.text); 
S:=0 ; 



 119

i:=1; 
while i<=n do 
  begin 
       a:=sin(i); 
       S:=S+a; 
       i:=i+1; 
   end; 
Memo1.Lines.Add (FloatToStr(S)); 
end; 

Программа решения задачи с помощью цикла с постусловием следующие: 
Procedure TForm1.Button1.Click(); 
var n,i:Integer; 
       a,S:real;  
 begin 
n:=StrToInt (edit1.text); 
S:=0 ; 
i:=1; 
Repeat 
                   a:=sin(i); 
                   S:=S+a; 
                    i:=I+1; 
Until i>n; 
Memo1.Lines.Add (FloatToStr(s)); 
end; 

Программа решения задачи с помощью цикла с параметром: 
Procedure TFORM1.Button3.Click(); 
var n,i:Integer; 
       a,S:real;  
 begin 
n:=StrToInt (edit1.text); 
S:=0 ; 
For i:=1 to n do  
 begin 
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          a:=sin(i); 
          S:=S+a;      
 end;                   
 Memo1.Lines.Add (FloatToStr(s)); 
end; 

Тема 18. Работа с массивами. Компонент TStringGrid. 

Одномерный массив  - это фиксированное количество элементов одного и то-
го же типа, объединенные одним именем, где каждый элемент имеет свой номер. 

 Пример.1 Дано 30 целых чисел от 25 до 54, объединенных общим именем А. 
N 
1 
2 
3 
… 
30 

A 
25 
25 
27 
… 
54 

А – общее имя для всех элементов 
Элементы массива A[i] – целые числа 
A[3]=27 

Описание массива: 
1. В разделе описания переменных массив описывается следующим образом: 

Var имя массива:ARRAY[1..t1] OF t2; 
ARRAY – массив; OF – из; 
t1 – количество элементов массива;  
t2 – тип элементов массива, допустимый в языке Object Pascal. 
Пример.2 Var А:ARRAY[1..30] OF integer; 

2. В разделе описания типов. 
 В разделе TYPE указывается тип массива, затем в разделе описания пере-

менных VAR перечисляются массивы, относящиеся к описанному (указанному) 
типу. 

TYPE имя типа=ARRAY[1..t1] OF t2; 
VAR имя массива: имя типа;  

Пример.3 TYPE mas=ARRAY[1..30] OF integer; 
VAR A: mas;  

 Если в программе несколько массивов, например, А, В, С имеют тип mas, то 
через запятую перечисляются в разделе описания переменных VAR. 

Типичные действия с массивами: 
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1. Вывод массива на экран.  
Вод выводом массива понимается вывод на экран значений элементов масси-

ва. Если в программе необходимо вывести значения всех элементов массива, то 
для этого удобно использовать инструкцию For, переменная-счетчик которой мо-
жет быть использована как индекс элемента массива. 

2. Ввод элементов массива.  
Под вводом массива понимается ввод значений элементов массива. Как и вы-

вод массива, ввод удобно реализовать при помощи инструкции For. Чтобы пользо-
ватель программы знал, ввода какого элемента массива ожидает программа, сле-
дует организовать вывод подсказок пере вводом очередного элемента массива. В 
подсказке обычно указывают индекс элемента массива. Элементы могут вводиться 
пользователем, либо с помощью генераторов случайных чисел. 

3. Сортировка массивов. 
Под сортировкой массива подразумевается процесс перестановки элементов с 

целью упорядочивания их в соответствии с каким-либо критерием. Существует 
много методов (алгоритмов) сортировки массивов. В приведенных примерах рас-
смотрим сортировку массива методом прямого выбора. 

4. Поиск в массиве заданного элемента. 
Для организации поиска в массиве могут быть использованы различные алго-

ритмы. Наиболее простой – это алгоритм простого перебора. Поиск осуществляет-
ся последовательным сравнением элементов с образцом, пока не будет найден ис-
комый элемент или перебраны все элементы массива. Алгоритм простого перебо-
ра применяется, если элементы массива не упорядочены. 

5. Поиск в массиве максимального и минимального элементов. 
Алгоритм поиска максимального (минимального) элемента массива довольно 

очевиден6 делается предположение, что первый элемент массива является макси-
мальным (минимальным), затем остальные элементы массива сравниваются с этим 
элементом. Если обнаруживается, что проверяемый элемент больше (меньше) 
принятого за максимальный (минимальный), то этот элемент принимается за мак-
симальный (минимальный) и продолжается проверка оставшихся элементов. 

 Для работы с массивами в Object Pascal используются следующие компо-
ненты: 
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1. StringGrid (SG)– таблица строк, предназначена для создания таблиц, в ячейках 
которых располагаются произвольные текстовые строки. Компонент находится на 
странице Additional. 

Таблица делится на фиксированную и рабочую. Фиксированная служит для 
показа заголовков строк (столбцов) и выделена темно-серым цветом; рабочая – это 
остальная часть таблицы. Если рабочая часть целиком не помещается в пределах 
окна, то в этом случае автоматически появляются полосы прокрутки. 

Основные свойства StringGrid: 

− FixedCol:integer – количество фиксированных столбцов 

− FixedRows:integer – количество фиксированных строк 
Если эти свойства равны 0, то таблица не содержит фиксированной части. 

Размер рабочей области (части) таблицы: 

− ColCount:integer – количество столбцов 

− RowCount:integer – количество строк 

− Cells:string – двумерный массив ячеек 
В массиве строки и столбцы нумеруются с 0. Массив ячеек включает фикси-

рованную и рабочую часть таблицы. К каждой ячейке можно обратиться  

Cells[<номер столбца>,<номер строки>]. 

 В ячейки можно записывать информацию, например:  
StringGrid1.Cells[0,0]=’ячейка с адресом 0, 0’; 

− При запуске программы содержимое ячеек таблицы можно редактировать. Для 
этого нужно задать свойство  

+Option – параметры 
 имеет +  - вложенные свойства 

GoEditiong – true (разрешено редактирвание ячеек) 
2. BitBtn – командная кнопка с изображением. Находится на странице Additional. 

Основные свойства BitBtn: 

− Caption – надпись 

− Kind=(bkOk, bkYes, bkCancel) – определяет стандартные кнопки 

− Glyph – определяет связанное с кнопкой изображение 
Пример. 1 Дан массив А, состоящий из элементов целого типа. Найти количество 

положительных элементов этого массива. 
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 Определим переменные задачи: 
Входные  данные: a[i,0]: целого типа  - элементы массива; n: целого типа – коли-

чество элементов массива. 
Промежуточные переменные: i: целого типа - параметр элемента, номер элемен-

та массива, изменяющийся с шагом 1;  
Выходные данные: k: целого типа – количество положительных элементов масси-
ва. 

 Решение данной задачи рассмотрим для цикла с параметром. Расположим 
следующие компоненты на окне формы. 

  

procedure TForm1.Button1Click( ); 
var n:integer; 
begin 
n:=strtoint(edit1.text); 
stringgrid1.ColCount:=n; 
stringgrid1.Visible:=true; 
end; 
procedure TForm1.BitBtn1Click( ); 
var 
 i,k:integer; 
 a:array[0..10,0..10] of integer; 
begin 
for i:=0 to n-1 do 
a[i,0]:=strtoint(stringGrid1.cells[i,0]); 
k:=0; 
for i:=0 to n-1 do 
 if a[i,0]>0 
  then k:=k+1; 
edit2.text:=inttostr(k); 
end; 

Блок-схема алгоритма и программа решения задачи с помощью цикла с пара-
метром следующие: 
Пример.2 В одномерном массиве  отрицательные элементы заменить на нуль. Вы-
вести полученный массив. 
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 Определим переменные задачи: 
Входные  данные: a[i,0]: целого типа  - элементы массива; n: целого типа – ко-

личество элементов массива. 
Промежуточные переменные: i: целого типа - параметр элемента, номер эле-

мента массива, изменяющийся с шагом 1;  
Выходные данные: k: целого типа – количество положительных элементов 

массива. 
 Решение данной задачи рассмотрим для цикла с параметром. Расположим 

следующие компоненты на окне формы. 

 

procedure TForm1.Button1Click(); 
var n:integer; 
begin 
n:=strtoint(edit1.text); 
stringgrid1.ColCount:=n; 
stringgrid1.Visible:=true; 
end; 
procedure TForm1.Button2Click(); 
var 
 i:integer; 
 a:array[0..10,0..10] of integer; 
begin 
for i:=0 to n-1 do 
a[i,0]:=strtoint(stringGrid1.cells[i,0]); 
for i:=0 to n-1 do 
 if a[i,0]<0 
  then 
    a[i,0]:=0; 
 stringgrid2.Visible:=true; 
 StringGrid2.ColCount:=n; 
for i:=0 to n-1 do 
StringGrid2.Cells[i,0]:=IntToStr(a[i,0]); 
end; 
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IV. МЕТОДИЧЕСКИЕ УКАЗАНИЯ ПО ВЫПОЛНЕНИЮ 

ЛАБОРАТОРНЫХ РАБОТ 

Задачей преподавателя при проведении лабораторных работ является гра-

мотное и доступное разъяснение принципов и правил проведения работ, побу-

ждение студентов к самостоятельной работе, определения места информатики в 

дальнейшей профессиональной работе будущего специалиста. 

Цель лабораторной работы – научить студентов самостоятельно произво-

дить  необходимые  действия для достижения необходимого результата. 

 Прежде чем приступить к выполнению лабораторной работы, студенту 

необходимо ознакомиться с теоретическим материалом, соответствующим дан-

ной теме. 

Выполнение лабораторной работы целесообразно разделить на  несколько 

этапов: 

• Формулировка и обоснование цели работы; 

• Определение теоретического аппарата, применительного к данной теме; 

• Выполнение заданий; 

• Анализ результата; 

• Выводы. 
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V. МЕТОДИЧЕСКИЕ УКАЗАНИЯ ПО ВЫПОЛНЕНИЮ 

ДОМАШНИХ ЗАДАНИЙ 

Внеаудиторная работа по информатике включает в себя: 

• Совершенствование и закрепление теоретических знаний, полученных на 

лекционных и лабораторных занятиях. Каждая тема курса включает вопросы 

входного контроля знаний (минимальный теоретический уровень), освоение 

которых необходимо для решения учебных задач, формирования умений и на-

выков темы. 

• Формирование навыков практической работы  - доведение умений до ав-

томатизма путем решения упражнений - заданий, требующее повторного вы-

полнения действий с целью его усвоения. 

• Выполнение творческих работ, предусмотренных рабочей программой 

(см. пункт самостоятельная работа студентов). 

При выполнении домашней работы студенты могут использовать различ-

ные источники приобретения информации: конспекты лекций, учебно-

методические материалы курса, ссылки на научную литературу в информаци-

онном пространстве Интернета и др.  
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VI. ПЕРЕЧЕНЬ ПРОГРАММНЫХ ПРОДУКТОВ, ИСПОЛЬЗУЕМЫХ 

ПРИ ПРЕПОДАВАНИИ ДИСЦИПЛИНЫ 

 

Наименование Год выпуска, разработ-

чик 

Примечание 

Total Commander 2004 Файловый менеджер 

(для windows) 

Far Manager 2006, Eugene Roshal and 

Far Group. 

Файловый менеджер 

(для DOS) 

Microsoft Office   2000, Microsoft Пакет прикладных про-

грамм 

Internet Explorer  2001, Microsoft Обозреватель Internet 

MathCad  2001, MathSoft, inc Математический пакет 

WinZip 2004 Архиватор 

WinRAR 3.2 2004 Архиватор 

Delphi for Object Pascal. 2000, Borland Delphi Система объектно-

ориентированного  про-

граммирования  

CorelDraw 2003, Corel inc  Графический пакет 

PhotoShop 2001, Adobe   Графический пакет 
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VII. КОМПЛЕКТ ЗАДАНИЙ ДЛЯ ЛАБОРАТОРНЫХ РАБОТ 

Тема: Компьютерная графика. 

Тема №1: Создание простейших изображений в графическом редакторе 

CorelDraw. 

Задания к лабораторной работе: 

В качестве отчетной работы требуется создать визитку с учетом основных 

правил подготовки изображений к печати в типографии и вывести на лист А4 

при помощи автоматического расположения на листе. 

1. Создание визитки 

− Устанавливаем размер листа под размер визитки (90х50) 

− Заполняем документ содержимым (в данном случае это несколько надписей 

и растровая картинка) 

− Важно! Видимую рамку к визитке делать нельзя, т.к. из-за погрешностей при 

обрезке рамка будет иметь неодинаковую толщину или с каких-то сторон ее 

не будет вообще. 

− Сохраняем документ. 

В результате получаем: 

 
2. Подготовка к печати 

− Входим в «print preview» 

− В режиме «Imposition layout tool» выбираем нужное число копий по верти-

кали и горизонтали. 
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− В режиме «Marks placement tool» устанавливаем метки для обрезки 

 
− Теперь, если нужно, такой стиль оформления можно сохранить (file => save 

frint style as…). Документ готов к печати. 

Тема №2: Создание простейших изображений в графическом редакторе Pho-

toShop. 

Задания к лабораторной работе: 

1. Создание контурного и обведенного текста. 

Инструмент Type (Текст) обладает незначительными возможностями соз-

дания контуров. Невозможно задать толщину обводки, нельзя выбрать режим 
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наложения или установить величину непрозрачности. Обычно для ввода и об-

водки текста перед импортом в Photoshop используют программу типа 

Illustrator. Если это невозможно, то для создания контуров воспользуйтесь ко-

мандой Stroke (Выполнить обводку) меню Edit (Редактирование). 

Прозрачный текст с цветным контуром можно создать, выполнив следую-

щие действия: 

1. Выберите инструмент Type Mask (Текст-маска) и щелкните на открытом 

изображении или на новом слое, в котором хотите поместить текст. 

2. Введите текст. Оставьте выделенную область ак-

тивной для выполнения последующих действий. 

3. Задайте желаемый цвет контура. 

4. В меню Edit (Редактирование) выберите команду 

Stroke (Выполнить обводку) и введите необходимые зна-

чения. 

Для создания окрашенного текста, контур которого имеет другой цвет, вы-

полните следующие действия: 

1. Задайте основной цвет, соответствующий цвету текста. 

2. Выберите инструмент Type (Текст), щелкните на 

новом слое и введите требуемый текст. 

3. Выполните Select → Load Selection, чтобы выделить текст по контуру и 

склейте слои (Ctrl + E). 

4. Задайте основной цвет, соответствующий цвету обводки. 

5. В меню Edit (Редактирование) выберите команду 

Stroke (Выполнить обводку) и введите необходимые значе-

ния. 

2. Пламя. 

Нам потребуется однослойное изображение - белая надпись на черном фо-

не. Удобнее всего использовать режим серых полутонов. 

Эффект пламени более выразителен на широком светлом 
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шрифте без засечек. Можно применить и массивный шрифт, обведя буквы по 

контуру. 

Первый этап состоит в применении фильтра Wind, вызываемого через ме-

ню Filter → Stylize. Перед вызовом эффекта ветра надо 

повернуть изображение на 90o по часовой стрелке (коман-

да Image → Rotate Canvas → 90o CW), поскольку в фильтре Wind нет верти-

кального направления ветра. Мы включим направление From the right, а силу 

ветра оставим минимальную - Wind. Чтобы следы ветра получились более 

мощными, можно применить фильтр несколько раз подряд, нажав клавиши Crtl 

+ F. После чего возвращаем изображение в нормальное положение командой 

меню Image → Rotate Canvas → 90o CCW. 

Придадим надписи и языкам ветра рваную форму, более соответствующую 

пламени. Для этого воспользуемся фильтром Diffuse, вызвав его через то же 

меню Filter → Stylize и установив режим Normal. 

Далее применим фильтр Gaussian Blur при небольшом радиусе. В данном 

случае он составил 1.3 пиксела. Усилим дрожание с по-

мощью фильтра Ripple (рябь), который вызывается через 

меню Filter → Distort. Зададим амплитуду (Amount) по-

рядка 80 - 100, да и длина волны пусть будет небольшой, выберем Small или 

Medium. 

На последнем этапе надо перевести изображение из черно-белого полуто-

нового в индексированный цвет Image → Mode → Indexed Color. Изменить па-

литру изображения с индексированным цветом можно с 

помощью команды меню Image → Mode → Color Table. 

Редактор Photoshop предлагает несколько заранее подго-

товленных палитр, из которых выберем Black Body. 

3. Лед. 

Создадим новое изображение и напишем на нем текст черным цветом. За-

тем выполним Select → Load Selection и Layer → Flatten Image. 
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Выполним команду Select → Inverse, и применим фильтр Filter → Pixelate 

→ Crystallize с коэффициентом кристаллизации равным 8. 

Опять выполняем команду Select → Inverse, и приме-

няем фильтр Filter → Noise → Add Noise с коэффициентом шума около 70 

(включите Distribution: Gaussian). 

Размываем избражение фильтром Filter → Blur → Gaussian Blur с коэффи-

циентом размывки около 2. Затем отменяем выделение Select → None и исполь-

зуем фильтр Filter → Blur → Blur. 

Выполняем команду Image → Adjust → Invert (Ctrl + I). 

Повернем изображение Image → Rotate Canvas → 90 

CW. Затем применяем фильтр Filter → Stylize → Wind (Method: Wind, Direction: 

From the left) и возвращаем картинку в горизонтальное положение Image → Ro-

tate Canvas → 90 CCW. 

Придадим изображению цвет льда с помощью команды Image → Adjust → 

HueSaturation (Включите Colorize, установите параметр Hue в положение - 181, 

а Saturation - 80). 

Добавим искрящиеся блики с помощью дополнительных кистей. В меню 

Brushes (Кисти) выберите команду Load Brushes (Загрузить 

Кисти) и откройте файл assorted.abr из подкаталога Brushes. 

Установите текущим белый цвет и нанесите искорки на не-

которые выступающие льдинки. 

4. Золотая надпись. 

Создаем новый белый лист. Переходим в палитру каналов и, нажав на 

кнопку внизу этой палитры, создаем канал #4. Его фон должен быть черным, а 

текст белым. Пишем текст. Этот эффект наиболее выразителен при использова-

нии крупных символов. 

Активизируем единственный слой Background он дол-

жен быть белым. Маску из канала #4 загружаем в окно ре-

дактора комбинацией клавиш [Ctrl]+[Alt]+[4]. Закрашиваем ее черным. Залить 
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маску основным цветом можно клавишами [Alt]+[Del]. Выключаем маску, на-

жав [Ctrl]+[D]. 

Надпись на слое Background надо растушевать с помощью гауссового 

фильтра (Filters → Blur → Gaussian Blur). Радиус в 3 пиксела. 

Переименуем этот слой. Щелкните дважды мышкой по пиктограмме слоя 

Background в палитре слоев. Затем необходимо продублировать слой. Для этого 

перетащите мышкой в палитре слоев дублируемый слой на кнопку создания 

нового. 

Слои надо сдвинуть друг относительно друга (Filter → Other → Offset). 

Для одного из слоев набираем два положительных смещения на 4 пиксела, а 

для другого - два отрицательных по 4 пиксела. 

Для верхнего из слоев (Layer 0 copy) режим наложе-

ния заменяем с Normal на Difference (разница). Теперь 

слои объединяем в один [Ctrl]+[Е].  

Нажав комбинацию клавиш [Ctrl]+[М], Вам надо по-

пытаться воспроизвести кривую, подобную той, что на ил-

люстрации. 

Загружаем маску #4 командой меню Select → Load 

Selection, затем маску инвертируем [Ctrl]+[Shift]+[I]. Убедившись, что маска 

включает в себя не надпись, а фон вокруг нее (об этом свидетельствует бегущая 

штриховая линия по краю окна редактора), нажмите клавишу [Del]. 

Нажимаем [Ctrl]+[D] и [Ctrl]+[I] - инвертирование. 

Создаем новый слой (цветной) Слой1. Подбираем ему из 

каталога золотистый цвет. Делаем заливку [Ctrl]+[Del]. Де-

лаем для Слой0 цветность. 

Надо объединить слои в срезаемую группу. Получаем ее, щелкнув мышкой 

при нажатой клавише [Alt] по линии, разделяющей слои в палитре Layers. 

Создаем новый слой Слой2, делаем его цветным. В ката-

логе выбираем черный цвет и нажав [Ctrl]+[Del] заливаем. 

Расположите слои в такой последовательности: слой1, слой2, слой0. 
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5. Эффект «X-Files». 

Создайте новое изображение RGB с чёрным фоном. Напишите ваш текст. 

Далее необходимо объединить слои (Ctrl + E). Теперь, откройте палитру Кана-

лы (Window → Show Channels); переместите любой из каналов к значку новый 

канал. Это создаст новый канал. Откройте двойным щелчком мыши свойства 

этого канала и переименуйте его в «оригинал». 

Перетащите канал «оригинал» к значку нового канала и сделайте дубликат. 

Дважды щелкните на новом канале, и переименуйте его в «белый». Затем нажав 

Ctrl + щелчок мыши на канале, загрузите его в выделение. Те-

перь мы немного расширим его. Используйте Select → Modify 

→ Expand со значением 1 пиксела. Далее выполните Edit → Fill 

use: white. Снимите выделение Select → Deselect и выполните размывку Filter 

→ Blur → Gaussian Blur с радиусом равным 2. 

Перетащите канал «белый» к значку новый канал, чтобы у нас получился 

ещё один канал. Дважды щёлкните на образовавшемся канале, и 

переименуйте его в «жёлтый». Ctrl + щелчок, чтобы загрузить в 

выделение. Опять, Select → Modify → Expand со значением 2. За-

полните белым цветом, снимите выделение и примените фильтр Filter → Blur 

→ Gaussian Blur с радиусом 3. 

Последний канал мы получим следующим образом - перетащите канал 

«желтый» к значку новый канал. Переименуйте его в «зелёный», 

Ctrl + щелчок; расширьте на 4. Заполните белым, снимите выде-

ление, размойте с радиусом 7 пикселов. 

Переключитесь на канал RGB. Выполните Select → Load Selection и выбе-

рите там канал «зелёный». Теперь выберите подходящий зеленый 

цвет, например R:0 G:255 B:0. И выполните заливку Edit → Fill 

use: Foreground Color. 

Сделайте тоже самое для канала «жёлтый», но с использова-

нием цвета R:128 G:255 B:0. Теперь тоже самое сделайте для ка-
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нала «белый», используя белый цвет. Загрузите «оригинал», выполните Select 

→ Modify → Contract установка - 1 пиксел и залейте черным Edit → Fill use: 

black. 

Тема: Операционная оболочка Total Commander. 

Задания к лабораторной работе: 

1. На диске С: создать два каталога DOG и GRAND. 

2. В каталог DOG создайте файл dogovor.txt, содержащий текст: 

ДОГОВОР №1 

Данный договор составлен 10.10.2000 год. 

3. Скопируйте файл dogovor.txt в каталог GRAND. 

4. Переименовать в каталоге GRAND файл dogovor.txt на dogovor1.txt. 

5. В файле dogovor1.txt исправить число 10.10.2000 на 10.12.2002. 

6. Перенести файл dogovor1.txt в каталог DOG с именем itog.txt. 

7. Просмотреть содержимое файла itog.txt. 

8. Переименовать каталог DOG в DATA. 

9. В корневом каталоге диска C: создать каталог с именем BLANK. 

10. В каталоге BLANK создать файл doc1.txt, содержащий текст: Программа-

оболочка – это программа, один из модулей которой, называемый резидент-

ным, постоянно находится в оперативной памяти компьютера.  

11. Скопировать файл doc1.txt в файл doc2.txt каталога BLANK. 

12. Переименовать в каталоге BLANK файл doc2.txt в файл otchet.txt. 

13. Добавить в файл otchet.txt следующий текст: Оболочки позволяет эффективно 

работать с файловой системой  дисков, а также запускать программы на ис-

полнение. 

14. В корневом каталоге диска С: создать каталог KONTORA. 

15. Перенести каталог BLANK в каталог KONTORA. 

16. Скопировать одновременно все файлы из каталога DOG в BLANK. 

17. В каталоге BLANK поместить файлы в архивный файл paper.rar одновременно 

уничтожив исходные файлы. 

18. Извлечь файлы из архива paper.rar в каталог DATA. 
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19. Осуществить поиск файлов doc2.txt и dogovor1.txt.  

Тема: Операционная система Windows. 

Тема №1: Рабочий стол Windows. Работа с окнами 

Задания к лабораторной работе: 

1. Познакомьтесь с элементами Рабочего стола: значками объектов Win-

dows и Панелью задач. 

2. Отработка приемов работы с мышью: 

− Выделить значок Мой компьютер. 

− Переместить значок в новое место Рабочего стола (Если перетаскивание не 

удается, то вызвать контекстное меню Рабочего стола отменить режим 

«Упорядочивать» – «Автоматически»). 

− Вернуть значок на место. 

− Снять выделение со значка Мой компьютер. 

− Открыть Главное меню кнопкой Пуск. 

− Определить текущую дату, применив прием зависания к индикатору часов на 

Панели задач. 

− Определить установленную раскладку клавиатуры, вызвав контекстное меню 

индикатора языка на Панели задач и выбрав в меню пункт Свойства. 

3. На Рабочем столе создать с помощью мастера ярлыки для приложений 

MS Word и MS Excel.  

4. Знакомство с элементами окна: 

− Открыть окно папки «Мой компьютер» и познакомиться с элементами окна. 

− Развернуть окно на весь экран; восстановить размер окна; свернуть окно; 

развернуть окно; закрыть окно. 

− Открыть окна папок «Мой компьютер» и «Корзина». 

− Изменить размеры окон таким образом, чтобы они не перекрывали друг дру-

га. 

− Закрыть окна. 

5. Установить шлейф для мыши. 
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6. Включить заставку: ОБЪЕМНЫЙ ТЕКСТ, текст «ТУРИСТ», параметры: 

стиль движения «Волны», шрифт – Arial. 

7. Просмотреть предлагаемые рисунки и узоры Рабочего стола и устано-

вить наиболее понравившийся. 

8.  Установить новые свойства у Панели задач: 

− раскрыть окно свойств Панели задач вызвав ее контекстное меню и выбрав в 

меню пункт Свойства; 

− снять флажок отображения часов; 

− установить флажок Автоматически убирать с экрана; 

− проверить установленные свойства; 

− восстановить прежнее значение измененных свойств. 

9. Изучить свойства клавиатуры: 

− в Панели управления открыть окно Клавиатура; 

− установить комбинацию клавиш Ctrl+Shift для переключения между рус-

ским и английским языками; 

− отключить индикатор раскладки клавиатуры; 

− проверить установленные свойства;  

− восстановить прежние значения свойств. 

10.  Изучить свойства Корзины: 

− раскрыть окно Свойства корзины; 

− выбрать закладку Глобальные; 

− изменить значения свойства Уничтожать файлы  сразу, не помещая их в кор-

зину; 

− изменить значения свойства Запрашивать подтверждение на удаления; 

− проверить установленные свойства; 

− восстановить прежнее значение измененных свойств. 

11. Очистить список документов в Главном меню. 

12. Создать в Главном меню новый пункт, запускающий программу Блок-

нот. 
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13. Удалить из Главного меню пункт Блокнот. 

Тема №2: Стандартные программы. Работа с папками и файлами 

Задания к лабораторной работе: 

1. Записать в тетради перечень стандартных программ Windows. 

2. Записать в тетради назначение программы «Блокнот». 

3. Запустить программу «Блокнот». 

4. Ввести текст: «Текст вводится с помощью буквенно-цифровых клавиш. 

Для ввода прописных букв используется  одновременное нажатие клавиши 

Shift для ввода длинной последовательности прописных букв клавиатуру мож-

но переключить с помощью клавиши Caps Lock. Для переключения между рус-

скими и английскими символами используется индикатор языка на Панели за-

дач, или специальная комбинация клавиш, установленная на Вашем компьюте-

ре. Обычно это комбинация клавиш Alt+Shift или Ctrl+Shift.» 

5. Свернуть окно программы «Блокнот» на Панель задач. 

6. Записать в тетради назначение программы WordPad. 

7. Запустить программу WordPad. 

8. Ввести текст: «Для выделения фрагмента текста необходимо нажать ле-

вую кнопку мыши на начале фрагмента и, удерживая ее, переместить указатель 

мыши в конец выделяемого фрагмента. Необходимый фрагмент выделится 

черным цветом». 

9. С набранным текстом проделать следующую работу: 

− Вставить набранный текст в конец документа два раза; 

− Выделить первый абзац и задать для него следующие параметры: шрифт – 

Arial, размер шрифта – 16, цвет шрифта – зеленый, тип шрифта – полужир-

ный курсив; 

− Выровнять первый абзац по левому краю, второй абзац – по центру, третий 

абзац – по правому краю. 

10. Свернуть окно программы WordPad на Панель задач. 

11. Записать в тетради назначение программы Paint. 

12. Запустить программу Paint. 
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13.  Нарисовать следующий рисунок 

 
14. Свернуть окно программы Paint на Панель задач. 

15. Открыть папку «Мой компьютер» и перечислить находящиеся в ней объ-

екты. 

16. Изменить несколько раз размеры и расположение значков файлов и папок. 

17. На диске С: создать папки Филолог, Литература,Все . 

18. В папке Филолог создать папки Повесть, Рассказ, Роман. 

19. Развернуть программу «Блокнот» и сохранить текст с именем Записки в 

папке Повесть. 

20. Развернуть программу «WordPad» и сохранить текст с именем Тезис в 

папке Рассказ. 

21. Развернуть программу «Paint» и сохранить рисунок с именем Разбор в 

папке Роман. 

22. Скопировать папку Филолог в папку Литература. 

23. Скопировать папку Литература на диск А:. 

24. Переместить на диске С: папку Литература в папку Филолог. 

25.  Переименовать на диске С: папку Литература на Все. 

26.  Удалить папку Все. 

27.  Восстановить папку Все. 

28.  Выделить папку Все и посмотреть, сколько места на диске она занимает. 

Заархивировать папку Все в архив Общие.rar. 

29.  Сравнить занимаемое место на диске архивом Общие.rar с первоначаль-

ным объемом папки Все. На сколько уменьшился объем занимаемого места на 

диске? 

30.  Разархивировать архив Общие.rar. 

Тема №3: Программа «Поиск». Программа «Проводник» 

Задания к лабораторной работе: 

1. Организовать поиск файлов по Имени и размещению: 
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− найти на диске С: все файлы с расширением .tmp (*.tmp); 

− найти на диске С: все файлы с расширением .bmp (*.bmp); 

− найти все файлы с однобуквенными именами и расширениями (?.?); 

2. Организовать поиск файлов по Дате изменения: 

− найти на диске С: файлы, созданные с 1.10.2000 по сегодняшний день; 

− найти на диске С: файлы, созданные с 1.10.2004 по 15.07.2005; 

− найти на диске С: файлы, созданные за последний месяц; за последние два 

месяца; за последний день; за последние три дня; 

3. Используя вкладку Дополнительно найти файлы типа Точечный рисунок 

BMP. На каком диске вы провели поиск? Полученный список файлов предста-

вить в виде таблицы и отсортировать его по размеру. Просмотреть самый 

большой рисунок. 

4. Найти на диске С: все текстовые файлы, содержащие слово «Windows». 

5. Найти на диске С: все Текстовые документы, содержащие слово 

«windows», но не  «Windows». Для этого необходимо отменить режим Пара-

метры → С учетом регистра. Открыть один из найденных файлов и найти в 

нем указанное слово. 

6. Запустить программу «Проводник». 

7. Измените Вид правой панели с помощью меню. 

8. Свернуть все папки, щелкая по значкам « – » на дереве папок в левой 

панели программы. 

9. Показать в правой части содержимое диска С: и при помощи контекст-

ного меню создать на диске С: папку Европа. 

10. Развернуть в правой части диск С: чтобы увидеть созданную папку. 

11. Открыть папку Европа в правой части Проводника. 

12. Создать в папке Европа папку Россия. 

13. В папке Россия создать текстовый документ Записки1 и точечный ри-

сунок Записки2. 

14. Правой кнопкой мыши переместить их в папку Европа. 

15. Скопировать файл Записки2 в папку Россия. 
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Тема: Текстовый процессор Word. 

Тема №1: Создание текстового документа. 

Задания к лабораторной работе: 

1. Запустить текстовый процессор MS Word. 

2. Изучить структуру окна редактора и назначение его основных элементов 

(строка заголовка; кнопки управления окном Свернуть, Развер-

нуть/Восстановить, Закрыть; строка меню; панели инструментов; линейка; 

рабочая область; полосы прокрутки; строка состояния; рамка). 

3. Набрать следующий текст с соблюдением вышеуказанных правил: 

Морфема – это самая маленькая значимая часть слова. Самая главная морфе-

ма – это корень, несущий основной смысл слова. Остальные морфемы, несущие 

«смыслиночки», — приставка, суффикс, окончание – называются аффиксами. 

Слово морфема ввел в науку ученый-лингвист Бодуэн де Куртенэ. Вы, конеч-

но, помните, что он же дал звуку-смыслоразличителю имя – фонема. 

От слова морфема образовалось слово морфология. Это раздел грамматики, 

изучающий, как изменяется слово.  

В России каждый человек имеет имя, отчество и фамилию. А в других стра-

нах у людей нет отчества, зато иногда бывает по два имени (и даже больше). На-

пример, великого австрийского композитора Моцарта звали Вольфганг Амадей, а 

известного комического актера кино Чаплина — Чарльзом Спенсером. 

А теперь вспомните сами, какие имена носил всеми любимый сказочник 

Андерсен (Ганс Христиан). Как у людей бывают вторые имена, так у некоторых 

морфем бывают вторые названия. 

4. Сохранить документ с именем «Морфема». 

5. Завершить работу с MS Word. 

Тема №2: Форматирование текстов. 

Задания к лабораторной работе: 

1. Загрузить MS Word. 

2. Установить поля станицы: верхнее – 2 см, нижнее – 2 см, левое – 3 см, 

правое – 1 см. 
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3. Напечатать следующий текст без форматирования символов: 

Тема – объективная основа произведения 

В «бесконечном лабиринте сцеплений», в многоуровневом поэтическом кос-

мосе художественного целого все образующие его элементы подчинены друг дру-

гу, иерархически упорядочены. Как и любая система, литературное произведение 

имеет свой центр (один или несколько) и свою периферию. Ядром художествен-

ной системы, ее признанным «руководящим центром» принято считать так назы-

ваемое идейно-тематическое содержание. Неразрывное единство темы и идеи со-

ставляет экстракт объекта и субъекта творчества, предмета искусства и его автор-

ского осознания, распространяющий свое влияние на все остальные элементы сис-

темы. 

Художественный космос литературного произведения сродни государствен-

ному устройству. Он может напоминать и монархию (чаще всего), как абсолют-

ную, так и конституционную, и олигархию, и демократию, и партократию, и охло-

кратию, и федерацию, и конфедерацию… Наверное, только не анархию, ибо ос-

новным цементирующим принципом построения произведения является принцип 

художественной целесообразности, т.е. строгий порядок. 

Обрусевшее древнегреческое слово thema обозначает буквально «то, что по-

ложено» (в основу чего-либо). Тема – объективная основа произведения, понятие, 

указывающее самых общих чертах на преимущественное внимание писателя к оп-

ределенной стороне действительности и отвечающее на вопрос «Что изображе-

но?». Внешним образом тема – это то, о чем произведение, чему оно посвящено, 

что прежде всего бросается нам в глаза. 

Писатель не может и не должен замахиваться на отображение всей реальной 

действительности, которая его окружает. Он сосредоточивается на некой ее части, 

совершив первый этап своего творческого акта – художественный отбор. Катего-

рия темы, следовательно, помогает определить то, что непосредственно изображе-

но в произведении, сориентироваться в его содержании, очертить круг жизненных 

явлений, отобранных, отображенных и воспроизведенных автором. 

Иногда приходится сталкиваться с весьма распространенным отождествлени-

ем темы и проблемы, вернее – с подменой одного понятия другим. Именно так 
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трактовал тему в своем популярном учебнике по введению в литературоведение 

Г.Л. Абрамович. Предложенное им определение «Тема – проблема, поставленная 

писателем в произведении» вызывает сомнение по крайней мере в двух аспектах. 

Во-первых, тема и проблема совпадают только частично. Понятие темы зна-

чительно шире понятия проблемы. Та или иная проблема (нравственная, социаль-

но-политическая, философская, религиозная) может стать темой лишь в произве-

дениях соответствующего масштаба и предназначения (в романах, повестях, тра-

гедиях, комедиях, драмах, поэмах). 

Во-вторых, понятие проблемы не должно подменять собой понятие темы, по-

скольку в нем нередко содержится, кроме объективной констатации того или ино-

го жизненного факта, и субъективно, личностно окрашенное отношение к нему 

писателя, т.е. некоторый отблеск идеи. 

Итак, тема есть проблема, явление или предмет, отобранный, осмысленный, 

домысленный и воспроизведенный определенными художественными средствами; 

часть действительности или ее аналог, уже преображенные в перл создания. 

4. Отформатировать 1 абзац: шрифт – Arial, размер – 24, видоизменение слов 

«идейно-тематическое содержание» – К, интервал после – 16 пт, межстрочный ин-

тервал – одинарный, выравнивание – по центру, цвет шрифта – красный, перед аб-

зацем вставить символ - . 

5. Отформатировать 2 абзац: шрифт – Book Antiqua, размер – 15, видоизме-

нение слов «государственному устройству» – подчеркнутый, отступ слева – 1,5 см, 

отступ справа – 1 см, отступ первой строки – 1,25 см, интервал перед – 3 пт, ин-

тервал после – 8 пт, межстрочный интервал – полуторный, выравнивание – по ле-

вому краю, цвет шрифта – зеленый. 

6. Отформатировать 3 абзац: шрифт – Monotype Corsiva, размер - 20, видоиз-

менение слов «thema», «то, что положено», «в основу чего-либо», «то, о чем», 

«чему оно посвящено» – К, отступ слева – 1 см, отступ справа – 1 см, отступ пер-

вой строки – 1,27 см, межстрочный интервал – двойной, выравнивание – по пра-

вому краю, цвет шрифта – синий, разбить на две колонки. 
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7. Отформатировать 4 и 5 абзацы: видоизменение слов «тема и проблема 

совпадают только частично», «понятие проблемы не должно подменять собой по-

нятие темы» – К. 

8. Отформатировать 8 абзац: шрифт – Times New Roman, размер – 16, видо-

изменение слов «тема», «проблема», «явление», «предмет» – Ж, отступ слева – 0 

см, отступ справа – 0 см, отступ первой строки – 1,5 см, межстрочный интервал – 

двойной, выравнивание – по ширине, цвет шрифта – синий. 

9. Отформатировать заголовок документа: начертание – ЖК, отступ перед – 

Авто, отступ после – Авто, размер – 30, цвет – желтый. 

10. Скопировать первые два абзаца в конец документа и разбить скопирован-

ный текст следующим образом: одно предложение – один абзац. 

11. Автоматически пронумеровать страницы документа: номер на первой 

странице не ставить, выравнивание от центра, внизу. 

12. Вставить в документ колонтитул: верхний колонтитул – ФИО, выравнива-

ние – по правому краю, нижний – автоматическая вставка даты создания докумен-

та, выравнивание – по центру. 

13. Проверить документ на наличие орфографических ошибок. 

14. Установить автоматическую расстановку переносов. 

15. Вставить из Коллекции картинок любую из понравившихся. 

16. Изобразить следующий заголовок с помощью инструмента Word Art: 

 
17. Изобразить следующую надпись к заголовку: 

 
18. Отредактировать рисунок следующим образом: 

 

Заголовок текста 
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19. Набрать следующий текст: 

Слово, как известно, является основной единицей языка, самым заметным 

элементом его художественных средств. И выразительность речи связана прежде 

всего со словом. Многие слова обладают способностью употребляться в несколь-

ких значениях. Это их свойство называется многозначностью, или полисемией. 

Писатели находят в многозначности источник яркой эмоциональности, живости 

речи. Например, в тексте может быть повторено многозначное слово, которое, од-

нако, выступает в разных значениях: Поэт издалека заводит речь, поэта далеко за-

водит речь (М. Цветаева). 

20. Установить для первой буквы первого слова абзаца буквицу: шрифт – 

Arial, положение – в тексте, высота в строках – 5. 

21.  Вставить перед текстом (задание 7) заголовок «Лексические средства 

выразительности речи» и установить для него эффект «Мигающий фон». 

22. Сохранить документ с именем «Тема». 

Тема №3: Создание таблиц и схем. 

Задания к лабораторной работе: 

1. Вставить таблицу любым из перечисленных способов, содержащую 10 

строк и 9 столбцов. 

2. Объединить ячейки следующим образом: 

 
3. Вставить перед таблицей заголовок «Согласные звуки русского языка»: 

 Заголовок текста 
изменен 
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шрифт – Monotype Corsiva, размер – 16, начертание - Полужирный курсив. 

4. Заполнить таблицу следующим образом. Обратите внимание на выравни-

вание текста в ячейках таблицы. 

Место образования 

губные переднеязычные средне-
язычные 

задненебные Способ образо-
вания губно-

губные 
губно-
зубные

зубные передне-
небные 

средне-
небные 

средне-
небные 

задне-
небные 

ф в 
Ф’ в’ 

c з 
с’ з’ 

ш ж 
ш’ ж’ 

 х’ у’ х у 
срединные 

   jָ j   

Щ
ел
ев
ы
е 

боковые 
лָ л 
лָ’ л’ 

 

носовые мָ м 
мָ’ м’ 

нָ н 
нָ’ н’ 

 нг 

дрожащие рָ р 
рָ’ р’  

 

взрывные п б 
п’ б’ 

т д 
т’ д’ 

 к’ г’ к г 

С
мы

чн
ы
е 

аффрикаты ц дз 
ц’ д’з’ 

ч дж 
ч’ д’ж’ 

 

5. Оформить таблицу следующим образом. 

 
6. Изобразить следующий объект. Самостоятельно задать цветовую гамму 

его элементам. 

 

Зеленый 

Желтый 

Серый 
Оранжевый 

Цвет внутренней линии и рамки - синий 
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Тема №4: Списки, стили, оглавления. 

Задания к лабораторной работе: 

1. Набрать следующий перечень (каждое слово на новой строке): сущест-

вительное, прилагательное, наречие, глагол. Выделить текст и оформить его в 

виде Нумерованного списка с помощью кнопки . 

2. Набрать следующий перечень (каждое слово на новой строке): Пушкин, 

Лермонтов, Некрасов, Толстой. Выделить текст и оформите его в виде Марки-

рованного списка с помощью кнопки . 

3. Изменить нумерованный список: нумерация начинается с 5,  нумерация 

– один, два, ….  

4. Изменить маркированный список: знак маркера – . 

5. Набрать следующий текст без соблюдения начертания (каждая фраза с 

новой строки): Введение в информатику, Краткая история развития инфор-

мационных технологий, Введение, Информация, Понятие информации, Ин-

формационные системы, Системы счисления, Понятие системы счисления, Не-

позиционные системы счисления, Позиционные системы счисления, Представ-

ление информации в компьютере, Общие сведения, Формы и коды представле-

ния данных в памяти ЭВМ, Технические средства информационных техно-

логий, Компьютер, Базовая структура персонального компьютера, Устройства 

ввода-вывода, Программное обеспечение компьютера, Компьютерные сети, 

Локальные компьютерные сети, Глобальные компьютерные сети. 

6. Создать следующий многоуровневый список: 

Речь 

1 предложение 3 предложение 
2 предложение 

слово

слово

слово

слово слово

слово

слово

слово

слово
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− Уровень 1: Формат номера – Глава, нумерация – 1, 2, 3 ..., начать с – 1; По-

ложение номера: Выравнивание – по левому краю; Отступ – 0,5 см; От но-

мера до текста – 0 см. Шрифт – Полужирный. 

− Уровень 2: Формат номера – 1.1., нумерация – 1, 2, 3 ..., начать с – 1; Поло-

жение номера: Выравнивание – по левому краю; Отступ – 1 см; Шрифт – 

Обычный. 

− Уровень 3: Формат номера – 1.1.1., нумерация – 1, 2, 3 ..., начать с – 1; По-

ложение номера: Выравнивание – по левому краю; Отступ – 1,5 см; Шрифт – 

Курсив.  

7. Применить к набранному тексту созданный список следующим образом: 

первая трока – заголовок текста (выравнивание – От центра, начертание – По-

лужирный курсив); текст, выделенный жирным шрифтом – Уровень 1; под-

черкнутый текст – Уровень 2; текст, выделенный курсивом – Уровень 3.  

8. Набрать следующий текст: 

А. Пушкин  

Тиха украинская ночь. Прозрачно небо,  

Звезды блещут. 

Своей дремоты превозмочь 

Не хочет воздух. 

Я. Некрасов 

Быстро лечу я по рельсам чугунным, 

Думаю думу свою. 

Б. Пастернак 

Мело, мело по всей земле во все пределы. 

Свеча горела на столе, свеча горела. 

М. Лермонтов 

Горные вершины спят во тьме ночной. 

Тихие долины полны свежей мглой. 

С. Маршак 

Вокруг белеющих прудов 
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Кусты в пушистых полушубках, 

И проволока проводов 

Таится в белоснежных трубках. 

9. Применить стиль Заголовок1 к фамилиям А. Пушкин, Я. Некрасов, Б. 

Пастернак. 

10. Создать новый стиль: имя – Поэт, основа на стиле – Заголовок1, стиль 

следующего абзаца – обычный. Форматирование: шрифт – Monotype Corsiva, 

размер – 14, начертание - Полужирный курсив, выравнивание – От центра, 

межстрочный интервал – двойной. 

11. Применить стиль Поэт к фамилиям М. Лермонтов, С. Маршак. 

12. Разбить текст на страницы таким образом, чтобы каждый автор начи-

нался на новой странице. 

13. На последней странице вставить оглавление. 

14. Сохранить документ с именем «Стили». 

Тема №5: Язык и статистика: редактирование формул. 

Задания к лабораторной работе: 

1. Вставить в документ формулы согласно варианту, указанному препода-

вателем. 

Вариант 1. 
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Вариант 3. 
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2. Отредактировать формулу. Изменить размер. 

3. Сохранить документ с именем «Формула». 

Тема: Электронная таблица Excel. 

Тема №1: Знакомство с электронной таблицей   

Задания к лабораторной работе: 

1. Запустить табличный процессор MS Excel.  

2. Выделить: 
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− Строки 5, 6, 9, 13. Снять выделение. 

− Столбцы В, C, F, G, K. Снять выделение. 

− Совокупность строк 1, 3, 6, 7, 10, 11 и столбцов B, D, G, H, I.  Снять выделе-

ние.  

− Блок ячеек B5: F10. 

− Совокупность блоков A1:C4, B6:E12, G8:H10. 

3. Вставьте два новых листа перед рабочим листом Лист3, используя оба 

способа.  

4. Переименовать Лист1 в Глагол; Лист2 в Наречие. 

5. Поменять местами листы Глагол и Наречие.  

6. Создать копии рабочих листов Глагол и Наречие.  

7. Удалить копии листов Глагол и Наречие.  

8. Сохранить рабочую книгу с именем «Части речи». 

Тема №2: Создание простейшей таблицы. Ввод и редактирование данных. 

Формат данных.  

Задания к лабораторной работе: 

1. В ячейку А1 внести слово Литература. 

2. Создайте ниже приведенную таблицу. 
№ п/п ФИО Дата рождения Век 

 Пушкин А.С. 6.06.1799  
 Гоголь Н.Ф. 1.04.1809  
 Лермонтов М.Ю. 3.10.1814  
 Толстой Л.Н. 28.08.1828  
 Блок А.А. 28.11.1880  
 Маяковский В.В. 7.07.1893  
 Чернышевский Н.Г. 24.07.1829  
 Горький А.М.  16.03.1868  
 Достоевский Ф.М. 11.11.1821  

3. С помощью автозаполнения заполнить первый столбец таблицы таким 

образом: 1 автор, 2 автор, 3 автор и т.д.  

4. Самостоятельно определить век, в котором родился каждый автор, и за-

полнить соответствующий столбец. 

5. Отредактировать в ячейке А1 слово Литература на Русская литерату-

ра.  
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6. После четвертой строки вставить пустую строку и заполнить ее таким 

образом: ФИО – Цветаева М.И., Дата рождения – 26.09.1892. 

7. Вставить между столбцами ФИО и Год рождения новый столбец – Про-

изведение и заполнить его самостоятельно. 

8. В столбце Дата рождения изменить формат представления информации 

на Дата, обозначение – 6 марта 1982 г (пример).  

9. Сохранить документ с именем «Таблица». 

Тема №3: Адресация. Вычисления в таблицах. 

Задания к лабораторной работе: 

1. В одном из опытов изучались частоты частей речи в прозе К. Федина. 

Было взято 10 выборок по 500 знаменательных слов каждая. В выборки вклю-

чалась только авторская художественная речь. Были получены следующие вы-

борочные частоты имен существительных и имен прилагательных: 

Проза К.Федина 

Частоты выборок (xi) Части речи 
1 2 3 4 5 6 7 8 9 10 

Ср. 
частота

Существительное 182 187 218 173 158 201 222 233 213 194  
Прилагательное 69 71 83 60 43 73 72 59 69 71  
Глагол 95 87 94 104 100 112 83 91 105 108  

− На Листе1 создать приведенную выше таблицу. 

− Переименовать Лист1 в Средняя. 

− Найти среднюю частоту выборки для каждой части речи по формуле 

n

x
x

n

i
i∑

== 1 , где n – количество выборок (наблюдений). Сделать вывод. 

2. Переименовать Лист2 в Отклонение. 

3. На листе Отклонение создать приведенную ниже таблицу и найти от-

клонение выборочных частот от средней частоты σ для каждой части речи по 

формуле 
n

a
n

i
i∑

== 1

2

σ , где xxa ii −= . 
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Выборочные частоты, их отклонение от средней частоты и квадраты 
этих отклонений 

Существительное Прилагательное Глагол Выборки 

ix  ia  2
ia  ix  ia  2

ia  ix  ia  2
ia  

1-ая          
2-ая          
…          
Сумма          
x     
σ    

4. Переименовать Лист3 в Предложения. 

5. На листе Предложения создать таблицу сравнения количества предло-

жений текста некоторого объема у различных авторов.  

Автор Количество предложений Сравнение 
Толстой Л.Н. 358  
Чернышевский Н.Г. 226  
Макаренко А.С. 345  
Новиков Н.И. 289  
Одоевский В.Ф. 456  
Горький А.М. 384  
Достоевский Ф.М. 267  
Общее количество   
Среднее количество   
Максимальное количество   
Минимальное количество   

− Найти общее количество предложений. 

− Найти минимальное количество предложений по всем авторам. 

− Найти максимальное количество предложений по всем авторам. 

− Найти среднее количество предложений по всем авторам. 

− Используя функцию ЕСЛИ определить «выше» или «ниже» среднего нахо-

дится количество предложений текста каждого автора. 

6. Сохранить документ с именем «Язык и статистика». 

Тема №4: Сортировка данных и форматирование таблиц.  

Задания к лабораторной работе: 

1. Запустить MS Excel. 
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2. Открыть файл Язык и статистика.xls. 

3. К таблице на листе Средняя применить следующие атрибуты форматирования: 

− выравнивание; 

− шрифты; 

− цвет фона; 

− ширина столбцов и высота строк; 

− рамка. 

5. К таблице на листе Отклонение применить стиль автоформатирования – 

Классический 2. 

6. На листе Предложения создать три копии таблицы (на этом же листе). 

7. К каждой таблице на листе Предложения применить стили автоформатиро-

вания – Цветной 1, Цветной 2, Цветной 3. 

8. На листе Предложения отсортировать первую таблицу – столбцу Количест-

во предложений, вторую таблицу – по столбцу Автор. 

9. Сохранить рабочую книгу с именем «Язык и статистика (формат)». 

Тема №5: Графический анализ данных.  

Задания к лабораторной работе: 

1. По имеющимся данным: «за» – 7 чел., «против» – 11 чел., «воздержа-

лось» – 2 чел., построить круговую объемную диаграмму, отражающую про-

центное соотношение результатов голосования. Цвета секторов – красный, си-

ний и зеленый соответственно.  

2. По данным таблицы построить различные типы диаграмм, отображаю-

щих: 

− долю каждого наименования в первом предложении; 

− динамику изменения количество подлежащих во всех предложениях; 

− сравнение общего числа наименований для всех предложений; 

− сравнение количества сказуемых в первом, третьем и пятом предложениях. 
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Наименование 1 предложе-
ние 

2 предложе-
ние 

3 предложе-
ние 

4 предложе-
ние 

5 предложе-
ние 

6 предложе-
ние 

Подлежащее 11 12 12 15 17 19 
Сказуемое 15 21 20 20 17 19 
Деепричастие 23 29 32 34 30 33 
Итого       

3. Создать следующую таблицу и выполнить к ней задания. 
Факультет 
Группа 

1 курс 2 курс 3 курс 4 курс 5 курс Макс. 
кол-во 

Миним. 
кол-во 

Среднее 

ФПИ 75 68 68 62 56    
ФМО 60 58 55 57 49    
ФФ 100 91 92 85 69    

− вычислить максимальное, минимальное и среднее количество студентов по 

отдельным факультетам; 

− построить диаграмму, отображающую сравнение количества студентов на 

разных курсах по факультету ФФ (круговая или кольцевая); разместить диа-

грамму на текущем листе; на диаграмме должен быть отображен заголовок, 

подписи данных, легенда. 

Тема: Электронные презентации PowerPoint. 

Задания к лабораторной работе: 

1. Вставить любым способом пять пустых слайдов. 

2. Применить ко всем слайдам способ заливки – текстура (любую понра-

вившуюся). 

3. Для первого слайда выбрать автомакет – титульный слайд. Применить 

к нему следующее оформление: 

− Текст заголовка – РУССКИЙ ЯЗЫК, шрифт – Mono-

type Corsiva размер – 80, цвет – синий, начертание – 

жирный. 

− Текст подзаголовка – ИМЯ СУЩЕСТВИТЕЛЬ-НОЕ, 

шрифт – Arial, размер – 0, цвет – красный, начертание – полужирный курсив, 

тень. 
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4. Для второго слайда выбрать автомакет – 

только заголовок и набрать приведенный текст (см. 

слайд). Применить к нему следующее оформление: 

шрифт – Arial. размер – 46, цвет: слово «существи-

тельное» – красный, остальной текст – черный; на-

чертание: слово «существительное» – жирный, остальной текст – обычный. 

Весь текст находится внутри рамки (см. слайд), цвет заливки рамки – светло 

голубой.  

5. Для третьего слайда автомакет – 

схема и оформить его следующим обра-

зом (см. слайд). Цвет заливки элементов 

схемы – светло зеленый, цвет шрифта 

для «имя существительное» - темно си-

ний, остальной текст - черный. Обрати-

те внимание на начертание некоторых слов. 

6. Для четвертого слайда выбрать автома-

кет – заголовок и маркированный текст и на-

брать приведенный текст (см. слайд). Цвет за-

головка – синий, «ь» в заголовке и по тексту 

маркированного списка выделен красным цве-

том. Обратите внимание на начертание некото-

рых слов. 

7. Для пятого слайда выбрать ав-

томакет – заголовок и таблица и на-

брать приведенный текст (см. слайд). 

Цвет заголовка – красный. Обратите 

внимание на начертание некоторых 

слов. 
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8. Вставить на первом слайде в верхний левый угол следующую картинку 

(если таковой не окажется в списке картинок, то можно вставить 

любую другую). 

9. Задать для созданных слайдов различную анимацию и смену 

слайдов. 

10. Установить для слайдов следующие управляющие кнопки: 

− первый слайд:  – далее и  – в конец; 

− последний слайд:  – в начало; 

− остальные слайды:  – далее. 

11. Осуществить показ созданной презентации. 

12. Сохранить презентацию с именем слайды.pps. 

Тема: СУБД Access. 

Тема №1: Создание таблиц базы данных. 

Задания к лабораторной работе: 

1. Загрузите Access, в открывшемся окне Microsoft Access щелкните селектор-

ную кнопку Новая база данных, затем - кнопку OK. 

2. В открывшемся окне Файл новой базы данных в поле Имя файла: введите 

имя Кафедра, в раскрывающемся списке поля Папка: выделите свою папку на 

диске С:, затем закройте окно, щелкнув кнопку Создать. Создаваемая база дан-

ных будет находиться в вашей папке на диска D:. 

3. В основном окне базы данных Кафедра: база данных выберите вкладку Таб-

лицы и щелкните кнопку Создать. 

4. В открывшемся окне Новая таблица выберите пункт Конструктор и щелк-

ните кнопку OK. В результате откроется окно Таблица1: таблица в режиме 

Конструктор, в котором определите поля таблицы согласно Таблице 3.  

Для этого: 

− введите в строку столбца Имя поля имя Код преподавателя, 

− поместите курсор в строку столбца Тип данных, раскройте список и выберите 

в нем слово Счетчик. В строку столбца Описание можно ничего не вводить, 
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− аналогично определите другие имена и тип данных полей таблицы, 

− в нижней части таблицы Свойства поля во вкладке Общие установите ука-

занные в Таблице 1 размеры полей, предварительно поместив курсор на со-

ответствующую запись (строку) в верхней части таблицы. 

Таблица 1. Структура таблицы данных Преподаватели 

Имя поля Тип данных Размер поля 
Код преподавателя Счетчик  
Фамилия Текстовый 15 
Имя Текстовый 15 
Отчество Текстовый 15 
Должность Текстовый 9 
Дисциплина Текстовый 11 
Зарплата Денежный  

5. Сохраните созданную таблицу под именем Преподаватели. 

6. На запрос о задании ключевых полей ответьте Нет. 

7. Вернемся к таблице Преподаватели в режиме Конструктор. Если ее нет на 

экране, то активизируйте вкладку Таблицы и откройте ее. 

8. В верхней части таблицы щелкните по записи Должность. 

9. В нижней части окна Свойства поля во вкладке Общие щелкните по строке 

параметра Условие на значение и установите ограничения на данные, которые 

будут вводиться в поле Должность: должны вводиться только слова Профессор, 

Доцент или Ассистент. Для этого: 

− щелкните по кнопке , чтобы открыть окно Построитель выражений, 

− в открывшемся окне введите слово Профессор, щелкните по кнопке , до-

бавьте Доцент, снова щелкните по кнопке , затем добавьте Ассистент и 

закройте окно, щелкнув кнопку ОК. 

− в строке параметра Сообщение об ошибке введите сообщение: Такой долж-

ности нет, 

− в строке параметра Значение по умолчанию введите Доцент.  

10. Введите ограничения на данные в поле Код преподавателя. С одной сторо-

ны эти данные не должны повторяться, а с другой - должна быть обеспечена 

возможность их изменения. Поэтому в этом поле нельзя использовать тип дан-

ных Счетчик, т.к. значения таких полей обновлять нельзя. Для выполнения 
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второго условия задайте тип данных Числовой. А для выполнения первого ус-

ловия выполните следующее: 

− щелкните по строке параметра Индексированное поле, 

− раскройте список и выберите пункт Да (совпадения не допускаются), 

− перейдите в режим Таблица, щелкнув кнопку  слева на панели инстру-

ментов и при запросе на сохранение щелкните кнопку Да. 

11. В режиме Таблица заполните таблицу данными о преподавателях в соответ-

ствии с Таблицей 2 и проверьте реакцию системы на ввод неправильных дан-

ных в поле Должность, введя, например, слово Лаборант. 

Таблица 2. Таблица данных Преподаватели 

Код Фамилия Имя Отчество Должность Дисциплина Зарплата 
1 Куклев Федор Петрович Доцент Информатика 9800 р. 
2 Максимов Никита Юрьевич Профессор Экономика 14500 р. 
3 Андреев Борис Сергеевич Доцент Статистика 7600 р. 
4 Лидский Виктор Борисович Профессор Математика 12500 р. 
5 Колосов Алексей Ивановна Доцент Математика 8900 р. 
6 Беляев Виктор Павлович Ассистент Информатика 3900 р. 
7 Максимов Иван Николаевич Доцент Информатика 8900 р. 

12. Измените ширину поля Дисциплина в соответствии с шириной данных, 

предварительно переведя курсор в любую строку данного поля и используя ко-

манду Формат/Ширина столбца... - кнопка По ширине данных. 

13. Произведите поиск преподавателя Максимова, для чего поместите курсор в 

первую строку под именем поля Фамилия и выберите команду Правка/Найти.... 

14. В открывшемся диалоговом окне Поиск в поле: Фамилия в поле Образец: 

введите Максимов, в поле Просмотр: выберите Все, в поле Совпадения: выбе-

рите С любой частью поля, у опции Только в текущем поле установите флажок 

и щелкните кнопку Найти. Чтобы найти следующую запись, щелкните кнопку 

Найти далее. Затем щелкните кнопку Закрыть. 

15. Измените заработную плату ассистенту Беляеву с 3900руб. на 4300руб., для 

чего поместите курсор в первую строку поля Зарплата и выберите команду 

Правка/Заменить.... 

16. В открывшемся диалоговом окне Замена в поле: Зарплата в поле Образец: 

введите 3 900р., в поле Заменить на: введите 4 300р., в поле Просмотр: выбери-
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те Все, у опции Только в текущем поле установите флажок и щелкните кнопку 

Найти далее. Когда запись будет найдена, щелкните кнопку Заменить. Затем 

щелкните кнопку Закрыть. 

17. Произведите сортировку данных в поле Зарплата по убыванию, используя 

команду Записи/Сортировка/Сортировка по убыванию (предварительно помес-

тив курсор на любую запись данного поля). 

18. Произведите фильтрацию данных сначала по полю Должность (например, 

профессор), затем – Дисциплина (например, математика), используя команду 

Записи/Фильтр/Фильтр по выделенному (предварительно поместив курсор на 

соответствующую запись данного поля). После выполнения окончательной 

фильтрации удалите фильтр командой Записи/Удалить фильтр. 

19. Просмотрите, как созданная таблица будет выглядеть на листе бумаги при 

печати, используя команду Файл/Предварительный просмотр. 

20. Закройте таблицу Преподаватели, щелкнув кнопку . 

21. Создайте в базе данных Кафедра таблицу Студенты. Для этого: 

− в окне базы данных выберите вкладку Таблицы и щелкните по кнопке Создать; 

− в открывшемся окне Новая таблица выберите пункт Конструктор и щелкните 

по кнопке ОК; 

− создайте структуру таблицы Студенты: определите ее имена полей, тип дан-

ных и свойства полей в соответствии с Таблицей 3; 

− в качестве ключевого поля определите поле Код студента, для чего активизи-

руйте это поле и щелкните по кнопке ; 

− закройте таблицу, задав ей имя Студенты. 

Таблица 3. Структура таблицы данных Студенты 

Имя поля Тип данных Размер поля 
Код студента Числовой Целое 
Фамилия Текстовый 15 
Имя Текстовый 15 
Отчество Текстовый 15 
Номер группы Числовой Целое 
Телефон Текстовый 9 
Стипендия Логический Да/Нет 

22. Аналогично создайте структуру таблицы Дисциплины, определив ее имена 



 161

полей, тип данных и свойства полей в соответствии с Таблицей 4, а ключевым 

выбрав поле Код дисциплины. 

Таблица 4. Структура таблицы данных Дисциплины 

Имя поля Тип данных Размер поля 
Код дисциплины Числовой Целое 
Название дисциплины Текстовый 30 

23. Создайте в базе данных Кафедра структуру таблицы Оценки, определив ее 

имена полей, тип данных и свойства полей в соответствии с Таблицей 5. На во-

прос о создании ключевого поля ответьте Нет. 

Таблица 5. Структура таблицы Оценки 

Имя поля Тип данных Размер поля 
Код студента Числовой Целое 
Код дисциплины Числовой Целое 
Оценки Числовой Байт 

24. В базе данных Кафедра измените структуру таблицы Преподаватели, доба-

вив в нее поле Код дисциплины и определив его тип данных и размер в соот-

ветствии с данными Таблицей 4. 

25. Закройте таблицы Преподаватели, Дисциплины, Оценки и Студенты, если 

они открыты. 

26. Щелкните по кнопке  на панели инструментов (или выполните команду 

Сервис/Схема данных). На экране откроется окно Добавление таблицы. 

27. В открывшемся окне будет выделено название одной таблицы. Щелкните по 

кнопке Добавить. 

28. Переведите выделение на имя следующей таблицы и щелкните по кнопке 

Добавить. Аналогично добавьте оставшиеся две таблицы. 

29. Закройте окно, щелкнув по кнопке . 

30. Создайте связь между таблицами Дисциплины и Оценки. Для этого подведи-

те курсор мыши к полю Код дисциплины в таблице Дисциплины, щелкните ле-

вой кнопкой мыши и, не отпуская ее, перетащите курсор на поле Код дисцип-

лины в таблицу Оценки, а затем отпустите кнопку мыши. На экране откроется 

окно Связи. 

31. Установите флажок («галочку») в свойстве Обеспечение целостности дан-
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ных, щелкнув по нему. 

32. Установите флажок в свойстве Каскадное обновление связанных полей и 

Каскадное удаление связанных полей. 

33. Щелкните по кнопке Создать. Связь будет создана. 

34. Аналогично создайте связи между полями Код дисциплины в таблице Дис-

циплины и полем Код дисциплины в таблице Преподаватели, а также между 

полем Код студента в таблице Студенты и полем Код студента в таблице 

Оценки. 

35. Закройте окно схемы данных, ответив Да на вопрос о сохранении макета. 

Тема №2: Работа с формами. 

Задания к лабораторной работе: 

1. В окне базы данных Кафедра: база данных активизируйте вкладку Формы и 

щелкните кнопку Создать. 

2. В открывшемся окне Новая форма выберите Мастер форм, а в нижней части 

окна раскройте список и выберите таблицу Преподаватели, затем нажмите 

кнопку OK. 

3. В открывшемся окне Создание форм из поля списка Доступные поля пере-

ведите в поле списка Выбранные поля те, которые будут присутствовать в 

форме. В данном случае это все поля, поэтому щелкните по кнопке  и 

нажмите кнопку Далее. 

4. В следующих окнах Мастера форм выберите соответственно внешний вид 

формы в один столбец, затем требуемый стиль оформления и далее задайте 

имя форме Состав преподавателей. 

5. После нажатия кнопки Готово откроется форма в один столбец. 

6. Найдите запись о доценте Максимове, для чего сначала переведите курсор в 

первую строку поля Фамилия, затем выполните команду Правка/Найти. 

7. Переведите курсор в первую строку поля Зарплата и, используя команду 

Правка/Заменить..., повысьте зарплату ассистенту с 4300руб. на 4500руб.  

8. Произведите сортировку поля Фамилия по убыванию командой Запись/ 

Сортировка/Сортировка по убыванию, предварительно поместив курсор в 
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любую запись данного поля. 

9. Поместив курсор на запись Доцент поля Должность командой Запись/ 

Фильтр/Фильтр по выделенному, оставьте в таблице только записи о препо-

давателях - доцентах. 

10. Аналогичной процедурой оставьте в таблице только записи о преподавате-

лях – доцентах по дисциплине информатика. 

11. Удалите фильтр командой Записи/Удалить фильтр. 

12. Теперь измените название поля Дисциплина на Преподаваемая дисциплина. 

Для этого: 

− перейдите в режим Конструктор, щелкнув кнопку  слева на панели ин-

струментов, 

− щелкните правой кнопкой мыши в поле Дисциплина (оно слева), 

− в контекстном меню выберите пункт Свойства, 

− в открывшемся окне свойств поля Дисциплина в строке Подпись вместо 

Дисциплина введите Преподаваемая дисциплина, 

− для просмотра результата перейдите в режим Форма. 

13. Просмотрите, как данная форма будет выглядеть на листе бумаги. 

14. Закройте форму Состав преподавателей, щелкнув кнопку . 

Тема №3: Формирование запросов и отчетов для отдельных таблиц базы 

данных. 

Задания к лабораторной работе: 

1. На основе таблицы Преподаватели создайте простой запрос на выборку, в 

котором должны отображаться фамилии, имена, отчества преподавателей и их 

должность. Для этого: 

− откройте вкладку Запросы и в открывшемся окне щелкните по кнопке Соз-

дать, 

− в окне Новый запрос выберите пункт Простой запрос и нажмите кнопку ОК, 

− в открывшемся окне Создание новых запросов в строке Таблицы/запросы 

выберите таблицу Преподаватели, а в поле списка Доступные поля выдели-
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те слово Фамилии и щелкните по кнопке  для перевода его в поле Вы-

бранные поля, 

− аналогично переведите туда поля Имя, Отчество, Должность и щелкните 

по кнопке Далее, 

− в строке параметра Задайте имя запроса введите имя Должности препода-

вателей и щелкните по кнопке Готово. 

2. В открывшейся таблице с результатами запроса отсортируйте по убыванию 

данные по полю Должность. 

3. Сохраните запрос. 

4. Создайте новый запрос под именем Преподаваемые дисциплины на выборку 

с параметром, в котором должны отображаться фамилии, имена, отчества пре-

подавателей и преподаваемые ими дисциплины, а в качестве параметра задайте 

фамилию преподавателя и выполните этот запрос для преподавателя Лидского. 

Для этого: 

− создав аналогично предыдущему пункту запрос под именем Преподаваемые 

дисциплины, перейдите в режим Конструктор, 

− в строке параметра Условия отбора для поля Фамилия введите фразу: [Вве-

дите фамилию преподавателя], 

− выполните запрос командой Запрос/Запуск, 

− в открывшемся окне введите фамилию Лидский и щелкните по кнопке ОК. 

5. Сохраните запрос и закройте окно запроса. 

Тема: Основы программирования в Delphi. Знакомство с компонента-

ми Standard. 

Задания к лабораторной работе: 

1. Составьте программу, которая при выборе соответствующей командной 

кнопки, изменяет: 

а) цвет формы на голубой, фиолетовый, серый; 

б) текстовую надпись на "Язык программирования", "Система программиро-

вания", "Алгоритм"; 
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в) размер формы на "крупный" (600*800), "средний" (400*600), "мелкий" 

(200*400); 

г) вид панели "выпуклая", "вдавленная", "отсутствует"; 

д) видимость – невидимость текстовой надписи. 

2. Создайте окно сообщения: 

а) об условии задачи; 

б) о назначение компонентов при щелчке мыши на данном компоненте. 

Тема: Линейная структура. 

Задания к лабораторной работе: 

1. Производственная функция Кобба-Дугласа имеет вид: P=5*L0,4*K0,6, где 

P-объем продукции, L-затраты труда, K-величина капитала. Составить про-

грамму вычисления объема продукции. 

2. Объем V выработки молока фермерского хозяйства описывается моде-

лью: Vt0 (1997) = 5,6*e3(t-t0) . Составить программу вычисления V в году t. 

3. Спрос на получения кредита S (руб.) семьи в год для семьи со среднеме-

сячный доход семьи на одного человека D (руб.) и  количество детей в семье m  

описывается моделью: S = 3,4+5m +4,3LnD. Составить программу вычисления 

спроса. 

4. Для вклада S руб. под n% годовых рассчитать сумму через год.  

5. Программа вычисления стоимости телефонного разговора. Запрашивает 

стоимость минуты  и длительность разговора, а затем вычисляет стоимость раз-

говора.  

6. Для суммы S (руб.) делается скидка n%. Рассчитать скидку в руб. и сум-

му оплаты. 

Тема: Оператор ветвления. 

Задания к лабораторной работе: 

1. Вычислить Y – размер ВВП страны в зависимости от: 

а – индекса расходов на сельское хозяйство к бюджету страны (от 0 до 1) 

b – индекса расходов на промышленность к бюджету страны (от 0 до 1) 
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z – индекс расходов на образование к общему бюджету страны (от 0 до 1) 

x =a-b – разница индексов расходов на сельское хозяйство и промышленность 
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2. Даны x, y, z. Составить программу нахождения максимального элемента 

A max (x+y+z, 3x, y-4z) F min (sin(x2+y2), tg(z), x/y) 

B min (x2+y2, |z|, xyz). G max (5x2-4y2), ey , ln|x/2|) 

C max (x2+y2-z2, xyz, (x-y)4) I max (sin(x+y), tg(10-2z), 6y3) 

D min (|x+y|, (z/x)2, 45/x3) J max (ln|x-y|, tg(z), x/y). 

E min (sin(x+y), 5-6y, tg(z)) K max (sin(x-y), tg2(z), x/y). 

3. Напишите программу расчета скидки на покупку.  Если сумма покупки 

составляет более 500 р., то покупателю предоставляется скидка n%.  

4. Некоторый товар можно приобрести в трех торговых точках. В каждом 

магазине известна цена товара S1, S2, S3 и предоставляемые скидки r1, r2, r3. 

Найти минимальную цену с указанием магазина. Вывести реальную цену по-

купки в каждом магазине.  

Тема: Оператор выбора. 

Задания к лабораторной работе: 
1. Составить программу, в которой вывод данных отображается включени-
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ем радиокнопки: 
а) Человек в течение своей жизни проходит несколько возрастных этапов 

(младенец, ребенок, подросток, …). Требуется по введенному количеству лет 
определить возрастной промежуток для данного возраста. 

б) В пятиэтажном доме на первом этаже 3 квартиры, на следующих этажах 
по четыре квартиры. Нумерация квартир с 1 по 19. Требуется по номеру квар-
тиры указать номер этажа, на котором она расположена. 

в) По введенному номеру месяца выделить номер квартала. 
г) По введенному количеству лет вывести возможные виды кредита: 

до 1 года – экспресс-кредитование;  
до 5 лет – кредит на неотложные нужды; 
до 15 лет – ипотечное кредитование. 

Для предлагаемого кредита в TMemo выводятся условия его получения. 
д) Средний ежеквартальный расход электроэнергии  - P кВ/час. При этом: 
в 1 квартале расход на 15% выше среднего, 
во 2 и 4 квартах  - на 5% выше среднего, 
в 3 квартале  - на 8% ниже среднего. 

Вводится номер квартала. Выделяется корректирующий сезонный процент и 
вычисляется расход электроэнергии в данном квартале. 

2. Составить программу, в которой ввод данных осуществляется выделе-
нием строки списка. 

а) Для выбранного дня недели вывести часы приема врача: 
 понедельник 8-00 – 10-00 
 вторник 11-00 – 13-00 
 среда 9-00 - 11-00 
 четверг 8-00 – 10-00 
 пятница 11-00 – 13-00 
 суббота 9-00 - 10-00 
 воскресенье выходной. 
б) Программа – киноафиша: на экране список фильмов, при нажатии на 

одно из названий, появляется время сеансов.  
в) Для выбранного автомобиля вывести данные мощности двигателя. 
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г) Оклад служащего составляет X рублей. Для выбранного района (цен-
тральный, дальневосточный, северный) вычисляется з/плата. Выводится про-
центная надбавка (0%, 50%, 100%) и зарплата за месяц. 

д) Напишите программу расчета стоимости телефонного разговора. Из-
вестно, что тариф днем, вечером и на выходных разный. 

День – 100% 
Вечер – скидка 20% 
Ночь – скидка 50%. 
Пользователь вводит количество минут и стоимость 1 минуты разговора, 

выбирает в списке строк категорию времени, получает результат - стоимость 
разговора. Результат вывести в TListBox. 

е) Для суммы S в списке радиокнопок выбирается вид вклада («Пенсион-
ный» - 17% годовых, «До востребования» - 3% годовых, «Молодежный» - 14% 
годовых и др.). Указать сумму вклада через один, два, три года с учетом начис-
ляемых процентов. 

ж) Составьте программу стоимости услуг парикмахерской. Пользователь в 
предложенном списке строк выбирает вид услуги, после нажатия «ОК» высве-
чивается стоимость услуги. Предусмотреть флажок «Скидка», для утренних 
клиентов 5%. 

Тема: Циклические структуры. 

Задания к лабораторной работе: 
1. Начальный объем выпуска предприятия составляет S ед. Ежегодное уве-

личение выпуска составляет  k%  к предыдущему году.  Рассчитать предпола-
гаемый выпуск предприятия на t лет вперед и суммарный выпуск предприятия. 

2. Объем продажи авиабилетов в 2002 г. составил Х тыс. ед. Ежегодный  
темп прироста составляет n%. Рассчитать объем продажи до 2005 г. и средний 
ежегодный объем продаж. 

3. В магазине №1 спрос на хозяйственные товары в 2001 г. составил m тыс. 
руб. Ежегодный прирост n%. Рассчитать спрос на 3 года вперед и средний 
спрос. 
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4. Объем продажи авиабилетов в 1 квартале 2002 г. составил Х тыс. ед. 
Ежеквартальный темп прироста составляет n%. Рассчитать объем продажи до 
конца 2002 г. и средний ежеквартальный объем продаж. 

5. Человек открыл счет в банке S руб. под n% годовых. Начисление про-
центов происходит в конце года. Рассчитать сумма вклада на 3 года вперед и 
среднее значение вклада за 3 года. 

6. Первоначальная стоимость основного фонда предприятия составляет S 
млн. руб. Амортизация в год составляет n%: ежегодная стоимость уменьшается 
на n%. Рассчитать стоимость основного фонда предприятия на t лет вперед. 

7. Для кредита на сумму S на t лет  под n% годовых рассчитать сумму вы-
плат: погашение основного кредита + выплата процентов. Известно, что сумма 
основного долга выплачивается равными долями ежемесячно, ежемесячный 
процент n/12 рассчитывается на оставшуюся сумму долга. Указать общую сум-
му выплаты и сумму переплаты по отношению к начальной сумме. 

8. В 1 квартале 2000 г. цена на телевизор «SAMSYNG-2536NY» составила 
х тыс. руб. Ежеквартальное увеличение цены составляет n%.  Вычислить еже-
квартальный спрос на TV -  у единиц, если y=3,4*x0,4. 

9. Начальный объем выпуска предприятия составляет S ед. Ежегодное уве-
личение выпуска составляет  k%  к предыдущему году: St = St-1 *k.  Рассчитать 
предполагаемый выпуск предприятия на t лет вперед. 

10. Для кредита на сумму S на t лет  под n% годовых рассчитать сумму вы-
плат: погашение основного кредита и выплата процентов. Известно, что сумма 
основного долга выплачивается равными долями ежемесячно, ежемесячный 
процент n/12 рассчитывается на оставшуюся сумму долга. 

11. Первоначальная стоимость основного фонда предприятия составляет S 
млн. руб. Амортизация в год составляет n%: ежегодная стоимость уменьшается на 
n%. Рассчитать стоимость основного фонда предприятия на t лет вперед. 

Тема: Работа с массивами. Компонент TStringGrid. 

1. Для вектора объема продаж квартир А (2000-2004 гг.) найти: 

− среднегодовой объем продаж квартир; 

− максимальный объем продаж и номер года максимального объема продаж; 

− количество лет, в которых объем продаж квартир был ниже среднего; 
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− получить новый вектор, как разница между максимальным объемом и те-
кущим годовым. 

2. Для вектора расходов на оплату услуг мобильной связи В (2001-2005 гг.) 
найти: 

− суммарный расход за 2001 – 2005 гг.; 

− минимальный расход и номер года минимального расхода; 

− количество лет, в которых расход был выше минимального; 

− получить новый вектор, как процент текущего года от суммы. 
3. Для вектора доходов от реализации Интернет-услуг С (2001-2005 гг.) най-

ти: 

− суммарный доход за 2001 – 2005 гг.; 

− максимальный и минимальный доход; 

− количество лет с доходом выше ј суммы доходов за 2001-2005 гг.; 

− получить новый вектор, в котором значения лет с доходом ниже ј суммы 
доходов за 2001-2005 гг. заменить нулями. 

4. В векторе объема удоя молока фермерского хозяйства А (2000-2004 гг.) 
найти максимальное значение. Указать количество максимальных элементов и го-
да их встречи. 

5. В векторе объема продаж мороженного С (2000-2004 гг.) найти среднего-
довое значение. Получить новый вектор как разницу между средним и текущим 
годом. 

6. Для вектора выпуска бытовой техники А (2000-2004 гг.) найти года выпус-
ка, значения которых больше среднего. 

7. В векторе спроса на ЭКСПЕРЕСС-кредит С (2000-2004 гг.) найти суммар-
ное и максимальное значения. Указать процент максимального значения от сум-
марного. 

8. Для вектора объема сбора урожая В (1995-2004гг.) найти средние значения 
XX(1995-2000 гг.) и ХХI(2001-2004 гг.)  и указать в каком веке наибольшее. 

9. Для вектора В (1999-2004гг.) найти разницу между минимальным и макси-
мальным значениями. Указать год с минимальным значением. 

10. Для вектора объема продаж авиабилетов  А (2000-2002 гг.) получить но-
вый вектор как разницу между объемом 2000 г. и текущим годовым значением. 
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VIII. КОМПЛЕКТ ЗАДАНИЙ ДЛЯ КОНТРОЛЬНЫХ РАБОТ 

Тема: Единицы измерения информации. 

1. В документе 60 строк по 60 символов. Каков размер данного текстового 

файла? 

2. Какое количество страниц неформатированного текста можно поместить на 

дискету емкостью 1,44 Мбайт? 

3. Сколько «весит» фраза «Мороз и солнце – день чудесный», если сохранить 

ее в текстовом файле? 

4. Сколько составляет размер текстового файла, содержащего только слово 

«информатика»? 

5. Разрешающая способность дисплея равна 640×200 пикселей. Для размеще-

ния одного символа в текстовом режиме используется матрица 8×8 пиксе-

лей. Какое максимальное количество текстовых строк может быть размеще-

но на экране? 

6. Решите систему уравнений (найти x, y). В ответе необходимо указать еди-

ницы измерения. 

⎩
⎨
⎧

=

=−

байт24
Кбайт725

14x
xy

. 

7. Одна страница книги содержит 25 строк по 80 символов. В книге 300 стра-

ниц. Каков объем информации необходим для хранения книги? 

8. Один музыкальный файл занимает 6 Кб на диске. Сколько файлов можно за-

писать на CD-диск объемом 600 Мб.  

Тема: Системы счисления. 

1) Перевести двоичное число вовсе известные вам системы счисления: 

а) 1001011101 

б) 10110001111 

в) 1111011010 

г) 1111100001 

д) 100011100011 

е) 10001101001 

ж) 111100000111111 

з)10101100110101 

и) 1111000111110101 

к) 10101101011010101 
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2) Перевести восьмеричное число вовсе известные вам системы счисления: 

а) 526 

б) 457 

в) 562 

г) 125 

д) 443 

е) 361 

ж) 777 

з) 1267 

и) 6375 

к) 774527 

3) Перевести десятичное число вовсе известные вам системы счисления: 

а) 58 

б) 96 

в) 129 

г) 345 

д) 789 

е) 953 

ж) 1283 

з)  1892 

и) 5638 

к) 105896 

4) Перевести шестнадцатеричное число вовсе известные вам системы счисле-

ния: 

а) 1А 

б) 26 

в) 3AF 

г) C45 

д) D56 

е) AFD 

ж) 4A5F 

з)  9E6CA 

и) ABC5F 

к) 48FF56A 

Тема: Компьютерная графика. 

Создать иллюстрированный материал по одной из тем: 

− рекламный проспект; 

− билет в театр (цирк, кинотеатр, музей); 

− визитная карточка некоторой организации. 

Тема: Операционная оболочка Total Commander. 

1. В корневом каталоге диска С: создать каталог ORBITA. 

2. В каталоге ORBITA создать каталог KOSMOS. 

3. В каталоге ORBITA создать текстовый файл paloma.txt. 

4. Скопировать в каталоге ORBITA файл paloma.txt в файл stih.txt. 
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5. Файлы каталога ORBITA скопировать в каталог KOSMOS. 

6. На диске А: создать каталог NEBO. 

7. Скопировать каталог KOSMOS в каталог NEBO. 

8. Переименовать в каталоге NEBO каталог  KOSMOS на LUNA. 

9. Осуществить на диске С: поиск файлов, начинающихся на букву «t», имею-

щих в расширении два символа. 

Тема: Операционная система Windows. 

1.  На диске С: создайте текстовый файл Сервис, содержащий следующий текст: 

«Сжатие информации — это процесс преобразования информации, храня-

щейся в файле, к виду, при котором уменьшается избыточность в ее пред-

ставлении и соответственно требуется меньший объем памяти для хранения». 

2.  На диске С: создайте папку ТУРИСТЫ. 

3.  В этой папке создайте текстовой файл Отдых, содержащий следующий 

текст: «Архивный файл — это специальным образом организованный файл, 

содержащий в себе один или несколько файлов в сжатом или несжатом виде 

и служебную информацию об именах файлов, дате и времени их создания 

или модификации, размерах и т.п.» 

4. В папке ТУРИСТЫ создать папку ОТЕЛЬ. 

5. В папке ОТЕЛЬ создайте текстовый документ Люкс, содержащий следующий 

текст: «Архивация (упаковка) — помещение (загрузка) исходных файлов в 

архивный файл в сжатом или несжатом виде». 

6. Для папки ТУРИСТЫ создать ярлык на Рабочем столе. 

7. Открыть документ Сервис и добавить в него следующий текст: «Разархива-

ция (распаковка) — процесс восстановления файлов из архива точно в таком 

виде, какой они имели до загрузки в архив. При распаковке файлы извлека-

ются из архива и помещаются на диск или в  оперативную память». 

8. Скопируйте документ Сервис в папку ОТЕЛЬ и переименовать его в файл 

Реклама. 
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Тема: Табличный процессорWord. 

− Все задания делать на отдельной странице.  

− Каждая страница должна начинаться с заголовка «Задание № …», оформ-

ленного стилем Заголовок2. 

− Проставить номера страниц: вверху страницы, справа, номер на первой 

странице не ставить. Расставить колонтитулы: на первой странице – Кон-

трольная работа, на четной странице – ваша фамилия, на нечетной странице 

– «Документ Word».  

− В конце документа вставить оглавление. 

1. Напечатать приведенный ниже текст, выполняя задания: 

ЛЕКСИЧЕСКИЕ СРЕДСТВА ВЫРАЗИТЕЛЬНОСТИ РЕЧИ 
Лексика, несомненно, занимает центральное место в системе образных 

средств языка. 

Слово, как известно, является основной единицей языка, самым заметным 

элементом его художественных средств. Выразительность речи связана прежде 

всего со словом. Многие слова обладают способностью употребляться в не-

скольких значениях. Это их свойство называется многозначностью, или поли-

семией. 

Писатели находят в многозначности источник яркой эмоциональности, 

живости речи. Например, в тексте может быть повторено многозначное слово, 

которое, однако, выступает в разных значениях: Поэт издалека заводит речь, 

поэта далеко заводит речь (М. Цветаева). 

Задание: 

 Заголовок выровнен по центру, шрифт – Monotype Corsiva, размер – 14, 

начертание – Полужирный. Все буквы прописные. 

 Основной текст выровнен по ширине, шрифт – Arial, размер – 12. 

 Разбить второй абзац на шесть колонок, а третий – на восемь. 

2. Создать приведенный ниже многоуровневый список, соблюдая все элементы 

форматирования: 
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Программирование на Visual Basic. 

Введение 

Урок 1. Основные элементы языка 

I.1.   Первая программа 

I.2.   Типы данных 

  ♥ Константы 

  ♥ Переменные величины 

I.3.   Операции и выражения 

  ♥ Оператор присваивания 

  ♥ Арифметические операции и выражения 

Урок 2. Управляющие операторы 

II.1.  Логические операторы 

II.2.  Операторы цикла 

 ♥ Оператор For…Next 

 ♥ Оператор While 

 ♥ Оператор Do 

Урок 3. Массивы и пользовательские типы данных 

3. Создать следующую таблицу, выполнить задания: 

Примерный план предмета «Логика» 

Количество учебных часов Код 
темы Наименование тем 

Всего Практических 
занятий 

1 2 3 4 
1 Предмет и назначение логики. Логика и язык 2 
2 Основные логические законы 2 нет 

3 Понятие. Логические операции с понятиями 6 2 
4 Суждение. Модальность суждений 4 нет 
5 Дедуктивные умозаключения 6 2 
6 Индуктивные умозаключения 2 
7 Аналогия и гипотеза 2 нет 

8 Логические основы аргументации 6 2 

Задание: 

 Для заголовка таблицы создать стиль ЛОГИКА с параметрами: Имя – 

ЛОГИКА, Стиль – Абзаца, Основан на стиле – Обычный, Стиль следую-
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щего абзаца – Обычный; Формат: Шрифт – Arial, курсив, размер – 14, 

цвет – зеленый, подчеркивание – пунктирное. Абзац: выравнивание по 

центру, выступ – 3 см, межстрочный интервал – одинарный, перед – 12, 

после – 12. 

 Текст таблицы – шрифт №16. 

 Заливка первой строки – серый 30%, второй – голубой. Цвет заливки яче-

ек с порядковыми номерами – желтый. 

4. Создать приведенные ниже формулы: 
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5. Создать следующую надпись, используя объекты рисования и WordArt: 

 

Тема: Электронная таблица Excel. 

1. Переименовать Лист1 на Магазин. 

2. Создать ниже приведенную таблицу: 

Прейскурант цен на книги в книжном магазине 
№ Автор Название книги Цена за одну книгу Количество Общая сумма 
1      
2      
3      
…      
10      

Сумма     
Среднее    

− Первый столбец заполнить с помощью автозаполнения. 

− Столбцы Автор, Наименование книги и Цена за одну книгу заполнить само-

стоятельно. 

− Посчитать общую стоимость покупки. 
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− Найти сумму и среднее значение по каждому столбцу. 

− Применить к таблице следующее форматирование: цвет заголовков столбцов 

– красный; цвет заливки – серый; внешняя рамка – сплошная; внутренняя 

рамка – пунктирная. 

− Отсортировать таблицу по столбцу Автор. 

− Построить диаграмму, отражающую название книги и общую сумму за каж-

дую книгу. Дать заглавие диаграмме (цвет шрифта названия диаграммы – 

синий). На диаграмме указать подписи данных. 

3. Переименовать Лист2 на Прейскурант. 

4. Создать ниже приведенную таблицу: 

Цена путевки  в долларах 
Курс доллара …  

   
Наименование санатория Цена в долларах Количество 

Моряк $390,00 2 
Амурский залив $350,00 3 
Шмаковка $600,00 2 
Белые горы $420,00 3 
Бузули $650,00 1 
Средняя цена   
Максимальная цена   
Минимальная цена   

− Ввести курс доллара. 

− Между столбцами Цена в долларах и Количество вставить столбец Цена в 

рублях. Вычислить цену в рублях, используя введенный курс доллара. 

− Найти среднюю, максимальную и минимальную цену в рублях и долларах 

среди всех санаториев. 

− После столбца Количество добавить столбец Сравнение. 

− Заполнить столбец Сравнение следующим образом: если цена путевки в са-

наторий в рублях больше средней цены, то вывести фразу «не покупать», 

иначе – вывести фразу «покупать». 

− Применить к таблице автоформатирование – Цветной 2. 
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− Построить диаграмму, отражающую наименование санатория и цену  путев-

ки в него в рублях. Дать заглавие диаграмме (цвет шрифта названия диа-

граммы – зеленый). На диаграмме указать подписи данных. 

Тема: Электронные презентации PowerPoint. 

1. Запустить программу MS PowerPoint. 

2. На первом слайде ввести произвольный заголовок. 

3. Вставить несколько слайдов разных типов и произвольно заполнить их тек-

стовой информацией и изображениями. 

4. Применить на выбор оформление слайдов. 

5. В одном из слайдов сменить фон на другой цвет и сменить способ заливки на 

градиентный (произвольно); в другом слайде в качестве способа заливки вы-

брать текстуру по выбору. 

6. Продублировать один из слайдов и изменить его содержание. 

7. Добавить слайд и вставить в него диаграмму. 

8. Добавить эффекты анимации в слайды. Для каждого слайда назначить смену 

слайда. 

9. Сделать настройку времени для презентации. 

Тема: СУБД Access. 

Выберете самостоятельно тему, соответствующую вашей специальности и 

создайте БД, выполнив следующие условия:  

1. Создайте таблицу. 

2. Внесите записи. 

3. Отсортируйте их. 

4. Создайте форму. 

5. Внесите еще 2 записи в форму. 

6. Организуйте поиск, задав критерий для поиска. 

7. Представить форму в режиме таблицы. 

8. Примените фильтр, задав условие отбора данных. 

9. Подготовьте отчет. 
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Тема: Линейная структура. 

1. Известна длина окружности. Найти радиус окружности и площадь круга, ог-

раниченного этой окружностью. 

2. Даны два натуральных числа. Найти среднее арифметическое и среднее гео-

метрическое этих чисел. 

3. Даны длины катетов прямоугольного треугольника. Найти длину гипотенузы 

и площадь данного треугольника. 

Тема: Оператор ветвления. 

1. Даны два числа. Если первое число больше или равно второму, то вывести 

кубы этих чисел, иначе вывести абсолютное значение первого числа, а второе 

число оставить без изменения. 

2. Даны четыре числа. Если первое число больше второго, то вывести первое 

число и квадрат второго, иначе вывести квадрат третьего числа и корень 

квадратный четвертого числа. 

3. Даны два числа. Если первое число больше или равно второму, то вывести 

кубы этих чисел, иначе вывести абсолютное значение первого числа, а второе 

число оставить без изменения. 

Тема: Оператор выбора. 

1. Учебный год разбит на два семестра и каникулы. В зависимости от месяца 

вывести – номер семестра или каникулы (зимние или летние). 

2. По введенному количеству лет определить номер класса. 

3. Дана цена в цифровом виде от 1 до 9. В зависимости от цифры вывести цену 

в правильном падеже (рубль, рублей, рубля). 

Тема: Циклические структуры. 

1. Вычислить LL +
+

+++=
13

2
2
1

n
nz  используя все циклы. 

2. Вычислить LL ⋅
−

⋅⋅⋅=
14

1
15
1

3
1

2n
z  используя все циклы. 
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3. Вычислить и вывести значения функции 22

3

xa
ay
+

= , при значении х изме-

няющемся от 0 до 3 с шагом h=0,1. Число а – произвольное, вводимое с кла-

виатуры. 

Тема: Работа с массивами. Компонент TStringGrid. 

1. Дан одномерный целочисленный массив А и целое число k. Найти сумму и 

количество элементов, больших заданного числа k. Отрицательные элемен-

ты заменить на нуль. Нарисовать блок – схему. 

2. Дана матрица А(n, n) и число m. Максимальным элементом главной диаго-

нали заменить все элементы матрицы, равные числу m. Вывести получен-

ную матрицу. Нарисовать блок – схему. 
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IX. ТЕСТЫ ДЛЯ ОЦЕНКИ КАЧЕСТВА ЗНАНИЙ 

Тема: Информатика как часть общечеловеческой культуры. Инфор-

мация. 

1. Данные – это: 

a) признаки или записанные наблюдения, которые по каким-то причинам не 

используются, а только хранятся; 

b) это выявленные закономерности в определенной предметной области; 

c) совокупность сведений, необходимых для организации хозяйственной 

деятельности предприятия; 

2. По месту возникновения информация бывает: 

a) входная, выходная, внутренняя, внешняя; 

b) текстовая, графическая; 

c) учетная, статистическая; 

3. По признаку стабильности информация бывает: 

a) количественная, суммовая; 

b) обрабатываемая, необрабатываемая; 

c) постоянная и переменная; 

4. По функциям управления информация бывает: 

a) плановая, учетная, оперативная; 

b) промежуточная, результатная; 

c) первичная, вторичная; 

5. В 4 килобайтах: 

a) 4000 бит; 

b) 4096 байт; 

c) 4096 бит; 

6. Минимальная единица измерения информации: 

a) байт; 

b) символ; 

c) бит; 
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7. Информация в ЭВМ кодируется: 

a) в двоичной системе счисления; 

b) в десятичной системе счисления; 

c) в символах; 

8. Один бит содержит: 

a) 0 или 1; 

b) одну цифру; 

c) один символ; 

9. Один байт содержит: 

a) 2 бита; 

b) 8 бит; 

c) 16 бит; 

10. В 1 килобайте 

a) 1012 байт; 

b) 1024 байт; 

c) 1000 бит. 

Тема: Системы счисления. 

1. Система счисления - это:  

a) способ наименования и записи чисел; 

b) представление букв с помощью цифр; 

c) способ представления одних чисел с помощью других; 

2. В двоичной системе используются цифры:  

a) 1 и 2; 

b) 0 и 1; 

c) 0 и 2; 

3. Бит – это:  

a) цифры 0 и 1; 

b) наименьшая единица памяти ЭВМ; 

c) 8 нулей и единиц; 
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4. Позиционная система счисления – это:  

a) римская; 

b) десятичная; 

c) все ответы верны;  

5. В двоичной системе основанием является:  

a) 0  

b) 2  

c) 8  

6. Двоичному числу 1000 соответствует десятичное число:  

a) 2;  

b) 8; 

c) 10;  

7. Системы счисления делятся на: 

a) позиционные и непозиционные; 

b) римские и десятичные; 

c) двоичные и десятичные; 

8. Результатом сложения двоичных чисел 1010 и 111 будет:  

a) 11010; 

b) 10110; 

c) 10100; 

9. Десятичному числу 122 соответствует двоичное число:  

a) 1111010; 

b) 1001010; 

c) 1010101; 

10. При переводе числа 425,7 из восьмеричной системы счисления в десятич-

ную, получится число: 

a) 277,875; 

b) 256,5; 

c) 377,95. 
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Тема: Аппаратное обеспечение ПК. 

1. Структура компьютера — это: 

a) комплекс электронных устройств, осуществляющих обработку информации; 

b) некоторая модель, устанавливающая состав, порядок и принципы взаимо-

действия входящих в нее компонентов; 

c) комплекс программных и аппаратных средств. 

2. Основная функция ЭВМ: 

a) общение человека и машины; 

b) разработка задач; 

c) принцип программного управления. 

3. Микропроцессор предназначен для: 

a) управления работой компьютера и обработки данных; 

b) ввода информации в ЭВМ и вывода ее на принтер; 

c) обработки текстовых данных. 

4. Разрядность микропроцессора — это: 

a) наибольшая единица информации; 

b) количество битов, которое воспринимается микропроцессором как 

единое целое; 

c) наименьшая единица информации. 

5. Постоянная память предназначена для: 

a) длительного хранения информации; 

b) хранения неизменяемой информации; 

c) кратковременного хранения информации в текущий момент времени. 

6. Принтер предназначен для: 

a) ввода алфавитно-цифровых данных, управления работой ПК; 

b) вывода информации на бумагу; 

c) вывода на экран текстовой и графической информации. 

7. Монитор предназначен для: 

a) ввода алфавитно-цифровых данных, управления работой ПК; 

b) вывода информации на бумагу; 

c) вывода на экран текстовой и графической информации. 
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8. Клавиатура предназначена для: 

a) ввода алфавитно-цифровых данных, управления работой ПК; 

b) вывода информации на бумагу; 

c) вывода на экран текстовой и графической информации. 

9. Функции системной шины состоят в: 

a) постоянном хранении самозагружаемой части операционной системы; 

b) передаче информации между микропроцессором и устройствами ПК; 

c) архивном копировании больших объемов данных. 

10. Для печати изготовленного на ПК текста используется  

a) принтер; 

b) винчестер; 

c) сканер. 

Тема: Программное обеспечение ПК. 

1. К операционным системам относятся: 
a) MS-Office, Clipper; 
b) MS-Word, Word Pad, PowerPoint; 
c) MS-DOS, Unix, Windows Nt; 

2. Сетевые операционные системы — это: 
a) комплекс программ для одновременной работы группы пользователей; 
b) комплекс программ, переносимых в сети с одного компьютера на другой; 
c) комплекс программ, обеспечивающих обработку, передачу и хранение дан-
ных в сети; 

3. К программам-архиваторам относятся программы: 
a) Raj.ехе; 
b) Arj.ехе; 
c) Ajr.ехе; 

4. Системное программное обеспечение (System Software) — это: 
a) комплекс программ для решения задач определенного класса в конкретной 
предметной области; 

b) совокупность программ и программных комплексов для обеспечения работы 
компьютера и сетей ЭВМ; 

c) комплекс программ для тестирования компьютера; 
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5. Отличительной особенностью операционной системы MS-DOS является: 

a) система ориентирована на эффективную поддержку процесса разработки 

программного обеспечения; 

b) система характеризуется развитыми средствами доступа ко всем аппарат-

ным средствам, гибкой файловой системой; 

c) наиболее простая операционная система; 

6. Системное программное обеспечение включает: 

a) базовое и сервисное программное обеспечение; 

b) операционную систему и антивирусные программы; 

c) операционные системы и операционные оболочки; 

7.Чем программное обеспечение отличается от аппаратного? 

a) аппаратное обеспечение – это все устройства, входящие в компьютер, а про-

граммное – это невидимая неотъемлемая часть, без которой не будет функ-

ционировать аппаратное обеспечение; 

b) аппаратное обеспечение – это все, что можно потрогать и увидеть (систем-

ный блок, кабель), а программное обеспечение – это все компоненты, нахо-

дящиеся внутри (микросхемы и т.д.); 

c) принципиально не отличаются; 

8. Для чего нужны прикладные программы? 

a) для перевода программ в машинные коды; 

b) для управления процессом обработки информации; 

c) для решения задач пользователей; 

9. Утилита – это: 

a) программа; 

b) микросхема; 

c) устройство ввода информации; 

10.Выберите категорию, к которой относятся следующие программы: Scandisk, 

Winrar,  Drweb, Format: 

a) системные; 

b) сервисные; 

c) прикладные. 
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Тема: Компьютерная графика. 

1. Пикселизация изображений при увеличении масштаба – один из недостатков: 

a) растровой графики; 

b) векторной графики; 

c) трехмерной графики; 

2. Большой размер файла – один из недостатков: 

a) растровой графики; 

b) векторной графики; 

c) трехмерной графики;  

3. Физический размер изображения может измеряться в:  

a) точках на дюйм (dpi) 

b) мм, см, дюймах или пикселах;  

c) пикселах; 

4. Растровый графический редактор предназначен для: 

a) построения диаграмм; 

b) создания чертежей; 

c) создания и редактирования рисунков; 

5. В модели CMYK в качестве компонентов применяются основные цвета ...  

a) красный, зеленый, синий, черный; 

b) голубой, пурпурный, желтый, черный; 

c) красный, голубой, желтый, синий; 

6. В модели RGB в качестве компонентов применяются основные цвета: 

a) красный, зеленый, синий; 

b) голубой, пурпурный, желтый; 

c) красный, голубой, желтый; 

7. Какой из графических редакторов является растровым: 

a) Adobe Illustrator; 

b) Paint; 

c) CorelDraw; 
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8. Разрешение изображения измеряется в: 

a) пикселах; 

b) точках на дюйм (dpi); 

c) мм, см, дюймах; 

 9. Paint – это: 

a) векторный графический редактор; 

b) растровый графический редактор; 

c) редактор сочетающий растровую и векторную графику; 

10. Графический редактор – это 

a) прикладная программа, предназначена для создания и обработки графи-

ческих изображений на компьютере; 

b) сервисная программа, предназначена для создания и обработки графиче-

ских изображений на компьютере; 

c) прикладная программа, предназначена для обработки графических изо-

бражений на компьютере. 

Тема: Файловая система. Norton-подобные операционные оболочки. 

1. Файл – это: 

a) часть диска; 

b) поименованная область на диске; 

c) последовательность операторов и команд; 

2. Для своего размещения файл требует: 

a) непрерывного пространства на диске; 

b) свободных кластеров в различных частях диска; 

c) Fat-таблицы; 

3. Для обозначения файлов используют: 

a) имена и расширения; 

b) команды операционной системы; 

c) имена кластеров; 
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4. Шаблон имени и расширения файла — это: 

a) специальная форма, в которой в полях имени и расширений типа файла 

используются символы «+» и «-.»; 

b) специальная форма, в которой в полях имени и расширений типа файла 

используются символы «*» и «?»; 

c) специальная форма, в которой в полях имени и расширений типа файла 

используются символы «-» и «?»; 

5. Каталог — это: 

a) постоянная память; 

b) место хранения имен файлов; 

c) внешняя память длительного хранения; 

6. Для отображения краткой информации в окне необходимо нажать: 

a) Ctrl+F2; 

b) Ctrl+F1; 

c) Ctrl+F8; 

7. Для быстрого просмотра файла необходимо нажать: 

a) Ctrl+O; 

b) Alt+O; 

c) Ctrl+Q; 

8. В окне просмотра файлов можно: 

a) редактировать текст; 

b) только просматривать текст; 

c) просматривать и редактировать текст; 

9. Для редактирования файла необходимо нажать: 

a) F4; 

b) F5; 

c) F3; 

10. В окне редактирования файлов можно: 

a) редактировать текст; 

b) только просматривать текст; 
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c) просматривать и редактировать текст. 

Тема: Операционная система Windows. 

1. Windows – это 

a) оболочка операционной системы; 

b) драйвер; 

c) операционная система; 

2. Панелью инструментов называется: 

a) панель, содержащая значки и кнопки, предназначенные для открытия нис-

падающего меню; 

b) панель, содержащая значки и кнопки, предназначенные для быстрого досту-

па к наиболее часто используемым командам приложения; 

c) панель, содержащая значки и кнопки, предназначенные для использования 

команд отсутствующих во всех видах меню; 

3. Какой интерфейс использует Windows? 

a) текстовый; 

b) программный; 

c) графический; 

4. Что такое программа «Поиск»? 

a) программа осуществляет быстрый поиск папок и файлов на компьютере; 

b) программа осуществляет поиск и удаление файлов на компьютере; 

c) программа не осуществляет поиск на компьютере; 

5. Главное меню предназначено для … 

a) быстрого запуска программ, поиска файлов, обеспечения доступа к справке; 

b) просмотра структуры папок и файлов; 

c) создания и удаления папок и файлов; 

6. Окно – это: 

a) прямоугольная область экрана, в которой выполняется программа или выво-

дится содержимое папки; 

b) все пространство Рабочего стола; 

c) часть экрана, в которой выводятся диски, папки, сети; 
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7. Проводник – это: 

a) программное средство Windows, предназначенное для управления файло-

вой системой, обеспечивающее  доступ к локальным и сетевым ресурсам; 

b) программное средство Windows, предназначенное для просмотра файлов; 

c) программное средство Windows, предназначенное для управления при-

ложениями и документами; 

8. Рабочий стол – это … 

a) полоса внизу экрана; 

b) все пространство экрана в среде Windows с расположенными на ней гра-

фическими объектами; 

c) все пространство экрана в среде Windows с расположенными на ней гра-

фическими и цифровыми объектами; 

9. Как запустить программу «Поиск»? 

a) Пуск → Программы → Поиск; 

b) Пуск → Программы → Стандартные → Поиск; 

c) Пуск → Поиск; 

13. Системное меню содержит: 

a) содержит команды для сохранения и удаления объектов; 

b) содержит команды, присущие только для данного объекта; 

c) содержит команды для изменения размеров окна. 

Тема: Табличный процессор Word. 

1. Команды открытия и сохранения файла находятся в пункте меню: 

a) Файл; 

b) Правка; 

c) Формат; 

2. Колонтитул – это... 

a) граница текста; 

b) строки текста, печатаемые на всех полях страницы; 

c) строки текста, печатаемые на верхних и нижних полях страницы; 
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3. Для организации таблицы следует выполнить команду ... и указать число 

строк, столбцов: 

a) Вставка → Таблица; 

b) Таблица → Нарисовать; 

c) Таблица → Добавить; 

4. Для обозначения конца абзаца используется клавиша: 

a) Enter 

b) Shift+Enter 

c) Ctrl+Enter 

5. Поместить в документ рисунок можно при помощи пункта меню: 

a)  Вид; 

b)  Сервис; 

c)  Вставка; 

6. Какая команда помещает выделенный фрагмент текста в буфер обмена без 

удаления: 

a) Копировать; 

b) Вырезать; 

c) Вставить; 

7. С помощью какого элемента можно вставить объект WordArt: 
a) 1; 
b) 2; 
c) 3; 

8. Копирование выделенного абзаца 
выполняется так: 

a) Правка→ Копировать; 

b) Формат→Абзац→Копировать; 

c) Абзац→Копировать; 

9. Заменить одно слово на другое можно командой: 

a) Сервис → Правописание → Заменить; 

b) Правка → Правописание → Заменить; 

c) Правка → Заменить; 
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10. Для ввода степени числа используют: 

a) шрифт маленького размера; 

b) вставку специального символа; 

c) верхний индекс. 

Тема: Электронная таблица Excel. 

1. Для задания диапазона ячеек Excel, два требуемых адреса необходимо разде-
лить: 
a) двоеточием; 
b) тире; 
c) точкой с запятой; 

2. Запись «B$1» означает, что при копировании ячейки Excel: 
a) изменится имя столбца; 
b) изменится номер строки; 
c) изменятся имя и номер ячейки; 

3. Изменяющийся при копировании и перемещении адрес ячеек Excel: 
a) ссылка; 
b) абсолютная ссылка; 
c) относительная ссылка; 

4. Содержимым отдельной ячейки может быть: 
a) график, диаграмма или рисунок; 
b) число, текст, или формула; 
c) команда, файл, каталог; 

5. Для задания диапазона ячеек нужно указать: 
a) его левый верхний и правый нижний адреса ячеек; 
b) адрес каждой ячейки диапазона; 
c) адреса двух ячеек с максимальным и минимальным элементами; 

6. Укажите правильную запись формулы, вычисляющей произведение содержи-
мого ячеек А1 и В1: 

a) С1=А1*В1; 
b) А1*В1; 
c) = А1*В1; 
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7. Если в клетках ЭТ содержится формула, то при обычном режиме в данной 

клетке отображается: 

a) содержимое данной клетки; 

b) математическая функции; 

c) вычисленное по этой формуле значение; 

8. Для указания абсолютного адреса используется знак: 

a) #; 

b) %; 

c) $; 

9. Файл, в котором хранится таблица Excel, имеет расширение: 

a) .doc; 

b) .exe; 

c) .xls; 

10. Результатом вычислений в ячейке С1 будет: 

a) 5; 

b) 10; 

с)15. 

 А В С 

1 5 = А1*2  =СУММ(А1:В1)  
 

Тема: Электронные презентации PowerPoint. 

1. В каком режиме просматривается данная 

презентация?  

a) обычный; 

b) страницы заметок; 

c) сортировщик слайдов; 

2. Как изменить междустрочный интервал в маркированном списке?  

a) Формат → Абзац; 

b) Формат → Список; 

c) Формат → Интервалы; 
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3. На картинке изображен слайд с таблицей. Вставить по-

добную таблицу в слайд возможно с помощью 

a) Вставка → Таблица; 

b) Формат → Таблица; 

c) Вид → Таблица; 

4. На рисунке изображена рамка с текстом, 

выровненным определенным образом. 

Укажите номер кнопки, соответствующей 

данному типу выравнивания: 

a) 1; 

b) 2; 

c) 3; 

5. В процессе демонстрации презентации доклад-
чик может использовать инструмент Карандаш. 
На рисунке представлен пример применения 
этого инструмента. Укажите пункт контекстно-
го меню, соответствующий выбору инструмен-
та Карандаш: 

a) записная книжка; 

b) заметки докладчика; 

c) указатель; 

6. На рисунках изображен слайд с одинаковым содержимым. Чем различаются 

эти слайды? 

   
a) шаблонами оформления; 

b) цветовыми схемами; 

c) эффектами анимации; 
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 7. На рисунке представлена картинка из коллекции MS Office 
ClipArt. Укажите все способы вставки картинок из данной 
коллекции: 

a) Вставка → Рисунок → Картинки; 

b) Вставка → Рисунок → Автофигуры; 

c) Вид → Вставка → Вставка картинки;  

8. На картинке изображено окно Настройки анима-

ции. Меню «Вход» (выделено красным) уста-

навливает эффект анимации: 

a) Для всего слайда при смене слайдов;  

b) Для выделенного на слайде объекта; 

c) Для всех слайдов создаваемой презентации; 

9. На картинке изображен фрагмент слайда. Укажите 

тип выравнивания названий времен года: 

a) По центру; 

b) По правому краю; 

c) По левому краю. 

Тема: База данных. 

1. Ключ в базе данных – это: 
a) простейший объект БД для хранения значений одного параметра реального 
объекта или процесса; 

b) поле, по которому выполняется фильтрация данных в таблице параметрам; 
c) поле или совокупность полей, однозначно определяющих записи таблицы; 

2. Представлена база данных «Школа»: 
 Фамилия Год рождения Класс Оценка 
 Лыкова Ольга 1988 10 5
 Семенов Олег 1987 11 4
 Морозов Иван 1987 11 3
 Рыков Роман 1988 10 5
 Попов Сергей 1988 10 4
 Зайцева Марина 1987 10 5 

Запрос для вывода спи-
ска: учеников 10 клас-
сов, 1988 года рожде-
ния, имеющих оценки 
не ниже 4 содержит вы-
ражение: 

a) Оценка>=4 и Год рождения = 1988 и Класс = 10; 
b) Класс = 10 и Год рождения = 1988 и Оценка = 5 и Оценка = 4; 
c) Оценка >=4 или Год рождения = 1988 и Класс = 10; 
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3. Установленные связи между таблицами реляционной базы данных помогают: 

a) избежать дублирования информации; 

b) определить местонахождение нужной таблицы; 

c) производить сортировку таблицы; 

4. Система управления базами данных – это: 

a) формальный аппарат ограничений на формирование таблиц, который позво-

ляет устранить дублирование; 

b) комплекс программных и языковых средств, предназначенных для создания, 

ведения и совместного применения баз данных многими пользователями; 

c) система, реализующая сбор, обработку и манипулирование данными и 

включающая технические средства, программное обеспечение и соответст-

вующий персонал; 

5. Тип поля (числовой, текстовой и др.) в базе данных определяется: 

a) названием поля; 

b) количеством строк; 

c) типом данных; 

6. Какую строку будет занимать запись Pentium II после проведения сортировки 

по возрастанию в поле Винчестер? 

a) 1; 

b) 2; 

c) 4; 

 

 Компьютер Опер. память Винчестер 
1 Pentium 16 2Гб 
2 386DX 4 300Мб 
3 486DX 8 800Мб 
4 Pentium II 32 4Гб  

7. Запись в БД Access: 
a) столбцы реляционной таблицы; 
b) строки реляционной таблицы; 
c) одно или несколько полей, имеющих уникальное значение для реляционной 
таблицы; 

8. Поле какого типа не может быть ключевым: 
a) числовое; 
b) логическое; 
c) дата; 
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9. В какой модели данных предполагается, что любой элемент может быть связан 
с любым количеством других элементов: 
a) реляционная; 
b) сетевая; 
c) иерархическая; 

10. База данных, в которой данные сгруппированы в двумерные таблицы, связан-
ные между собой, называется: 
a) иерархическая; 
b) сетевая; 
c) реляционная; 

11. Поисковая фраза в текстовых БД называется: 
a) вопросом; 
b) ответом; 
c) запросом. 

12. Представлена таблица базы данных «Кадры»: 
 Фамилия Год рождения Оклад 
 Иванов 1956 2400
 Петров 1957 5300
 Сидоров 1956 3600
 Скворцов 1952 1200
 Трофимов 1958 4500 

При поиске по условию (Год 

рождения>1956 и оклад<5000) бу-

дут найдены фамилии: называет-

ся: 

a) Иванов, Петров, Трофимов; 
b) Трофимов; 
c) Иванов, Петров, Трофимов, Скворцов. 

Тема: Компьютерные сети. Интернет. 

1. Компьютерная сеть – это: 
a) группа установленных рядом вычислительных машин, объединенных с по-
мощью средств сопряжения и выполняющих единый информационно-
вычислительный процесс; 

b) совокупность компьютеров и терминалов, соединенных с помощью каналов 
связи в единую систему, удовлетворяющую требованиям распределенной 
 обработки данных; 

c) совокупность сервера и рабочих станций, соединенных с помощью коакси-
ального или оптоволоконного кабеля; 
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2. Информационно-вычислительные системы по их размерам подразделяются на: 

a) локальные, региональные, глобальные, широкомасштабные; 

b) терминальные, административные, смешанные; 

c) цифровые, коммерческие, корпоративные; 

3.  Локальная вычислительная сеть – это: 

a) вычислительная сеть, функционирующая в пределах подразделения или 

подразделений предприятия; 

b) объединение вычислительных сетей на государственном уровне; 

c) общепланетное объединение сетей; 

4. Признак «Топология сети» характеризует: 

a) схему приводных соединений в сети (сервера и рабочих станций); 

b) как работает сеть; 

c) состав технических средств; 

5.  Локальные вычислительные сети по признаку «топология» подразделяются 

на: 

a) реальные, искусственные; 

b) типа «Звезда», «Шина», «Кольцо»; 

c) проводные, беспроводные; 

6. Программное обеспечение локальной вычислительной сети включает: 

a) сетевую операционную систему, пакеты прикладных программ, базы 

данных; 

b) пакеты прикладных программ, базы данных; 

c) MS-Dos, MS-Windows, NetWare; 

7. Наиболее распространенной операционной системой для локальной вычис-

лительной сети является: 

a) Unix; 

b) MS-DOS; 

c) Windows; 
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8. Сервер – это: 

a) персональный компьютер, подключенный к сети, через который пользо-

ватель получает доступ к ее ресурсам; 

b) компьютер, подключенный к сети и обеспечивающий ее пользователей 

определенными услугами; 

c) два или более абонентов вычислительной сети, соединенных каналом 

связи; 

9. Рабочая станция – это: 

a) персональный компьютер, подключенный к сети и выполняющий моду-

ляцию и демодуляцию информации; 

b) персональный компьютер, подключенный к сети, через который пользо-

ватель получает доступ к ее ресурсам; 

c) устройство, выполняющее функции сопряжения ЭВМ с каналом связи; 

10. Шлюз – это: 

a) устройство, позволяющее организовать обмен данными между двумя се-

тями, использующими один и тот же протокол взаимодействия; 

b) устройство, позволяющее организовать обмен данными между двумя се-

тями, использующими различные протоколы взаимодействия; 

c) устройство, соединяющее сети разного типа, но использующее одну опе-

рационную систему. 

Тема: Алгоритмизация и программирование. Моделирование решения 

функциональных и вычислительных задач. 

1. Программы-компиляторы служат для: 

a) автоматического перевода программы в машинный код и последующего её 

использования без исходного текста; 

b) анализа структуры очередного оператора языка из текста программы и его 

исполнения перед переходом к следующему оператору языка; 

c) написания текста программы с возможностью определения синтаксических 

ошибок; 
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2. Выберите верное высказывание: 
a) алгоритм имеет свойство дискретность, означающее разбиение алгоритма на 

конкретные действия; 
b) алгоритм имеет свойство специфичность, обозначающее, что алгоритм со-

ставляется для одной задачи; 
c) алгоритм имеет свойство результативность, означающее, что после выпол-

нения алгоритма должен быть получен графический результат; 
3. К языкам программирования высокого уровня относятся: 

a) Pascal, Basic, Cи++, Ассемблер; 
b) Pascal, Basic, Ассемблер, Access; 
c) Basic, Cи++, Pascal, Java; 

4. Алгоритм – это: 
a) точное предписание, определяющее процесс перехода от исходных данных к 

результату; 
b) требования, предъявляемые к программе; 
c) проведение расчетов и анализ результатов; 

5. Условие – это: 
a) выражение логического типа; 
b) повторяющиеся команды; 
c) все ответы верны; 

6. Язык программирования низкого уровня – это: 
a) не учитывают особенности конкретных компьютерных архитектур и позво-
ляют разрабатывать программы с помощью понятных для пользователя ко-
манд; 

b) языки, операторы которых близки к машинному коду и ориентированы на 
конкретные команды процессора; 

c) представляют собой комплект программ, обеспечивающий возможности ра-
боты на компьютере; 

7. Выберите верное высказывание: 
a) каждый алгоритм решения задачи имеет входные и выходные данные; 
b) каждый алгоритм содержит в себе разветвляющиеся и циклические структу-

ры; 
c) не всякий алгоритм можно представить в виде блок-схемы; 
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8. Выберите верное высказывание: 
a) алгоритм имеет свойство дискретность, означающее разбиение алгоритма на 

конкретные действия; 
b) алгоритм имеет свойство специфичность, обозначающее, что алгоритм со-

ставляется для одной задачи; 
c) алгоритм имеет свойство результативность, означающее, что после выпол-

нения алгоритма должен быть получен графический результат. 

Тема: Основы программирования в Delphi. 

1. Delphi реализует интерфейс управления окнами: 
a) SDI (Single Document Interfase); 
b) MDI (Multiple Document Interface); 
c) RDI (Reformative DI); 

2. Окно формы используется для: 
a) проектирования окна программы; 
b) выбора визуальных компонентов; 
c) создания текста программы; 

3. В инспекторе объектов задаются: 
a) заголовок формы; 
b) свойства и события; 
c) программа и алгоритм; 

4. Страница Properties используется: 
a) для задания свойств объекта; 
b) для задания событий объекта"; 
c) в меню главного окна; 

5. TButton является: 
a) командной кнопкой; 
b) меткой; 
c) свойством; 

6. Свойство Font определяет: 
a) параметры шрифта; 
b) палитру фона; 
c) характеристики формы; 
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7. Свойства размера объекта: 

a) Width, Height; 

b) Width, Top; 

c) Left, Top; 

8. TButton не имеет свойства: 

a) Caption; 

b) Color; 

c) Left; 

9. Событие щелчок мыши: 

a) OnClick; 

b) OnCreatе; 

c) OnClose; 

10. Верное описание события: 

a) Procedure Form1. Button1Click(); 

b) Procedure Form1.OnClick(Button1); 

c) Procedure Button1.Click(); 

11. Команда прекращения программы: 

a) Project/Compile; 

b) Run/Run; 

c) Run/Reset; 

12. Выполняемый файл *.exe создается: 

a) при компиляции сохраненной программы; 

b) при алгоритмизации программы; 

c) во время сохранения программы; 

Тема: Линейная структура. 

1. При моделировании решения задач этап алгоритмизация следует:  

a) после этапа программирования; 

b) после этапа тестирования; 

c) после этапа выбор методологии разработки программы; 
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2. Компонент TEdit не имеет свойство:  
a) Text; 
b) Color;  
c) Caption; 

3. Переменная типа Boolean может принимать значение:  
a) 10; 
b) False; 
c) 'верно';  

4. Выберите верную команду:  
a) edit1.text:=FloatToStr(S);  
b) S:=FloatToInt(edit1.text);  
c) edit1.text:=S(StrToFloat); 

5. Функция возведение переменной х в квадрат:  
a) SQRT(x); 
b) SQR(x); 
c) не существует; 

6. Функция (r mod 2) находит:  
a) модуль числа; 
b) целую часть от деления; 
c) остаток от деления; 

7. Выражение ABS(6+5*x) при x=2 возвращает значение:  
a) 4; 
b) 16; 
c) 22; 

8. При обнаружении синтаксической ошибки курсор помещается на символ:  
a) в котором обнаружена ошибка; 
b) следующий после ошибки; 
c) перед ошибкой; 

9. Наличие структурных ошибок проверяется при:  
a) компиляции; 
b) закрытии окна кода программы; 
c) работе с выполняемой программой; 
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10. Модуль является:  

a) не обязательной программой, однако при его наличие увеличивается бы-

стродействие; 

b) основной программой, к которой подключаются файл проекта; 

c) вспомогательной программой, которая присоединяется к файлу проекта; 

11. Команда FileSave as… сохраняет:  

a) модуль с расширением .pas; 

b) проект с расширением .dpr; 

c) форму с расширением .dfm; 

12. Запуск программы на исполнение осуществляется командой:  

a) Project/Compile; 

b) Run/Run; 

c) Run/Program Reset. 

Тема: Оператор ветвления. 

1. В операторе ветвления выполняется:  

a) сначала одна, потом другая цепочка действий; 

b) только одна цепочка действий; 

c) две цепочки действий при истинном условии, одна - при ложном; 

2. Веточка THEN в ветвление определяет:  

a) действия, выполняемые при ложности условия; 

b) действия, выполняемые при истинности условия; 

c) проверку условия для выполнения действия; 

3. Верно записанное условие:  

a) y:=5; 

b) y=5; 

c) y and 5; 

4. Условие not(x>=5) при х=-20 равно:  

a) boolean; 

b) false; 

c) true; 
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5. Выберите верное утверждение  

a) не верна; 

b) полного ветвления; 

c) неполного ветвления; 

5. Условие принадлежности выделенной области в Pascal: 

a) not(x<-7); 

b) not(x>-7); 

c) not(x<=-7); 

6. Условие принадлежности точки фигуре в Pascal: 

a) (sqr(x)+sqr(y)<4) and (x>0); 

b) (sqr(x)+sqr(y)<=4) or (y<>0); 

c) (x>0) and (x<2) and (y>-2) and (y>2); 

8. Для формы F1 событие щелчок мыши на компоненте CheckBox1 описыва-

ется:  

a) Procedure TF1. CheckBox1Click (); 

b) Procedure F1. CheckBox1 OnClick (); 

c) Procedure CheckBox1 Click (); 

9. Независимый переключатель позволяет:  

a) включать флажки только поочередно; 

b) включать одновременно любое количество флажков; 

c) включать один флажок обязательно при выключенных других; 

10. If (x<4)and(x>-2) then y:=x+2 else y=x-5; при х=5 вернет значение:  

a) y=x-5; 

b) 7; 

c) 0. 

Тема: Оператор выбора. 

1. Оператор выбора позволяет:  

a) правильно выделить соответствующую строку текста; 

b) выбрать одно из нескольких продолжений программы;  

c) выполнить две цепочки действий; 
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2. В операторе выбора промежуток значений от 1 до 10 указывается:  
a) 1...10; 
b) 1-10; 
c) 1..10; 

3. К классу TStrings относится свойство компонента TRadioGroup:  
a) String; 
b) Items; 
c) Lines; 

4. Свойство, возвращающее номер выделенной строки, у компонента Tmemo:  
a) называется Items; 
b) отсутствует; 
c) используется ItemIndex; 

5. Команда присвоения n:Integer количество строк в memo1 записывается:  
a) n:=memo1.Lines.Count;  
b) n:=memo1.Count;  
c) memo1.Lines.Count(n); 

6. В компоненте TListBox редактирование текста  
a) допустимо после выделения радиокномпки; 
b) невозможно; 
c) возможно; 

7. Команда, скрывающее окно ListBox1, записывается:  
a) ListBox1.ItemIndex.Clear;  
b) ListBox1.Visible:=false;  
c) ListBox1.Items.visible:=false; 

8. В компоненте TRadioGroup редактирование текста  
a) допустимо после выделения радиокномпки; 
b) невозможно; 
c) возможно; 

9. Команда, скрывающее окно RadioGroup1, записывается:  
a) RadioGroup1.ItemIndex.Clear;  
b) RadioGroup1.Visible:=false;  
c) RadioGroup1.Items.visible:=false; 
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10. Зависимый переключатель позволяет:  

a) включать переключатели только поочередно(первую, вторую и т.д.); 

b) включать одновременно любое количество переключателей; 

c) включать один переключатель обязательно при выключеннии других. 

Тема: Циклические структуры. 

1. Циклические операторы бывают:  

a) с предусловием/с параметром/с постусловием; 

b) простые/сложные/многовариантные; 

c) с начальным/повторяющимся/ конечным условиями; 

2. Условие проверяется в конце в операторе:  

a) Repeat; 

b) For; 

c) While; 

3. Выберите верное утверждение  

a) блок-схема цикла с предусловием; 

b) в блок-схеме веточки true и false сле-

дует поменять местами; 

c) в блок-схеме оператор2 веточки false 

лишний; 
 

4. Тело цикла в цикле с предусловием выполняется:  

a) при ложности условия; 

b) при истинности условия; 

c) вне зависимости от проверки условия n раз; 

5. Выберите верное утверждение:  

a) блок-схема цикла с постусловием  

b) в блок-схеме веточки true и false 

следует поменять местами; 

c) в блок-схеме отсутствует второй 

оператор; 
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6. Оператор цикла с постусловием имеет вид:  

a) Repeat (<условие>) do <оператор>; 

b) While (<оператор>) Until <условие>; 

c) Repeat (<оператор>) Until <условие>; 

7. Цикл с параметром верно записан:  

a) For i:=10 downto 2 do <оператор>; 

b) For i:=10 to 2 do <оператор>; 

c) For i:=10 do 2 downto <оператор>; 

8. При решение задач циклы с параметром и постусловием различаются:  

a) изменение параметра цикла происходит автоматически/оператором; 

b) тело цикла выполняется n/(n-1) раз; 

c) условие цикла записывается в одну/две строки; 

9. В программах переменная, хранящая значение a в степени x первоначально 

равна:  

a) -1; 

b) 1; 

c) 0; 

10. a:=3; t:=1; For i:=1 to 5 do t:=t*a;  

a) блок программы вычисления 5!; 

b) блок программы вычисления a в 5 степени; 

c) блок программы вычисления суммы ряда a+2a+3a+4a+5a. 

Тема: Работа с массивами. Компонент TStringGrid. 

1.  Тип данных массив относится к: 

a) структурированным типам данных; 

b) простым типам данных; 

c) объектным типам данных; 

2. Вектор объема продаж квартир А (2000-2004 гг.) описывается: 

a) A: array [2000-2004] of Integer; 

b) A: array [2000..2004] of real; 

c) A:=IntTostr ([2000,2004]); 
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3. Обращение к 2001 г. вектора А задания 2 записывается: 

a) A(1); 

b) A[2001]; 

c) A(2); 

4. For i:=2000 to 2002 do S:=S+A[i]: 

a) находится сумму значений за три года; 

b) находится количество значений; 

c) находится среднегодовое значение; 

5. for i:=2000 to 2004 do  

                             edit11.text:=IntToStr(i): 

a) выведет на экран номер года; 

b) выведет на экран объем продаж i-года; 

c) выведет количество лет вектора; 

6. k:=5; А[2000]:=14; А[2001]:=12; А[2002]:=13; А[2003]:=16; А[2004]:=17; 

 For i:=2000 to 2004 do  

    If A[i]>14 then k:=k-1; 

Выберите конечное значение к: 

a) k = 1; 

b) k = 3; 

c) k = 2; 

7. Выберете верное утверждение:  

a) k выводится после выполнения цикла; 

b) k выводится при ложности ветвления; 

c) k выводится при истинности ветвления; 

8. Согласно вопросу 6 S равно: 

a) 47; 

b) 3; 

c) 6007. 
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X. КОМПЛЕКТ ЭКЗАМЕННАЦИОННЫХ БИЛЕТОВ 
 

АМУРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ 
Утверждено на заседании кафедры                       Кафедра    ОМиИ 
«     »                  200    г.                                           Факультет  ЭкФ 
Заведующий кафедрой                                            Курс 1 

  Утверждаю:__________________                          Дисциплина Информатика 
 

БИЛЕТ № 1 

1. Информатика - это … Основная задача информатики … 

2. Информация – это …Формы передачи информации… 

3. К основному аппаратному обеспечению компьютера относятся … Микропро-

цессор расположен …, выполняет функции: …. Включает в себя …. 

4. Зарисовать схему запоминающих устройств ПК. 

5. Операционная система – это … ОС можно квалифицировать по следующим 

признакам. 

6. Каталог – это …, привести примеры. 

7. Задайте маску файлам: а) созданным в программе Excel; б) текстовым файлам, 

начинающимся на букву T.  

8. База данных – это … Классификация БД. 

9. Метод защиты информации криптография позволяет…Криптография бывает 

двух видов…Пример использования закрытого и публичного ключа. 

10. В Excel в ячейке С1 записана формула: =A$1+$B2. Переместите формулу в 

ячейки D2, E4. 

11. В ЭТ в клетку В1 занесено выражение:  

ЕСЛИ(А1<10,2,ЕСЛИ(А1<15,3,ЕСЛИ(А1<20,4,5))) 

При каких значениях содержимого клетки значение клетки В1 равно 4? Объяс-

нить. 

12. Дана база данных сотрудников. Найти средний доход сотрудников. В столбец 

«Вывод» для каждого сотрудника вывести с помощью функции ЕСЛИ фразу 

«выше» или «ниже» его доход по сравнению с прожиточным минимумом. 
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Средний доход 
Прожиточный минимум 4200 р.   

ФИО Доход Количество человек 
на содержании Вывод 

Иванов О.П. 8000 р. 3  
Арбузова П.Г. 18060 р. 4  
Зайцева К.В. 14600 р. 4  
Бубнов П.У. 15310 р. 2  
Ясман В.Р 21420 р. 4  
Седова К.Л. 9400 р. 5  
Донцов П.П. 8500 р. 1  

СРЕДНЕЕ    

13. Составить программу вычисления ∑
=

n

i

i

i
a

1

 используя все циклы Изобразить блок-

схему. 

 
АМУРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ 

Утверждено на заседании кафедры                       Кафедра    ОМиИ 
«     »               200   г.                                               Факультет  ЭкФ 
Заведующий кафедрой                                            Курс 1 

  Утверждаю:__________________                          Дисциплина Информатика 
 

БИЛЕТ № 2 

1. Информация – это …. Виды информации: …. Единицы измерения информа-

ции. 

2. Классификация ЭВМ. 

3. АЛУ предназначено … Математический сопроцессор необходим для … 

4. Накопители на жестких магнитных дисках. 

5. Операционная оболочка – это … ОО относится к классу программного обес-

печения… 

6. Файл – это …. Имя файла формируется …. Назовите 6 известных вам рас-

ширений и их обозначение. 

7. Задайте маску файлам: а) созданным в программе Word, б) графическим 

файлам, имеющим в имени 5 символов, первый - T.  

8. База данных – это … Структурные элементы БД. 

9. Рабочая станция компьютерной сети служит для …, например …. Рабочие 

станции бывают 3-х видов: … 
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10. В Excel в ячейке С3 записана формула: =$A2 - C$2. Переместите формулу в 

ячейки D3, E4. 

11. В ЭТ в клетку В4 занесено выражение: ЕСЛИ(NOT(OR(А4<2,А4>=5)),0,1). 

При каких значениях содержимого клетки А4 значение клетки В4 равно 1? 

Объяснить. 

12. В таблице представлены данные курса USD в декабре месяце. Рассчитать 

среднемесячное значение курса USD. По вычисленной разнице текущего и 

среднего курса вывести с помощью функции ЕСЛИ фразу «понижение кур-

са»  или «повышение курса». 

Курс валюты 
Дата Курс USD Разность Итог 

01 дек 06 $30,40   
02 дек 06 $30,20   
03 дек 06 $30,12   

…    
31 дек 06 $29,36   
СРЕДНЕЕ    

13. Составить программу вычисления 
( )∏

=
⎟⎟
⎠

⎞
⎜⎜
⎝

⎛

−
+

n

i i1
212

11  используя все циклы. Изо-

бразить блок-схему. 

 
АМУРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ 

Утверждено на заседании кафедры                       Кафедра    ОМиИ 
«     »               200   г.                                               Факультет  ЭкФ 
Заведующий кафедрой                                            Курс 1 

  Утверждаю:__________________                          Дисциплина Информатика 
 

БИЛЕТ № 3 

1. Информационное общество – это … 

2. Классификация информации по различным признакам. 

3. Внутренние ЗУ представлены … Они предназначены …. 

4. Накопители на гибких магнитных списках. 

5. Операционная система - это ... Наиболее известны операционные системы … 

6. Файловая система – это … 
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7. Задайте маску файлам: а) выполняемым программам; б) текстовым файлам, 

в имени которых третий символ R. 

8. Модель данных – это … Иерархическая модель данных. 

9. Метод защиты информации аутентификация позволяет …. Аутентификация 

бывает двух видов …. 

10. В Excel в ячейке С2 записана формула: =$A2 - C$2. Переместите формулу в 

ячейки D3, E4. 

11. Значения клеток А2 и А3 равны соответственно 7 и 12. В клетку В2 занесено 

выражение: ЕСЛИ(AND(А2>1,А2<10),1,0). В клетку В3 занесено выраже-

ние: ЕСЛИ(OR(А3<=1,А3>8),0,1). Чему равно значение клетки D3? Объяс-

нить. 

12. Известна цена холодильника в 2006 году и ежегодное увеличение цены в % 

к предыдущему году. Рассчитать прогнозную цену до 2010 года и среднюю 

цену. 
Ежегодное увеличение цена 3,5% 
Года Цена холодильника марки 12.2435.12 
2006 10230 р. 
2007  
2008  
2009  
2010  
Средняя цена  

13. Составить программу вычисления ∑
=

n

i

i

i
x

1

, используя все циклы. Изобразить 

блок-схему. 
 

АМУРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ 
Утверждено на заседании кафедры                       Кафедра    ОМиИ 
«     »               200   г.                                               Факультет  ЭкФ 
Заведующий кафедрой                                            Курс 1 

  Утверждаю:__________________                          Дисциплина Информатика 
 

БИЛЕТ № 4 

1. Информатика – это… Главная функция информатики заключается … 

2. Информация – это … 

3. Накопители на оптических дисках. 

4. Устройства ввода информации. 
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5. Операционная оболочка - это …Наиболее известны операционные оболочки. 

6. Элементами операционной системы являются: … (6 элементов). 

7. Задайте маску файлам: а) созданным в программе Блокнот; б) файлам, 

имеющим в расширении вторую букву X. 

8. При построении баз данных используются три модели…. Реляционная мо-

дель представляет ….  

9. Электронная служба в Интернет позволяет … (3 функции). Адрес электрон-

ного ящика состоит из частей…  

10. В Excel в ячейке B2 записана формула: =A$1 - $B1. Переместите формулу в 

ячейки D3, C4. 

11. В ЭТ в клетку В4 занесено выражение: ЕСЛИ(AND(NOT(А4<2),А4<5),1,0). 

При каких значениях содержимого клетки А4 значение клетки В4 равно 1? 

Объяснить. 

12.  В представленной таблице рассчитать процент работ на «отлично». В поле 

«Вывод» определить «выше среднего» или «ниже среднего» количество от-

личников в группах. 
 Итоги контрольного среза   
Группа Всего сдавало Сдали на «отлично» % работ на «отлично» Вывод 

242 31    
243 24    
244 23    
245 34    
246 27    

Среднее     
13. Написать программу, вычисляющую количество и сумму отрицательных 

элементов главной диагонали матрицы. Изобразить блок-схему. 

 
АМУРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ 

Утверждено на заседании кафедры                       Кафедра    ОМиИ 
«     »               200   г.                                               Факультет  ЭкФ 
Заведующий кафедрой                                            Курс 1 

  Утверждаю:__________________                          Дисциплина Информатика 
 

БИЛЕТ № 5 
1. Информация – это … Минимальной единицей информации является 

…Свойства информации. 
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2. Этапы развития информатики. 
3. К внешним ЗУ относятся … Их значение для современных компьютеров равно. 
4. При форматировании диск делится на …. Кластер - это …. Файловые системы 

FAT16 и FAT32 различаются …  
5. Компьютерный вирус – это … Признаки появления вирусов. 
6. Файл – это … «Маски» в именах файлов. Привести примеры. 
7. Задайте маски файлам: а) созданным в программе Paint; б) файлам, имеющим в 

имени вторую букву З. 
8. База данных – это… Сетевая модель данных. 
9. Гипертекстовые документы – это …. Для поиска информации по ключевому 

слову в WWW  используются …., например, … 
10. В Excel в ячейке С2 записана формула: =A$1 - $B1. Переместите формулу в 

ячейки D3, Е4. 
11. В ЭТ в клетку В1 занесено выражение:  

ЕСЛИ(А1<10,2,ЕСЛИ(А1<15,3,ЕСЛИ(А1<20,4,5))) 
При каких значениях содержимого клетки значение клетки В1 равно 4? Объяс-
нить. 

12. Дана база данных сотрудников. Найти средний доход сотрудников. В столбец 
«Вывод» для каждого сотрудника вывести с помощью функции ЕСЛИ фразу 
«выше» или «ниже» его доход по сравнению с прожиточным минимумом. 

Средний доход 
Прожиточный минимум 4200 р.   

ФИО Доход Количество человек 
на содержании Вывод 

Иванов О.П. 8000 р. 3  
Арбузова П.Г. 18060 р. 4  
Зайцева К.В. 14600 р. 4  
Бубнов П.У. 15310 р. 2  
Ясман В.Р 21420 р. 4  
Седова К.Л. 9400 р. 5  
Донцов П.П. 8500 р. 1  

СРЕДНЕЕ    

13. Составить программу вычисления ( )∑
=

⋅
n

i
i

1

32  используя все циклы. Изобразить 

блок-схему. 
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АМУРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ 
Утверждено на заседании кафедры                       Кафедра    ОМиИ 
«     »               200   г.                                               Факультет  ЭкФ 
Заведующий кафедрой                                            Курс 1 

  Утверждаю:__________________                          Дисциплина Информатика 
 

БИЛЕТ № 6 
1. Основные направления информатики. 
2. Информационная система – это …, информационная технология – это … 
3. Устройства вывода информации. 
4. Назначение генератора тактовых импульсов. 
5. Компьютерный вирус – это … Классификация компьютерных вирусов. 
6. Основными элементами операционной системы MsDos являются … 
7. Задайте маски файлам: а) графическим файлам; б) файлам, начинающимся на 

букву W, и имеющим в расширении два символа. 
8. Компьтерная сеть – это … Классификация вычислительных сетей. 
9. Адаптер, шина предназначены …. 
10. В Excel в ячейке B2 записана формула: =B$1 + $C1. Переместите формулу в 

ячейки D3, Е4. 
11. В ЭТ в клетку В4 занесено выражение: ЕСЛИ(NOT(OR(А4<2,А4>=5)),0,1). При 

каких значениях содержимого клетки А4 значение клетки В4 равно 1? Объяс-
нить. 

12. В таблице представлены данные курса USD в декабре месяце. Рассчитать сред-
немесячное значение курса USD. По вычисленной разнице текущего и среднего 
курса вывести с помощью функции ЕСЛИ фразу «понижение курса»  или «по-
вышение курса». 

Курс валюты 
Дата Курс USD Разность Итог 

01 дек 06 $30,40   
02 дек 06 $30,20   
03 дек 06 $30,12   

…    
31 дек 06 $29,36   
СРЕДНЕЕ    

13. Составить программу вычисления ∑
=

n

i i
x

1 !
 используя все циклы. Изобразить блок-

схему. 



 218

АМУРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ 
Утверждено на заседании кафедры                       Кафедра    ОМиИ 
«     »               200   г.                                               Факультет  ЭкФ 
Заведующий кафедрой                                            Курс 1 

  Утверждаю:__________________                          Дисциплина Информатика 
 

БИЛЕТ № 7 

1. Информатика – это … Этапы развития информатики. 
2. Классификация ПК. 
3. Системная шина – это … Обеспечивает три направления передачи информации 

… 
4. Зарисуйте схему классификации программного обеспечения. 
5. Антивирусная программа – это … Виды антивирусных программ. 
6. Драйверы устройств – это …  
7. Задайте маску файлам: а) созданным в программе Word; б) графическим фай-

лам, начинающимся на букву T. 
8. База данных – это … Типы связей между данными в реляционной модели дан-

ных.  
9. Интернет - это …. Интернет имеет следующие службы: ….. 
10. В Excel в ячейке С3 записана формула: =A$1+$B2. Переместите формулу в 

ячейки D2, E4. 
11. Значения клеток А2 и А3 равны соответственно 7 и 12. В клетку В2 занесено 

выражение: ЕСЛИ(AND(А2>1,А2<10),1,0). В клетку В3 занесено выражение: 
ЕСЛИ(OR(А3<=1,А3>8),0,1). Чему равно значение клетки D3? Объяснить. 

12. Известна цена холодильника в 2006 году и ежегодное увеличение цены в % к 
предыдущему году. Рассчитать прогнозную цену до 2010 года и среднюю цену. 

Ежегодное увеличение цена 3,5% 
Года Цена холодильника марки 12.2435.12 
2006 10230 р. 
2007  
2008  
2009  
2010  
Средняя цена  

13. Составить программу вычисления ( )∏
=

+
n

i

i
1

22  используя все циклы. Изобразить 

блок-схему. 
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АМУРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ 

Утверждено на заседании кафедры                       Кафедра    ОМиИ 
«     »               200   г.                                               Факультет  ЭкФ 
Заведующий кафедрой                                            Курс 1 

  Утверждаю:__________________                          Дисциплина Информатика 
 

БИЛЕТ № 8 

1. Информационная культура – это … 

2. Информация – это … Единицы измерения информации. 

3. Внешние устройства ПК. Сканер – это … Предназначен для … 

4. Разрядность процессора определяется  … Она может быть равна … 

5. Графические редакторы. 

6. Программа-оболочка – это … Norton-подобные оболочки.  

7. Задайте маску файлам: а) созданным в программе Word, б) графическим фай-

лам, имеющим в имени 5 символов, первый - T.  

8. Сервер – это … Виды серверов. 

9. Программы-броузеры - это ….. Известные программы-броузеры …..  

10. В Excel в ячейке С3 записана формула: =$A2 - C$2. Переместите формулу в 

ячейки D3, E4. 

11. В ЭТ в клетку В4 занесено выражение: ЕСЛИ(AND(NOT(А4<2),А4<5),1,0). 

При каких значениях содержимого клетки А4 значение клетки В4 равно 1? 

Объяснить. 

12.  В представленной таблице рассчитать процент работ на «отлично». В поле 

«Вывод» определить «выше среднего» или «ниже среднего» количество отлич-

ников в группах. 

 Итоги контрольного среза   
Группа Всего сдавало Сдали на «отлично» % работ на «отлично» Вывод 

242 31    
243 24    
244 23    
245 34    
246 27    

Среднее     
13. Написать программу, вычисляющую количество и сумму элементов одно-
мерного массива, кратных заданному числу k. Изобразить блок-схему. 
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АМУРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ 
Утверждено на заседании кафедры                       Кафедра    ОМиИ 
«     »               200   г.                                               Факультет  ЭкФ 
Заведующий кафедрой                                            Курс 1 

  Утверждаю:__________________                          Дисциплина Информатика 
 

БИЛЕТ № 9 
1. Информатика – это … Главная функция информатики. 
2. Понятия «сигнал» и «данные». 
3. Внешние устройства ПК. Манипуляторы. 
4. Производительность компьютера определяется  … Она может быть равна … 
5. Архивный файл – это … Архивация, разархивация. 
6. Окно – это… Элементы окна.  
7. Задайте маску файлам: а) графическим файлам; б) системным файлам, в имени 

которых третий символ R. 
8. К методам защиты информации в сети относятся ….  
9. В вычислительных сетях используются следующие типы передающий среды. 
10. В Excel в ячейке С2 записана формула: =$A2 - C$2. Переместите формулу в 

ячейки E3, F5. 
11. В ЭТ в клетку В1 занесено выражение:  

ЕСЛИ(А1<10,2,ЕСЛИ(А1<15,3,ЕСЛИ(А1<20,4,5))) 
При каких значениях содержимого клетки значение клетки В1 равно 4? Объяс-
нить. 

12. Дана база данных сотрудников. Найти средний доход сотрудников. В столбец 
«Вывод» для каждого сотрудника вывести с помощью функции ЕСЛИ фразу 
«выше» или «ниже» его доход по сравнению с прожиточным минимумом. 

Средний доход 
Прожиточный минимум 4200 р.   

ФИО Доход Кол-во чел-к на содержании Вывод 
Иванов О.П. 8000 р. 3  
Арбузова П.Г. 18060 р. 4  
Зайцева К.В. 14600 р. 4  
Бубнов П.У. 15310 р. 2  
Ясман В.Р 21420 р. 4  

СРЕДНЕЕ    
13. Написать программу, вычисляющую произведение максимального и мини-

мального элементов матрицы. Изобразить блок-схему. 
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АМУРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ 
Утверждено на заседании кафедры                       Кафедра    ОМиИ 
«     »               200   г.                                               Факультет  ЭкФ 
Заведующий кафедрой                                            Курс 1 

  Утверждаю:__________________                          Дисциплина Информатика 
 

БИЛЕТ № 10 
1. Информационное общество – это … Оно характеризуется … 
2. Компьютеры по истории создания классифицируются: … 
3. Принтер – это … Виды принтеров. 
4. Тактовая частота процессора определяется  … Она может быть равна … 
5. Архивный файл – это … Цели сжатия файлов. 
6. BIOS служит для …. 
7. Задайте маску файлам: а) созданным в программе Word; б) файлам, имеющим в 

расширении последнюю букву t. 
8. База данных – это …..  Реляционная модель данных.  
9. Метод защиты информации электронная подпись позволяет …. Публичный 

ключ находится у ….  
10. В Excel в ячейке C3 записана формула: =A$1 - $B1. Переместите формулу в 

ячейки D3, C4. 
11. В ЭТ в клетку В4 занесено выражение: ЕСЛИ(NOT(OR(А4<2,А4>=5)),0,1). При 

каких значениях содержимого клетки А4 значение клетки В4 равно 1? Объяс-
нить. 

12. В таблице представлены данные курса USD в декабре месяце. Рассчитать сред-
немесячное значение курса USD. По вычисленной разнице текущего и среднего 
курса вывести с помощью функции ЕСЛИ фразу «понижение курса»  или «по-
вышение курса». 

Курс валюты 
Дата Курс USD Разность Итог 

01 дек 06 $30,40   
02 дек 06 $30,20   

…    
31 дек 06 $29,36   
СРЕДНЕЕ    

13. Составить программу вычисления ∏
=

n

i

i

i
x

1
2 , используя все циклы. Изобразить 

блок-схему. 
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XI. КАРТА ОБЕСПЕЧЕННОСТИ ДИСЦИПЛИНЫ КАДРАМИ 

ПРОФЕССОРСКО-ПРЕПОДАВАТЕЛЬСКОГО СОСТАВА 
 

Ф.И.О. должность Ученая степень и 
ученое звание 

Вид занятия Специальность 

Чалкина Н.А., 
ст.преподаватель 

к.п.н. Лекция 080504 – государ-
ственное и муни-
ципальное управ-
ление 
080111 – марке-
тинг 
080401 – товарове-
дение и экспертиза 
товаров 

Макарчук Т.А., 
доцент 

к.п.н. Лекция 080105 – финансы 
и кредит 
080109 – бухгал-
терский учет, ана-
лиз и аудит 
080102 – мировая 
экономика 

Чугунова О.В., 
ст. преподаватель 

- Лекция 080301 – коммер-
ция (торговое де-
ло) 

Чалкина Н.А., 
ст.преподаватель 

к.п.н. Лабораторная ра-
бота 

080401 – товаро-
ведение и экспер-
тиза товаров 
080102 – мировая 
экономика 

Баранова Е.В., 
ассистент 

- Лабораторная 
работа 

080111 – марке-
тинг 

Архипова Н.С., 
ассистент 

- Лабораторная 
работа 

080504 – государ-
ственное и муни-
ципальное управ-
ление 
080105 – финансы 
и кредит 

Макарчук Т.А., 
доцент 

к.п.н. Лабораторная ра-
бота 

080109 – бухгал-
терский учет, ана-
лиз и аудит 

Чугунова О.В., 
ст. преподаватель 

- Лабораторная ра-
бота 

080301 – коммер-
ция (торговое де-
ло) 

 

 


